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Introduction 

FelixCAD™ is an advanced CAD system designed specifically for 32-bit 
Microsoft Windows  95, 98, and NT  computers. Designed for fast and 
effective solutions of design projects, FelixCAD offers all the power, precision, 
and ease-of-use that today’s CAD user demands. 

For commercial, corporate, and government application developers, FelixCAD 
is available as the low cost Graphic Developer’s Engine™  (GDE ). For 
information on how you can utilize GDE in business or graphics applications of 
your own design, visit www.fcad.com (North America) or www.fcad.de 
(outside North America).  

Range of Capabilities 
FelixCAD includes all the commands necessary for constructing and detailing 
drawings, with many unique features aimed at saving you time and effort in 
your drawing tasks. 

FelixCAD’s drawing commands make short work of drawing tasks. You 
create drawings with lines and polylines, circles and arcs, rectangles, regular 
polygons, solid entities, 3D surface entities, and other elements.  

FelixCAD allows you to identify and define parts (blocks), and helps you build 
libraries of parts for use in repetitive drawing tasks. 

Drawing entities may be altered using the modify commands. Size, position, 
shape, and other graphic qualities may be changed. Advanced editing functions, 
such as trimming, filleting, and chamfering, are available to build sophisticated 
designs. 

Attributes of any part may be defined or edited, insuring that all pieces making 
up a drawing contain intelligence for later use.  

For additional detailing, you may call on dimensioning, hatching, and the 
insertion of text.  

FelixCAD makes all of these functions available by keyboard command entry 
and easy-to-use palettes (floating toolboxes) for true point-and-click drawing! 

http://www.fcad.com/
http://www.fcad.de/
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Layers help you organize your work. This improves drawing management, and 
makes it easy to create effective, clear, and well-detailed drawings. FelixCAD 
conforms to the layer conventions used by AutoCAD, from Autodesk Inc. 

Instead of fumbling with a complex system of dividing the drawing into 
different viewports to see different views and perspectives, FelixCAD allows 
you to open up to four drawings, each with up to four viewports. All views are 
displayed simultaneously on the screen while you work on the “active” view. 
You may have as many as sixteen viewports open on the screen during the 
drawing process. 

FelixCAD incorporates simple to use static and animated rendering of 3D 
objects, along with light source definition and placement. 

At every step, on-line help supports you. In addition, a useful and detailed on-
line tutor graphically illustrates basic geometry behind various commands. The 
tutorials allow you to call up an illustrated description of the command, see 
how it works, and work through an exercise. The tutorials includes a discussion 
of setting up the drawing, the user coordinate system, the layer concept, the 
object snap, and a few basic drawing exercises. 

FelixCAD has been designed as a truly open-architecture system. This 
facilitates industry compatibility, and allows you to freely exchange 
information with other CAD applications, evaluation software, and analysis 
programs. 

FelixCAD allows the opening and saving of drawings in industry standard 
DXF format or DWG format, transferring graphic and non-graphic 
information without destruction or loss of data. This ensures transparent file 
exchange with a variety of CAD programs and applications, including 
AutoCAD. 
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Flexible and Adaptable 
The configuration and customization commands allow many other possibilities 
for the program. You manage the use of colors, scripts, input, and output 
media, and hotkey assignment of function keys – just to name a few examples.  

FelixCAD is very flexible with regard to configuration of its user interface. 
You can choose between a standard pull-down menu, an AutoCAD “work a 
like” menu, or create one of your own. 

Menu, Palette, and Dialog Box Customization 
FelixCAD contains an integrated Dialog and Menu Editor (DME) . This 
editor adapts menus to specific tasks, and creates brand new menu structures. 
Most importantly, these changes do not require any programming knowledge. 

Palettes are toolboxes that allow for direct point-and-click access to commands 
and functions. There are a number of palettes included with FelixCAD that are 
designed to make drawing tasks easier. Should you require additional 
functionality, the Dialog and Menu Editor lets you create as many new palettes 
as you wish. The new palettes may contain discipline-related commands and 
functions, or be application-related.  

Palettes may be called upon through point-and-click techniques or by hotkeys. 
To insure optimum productivity, they can be freely placed anywhere on the 
program desktop. 

If you prefer to modify the standard FelixCAD desktop, you may simply choose 
to edit the included palettes using the included DME. 

FLISP Programming 
The integrated FelixCAD LISP interpreter (FLISP) facilitates the adaptation 
and extension of FelixCAD. It also opens up the possibility of working with 
other programs, utilities, routines, and libraries.  

The function library of the FLISP interpreter includes functions to display 
dialog boxes and evaluate user input. You can create your own dialog boxes 
with Dialog and Menu Editor. 

FelixCAD includes utilities to assist in converting existing AutoLisp programs 
written for use with AutoCAD. Utilities exist to convert dialog boxes, menus, 
and programming code. 
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Developer’s Toolkit Manual * 
FelixCAD includes an API (application programming interface), which allows 
professional developers and advanced users to access nearly all FelixCAD 
functions through the use of dynamic link libraries (DLL).  

The FelixCAD Developers Toolkit (FDT) manual is included in electronic 
format for the convenience of advanced developers wishing to extend the 
program’s capabilities using C, C++, or Delphi programming languages. The 
API manual can be opened and/or printed using Adobe’s Acrobat reader 
(included with CD versions of FelixCAD, downloadable from www.fcad.com 
or www.adobe.com for on-line Internet purchases). Search the \manuals folder 
for any file starting with FDT, and having the extension .pdf. 

DOCUMENTATION 
FelixCAD includes this comprehensive User Guide. In addition, on-line 
documentation is included for all FelixCAD customization and programming, 
and for existing AutoCAD users. Of note are the manuals detailing program 
customization, FLISP programming, and the FelixCAD Developer’s Toolkit 
(FDT), an advanced C/C++ language programming interface available with 
FelixCAD. 

All on-line manuals for FelixCAD are saved in Adobe Acrobat Portable 
Document Format (files end with the extension .pdf). To view or print the on-
line manuals, you must first install the Adobe Acrobat Reader (version 4 or 
higher), which is contained on the installation CD, or available for download 
off the Internet at www.fcad.com or www.adobe.com.   

User Manual 
This User Manual contains instruction on the layout and general functions 
contained in FelixCAD. It is included in Acrobat .PDF form and can be viewed 
and printed (have 300 pages ready) using the Adobe Acrobat Reader (which 
must be installed separately from FelixCAD). 

Note: If you purchased FelixCAD on-line, you should place all program 
documentation (.pdf files) into the \manuals sub-folder of the FelixCAD 
installation folder. 

Chapter 1 covers basics on working with the program. 

http://www.fcad.com/
http://www.adobe.com/
http://www.fcad.com/
http://www.adobe.com/
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Chapter 2 offers a detailed description of drawing aids. There are functions for 
precision drawing, the object snap functions, and other precision drawing aids. 
The use of different coordinate systems is explained in this chapter as well. 

Chapter 3 explains the techniques used to view drawings, with a detailed 
explanation on the use of viewports, how to achieve good results from 
FelixCAD’s ability to see many views at the same time, and the use of the 
multiple-drawing viewing capability. The world and user coordinate systems 
are also discussed. 

The remaining chapters explain working with layers, the functions involving 
drawing, working on, and detailing (dimensioning, crosshatching) objects, the 
definition and insertion of parts and attributes, working with text objects, and 
all other topics that pertain to helping you do a fast and easy job of drawing and 
designing with FelixCAD. 

Finally, importing and exporting functions, rendering, and outputting the 
drawings on a plotter or a printer are explained. 

FELIXCAD FOR AUTOCAD USERS GUIDE 
To assist AutoCAD familiar operators and programmers with their use of 
FelixCAD, a separate .pdf document is included. The FelixCAD for AutoCAD 
Users and Programmers guide explains how the FelixCAD interface and 
command operations can be easily adapted to work more like AutoCAD. 

The guide also contains details on the main differences between FelixCAD and 
AutoCAD with regards to use, customization, and programming techniques. 
You should place all documentation into the \manuals folder. 

To view/print (have 70 pages ready) the FelixCAD for AutoCAD Users guide, 
use the Adobe Acrobat reader to open the appropriate .pdf,  contained in the 
\manuals folder.  

CUSTOMIZATION AND LISP PROGRAMMER’S GUIDE 
The Customization and Programmer's Guide manual appeals to users interested 
in further adjusting, individualizing, customizing and programming FelixCAD 
and its functions to specific application needs. To view the programmer’s 
guide, use the Adobe Acrobat reader to open the appropriate .pdf file, contained 
in the \manuals folder.  
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Initial chapters contain a number of suggestions for possible arrangement of the 
user interface, working with alias commands, macros, and function key 
assignments, as well as a guide to the directory structure of the program. 

Chapters are included to describe the meaning and use of template drawings, as 
well as the definition of linetypes and hatch patterns. 

Middle chapters describe in detail working with the Dialog and Menu Editor 
(DME), and describe the techniques used in setting up new (or editing the 
standard) menus, palettes and dialog boxes. 

Detailed information is provided about the integrated FLISP interpreter 
allowing you to extend the program or comply it with special working 
requirements. 

And finally, a detailed overview of the global and local variables in the system 
is outlined. 

ADVANCED PROGRAMMING USING C, C++, OR DELPHI 
The FelixCAD Developer's Toolkit Application Programming Interface (FDT-
API) Manual contains instructions of how to extend FelixCAD through use of 
its advanced programming interface. The FDT API manual is supplied in .pdf 
format. 

If you plan to create integrated Lisp, C, C++, or Delphi solutions using 
FelixCAD, contact us at www.fcad.com (North America) or www.fcad.de 
(outside North America) to obtain details on our Graphic Developer's Engine. 
GDE licensing allows low cost distribution of vertical market applications, with 
flexible low cost licensing designed to suit the needs of any size developer. 

Contact Us 
We look forward to your successes with FelixCAD. Please don’t hesitate to 
contact us for assistance at info@fcad.com (North America), or info@fcad.de 
(outside North America). Tell us your thoughts on the product and your 
experiences with its use, whether you are a user or a developer. Your input is 
welcome, and we look forward to hearing from you!  

http://www.fcad.com/
http://www.fcad.de/
mailto:info@fcad.com
mailto:info@fcad.de
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PROGRAM INSTALLATION AND SETUP 
FelixCAD is available for purchase on CD, or via download off the Internet. 

FelixCAD includes an automated installation routine, which is run by using the 
appropriate Windows “run” function (under the Windows “Start” menu”) to 
execute the program Setup.Exe. 

For information on where to purchase FelixCAD, please visit www.fcad.com  
or www.fcad.de. 

Installation on Windows 95/98, NT, 2000, XP and Me.  
1. If you purchased a CD version of FelixCAD, go to step 2. If you 

downloaded FelixCAD off the Internet, save the file(s) from your download 
into a temporary directory on your computer and proceed to step 3. 

2. Insert the FelixCAD CD-ROM into the CD drive of your computer. 

3. From the Start button, browse the CD-ROM (or download folder) to select 
the Setup program file. CD versions are set to “autorun”, so the installation 
may start up automatically upon insertion into your CD drive. 

4. Follow the on-screen prompts to complete the installation. 

FelixCAD offers three types of installation: 

• INSTALL FULLY LICENSED VERSION  
Select this option, if you have purchased a fully licensed software version 
(including a valid CD-Key Number). 

• INSTALL EVALUATION VERSION  
Choose this option, if you wish to evaluate the program for a 30-day period 
with full functionality. The program will cease operation after 30 days. 

• CONVERT EVALUATION TO FULL VERSION  
If you purchased a CD Key Number, this option allows you to convert an 
already installed evaluation copy to a regular fully licensed version of the 
software. 

Uninstall 
FelixCAD can be uninstalled from your computer. When using the Windows 
95/98/NT4 desktop, the program can be removed using the Add/Remove 
function in the Control Panel. The Uninstall program removes the program 
groups and .ini files from the Windows directory. An Uninstall icon is also 
available under the FelixCAD program group.  

http://www.fcad.com/
http://www.fcad.de/
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Be careful not to delete any drawing (.flx, .dwg, .dxf) files you may have 
saved in these directories after installation. 

Adobe Acrobat Installation 
The FelixCAD CD includes Adobe’s on-line document reader for Windows. To 
install Acrobat from the FelixCAD CD-ROM, run the AcroInst.Exe program 
situated in the \acrobat directory of the CD. Follow the on-screen prompts to 
compete the installation. 

If you purchased or downloaded the Internet version of FelixCAD, visit 
www.fcad.com or www.adobe.com to download a free copy of the reader. You 
will need the reader to view or print the supplied documentation. 

Technical Support 
Please contact your selling dealer, or send an email to support@fcad.com 
(North America) or support@fcad.de (outside North America). 

From our Web site(s), choose the Support page for hints and tips, and bonus 
files. You can also access the FelixCAD home page for technical requests or 
reports. 

http://www.fcad.com/
http://www.adobe.com/
mailto:support@fcad.com
mailto:support@fcad.de
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WHAT’S NEW IN FELIXCAD 5 

New Entities: 

Lightweight Polyline 
Now FelixCAD supports the memory-optimized LWPOLYLINE-Entity. The 
creation of lightweight or ”previous style” polylines can be controlled with the 
global system variable PLINETYPE. 

This variable specifies whether FelixCAD uses optimized 2D polylines. 
PLINETYPE controls both the creation of new polylines with the PLINE 
command and the conversion of existing polylines in drawings from previous 
releases. 

0 Polylines in older drawings are not converted when opened; PLINE 
creates old-format polylines 

1 Polylines in older drawings are not converted when opened; PLINE 
creates optimized polylines 

2 Polylines in older drawings are converted when opened; PLINE 
creates optimized polylines 

 
New Commands: 

Command MTEXT 
FelixCAD 5 now fully supports MTEXT.  After issuing the command and 
specifying the location of the new text, you are presented with a dialog in 
which you enter your text. Three tabs allow you to exercise control over all text 
parameters and an Import function enables you to import an external text file 
into the window. 
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MTEXT Dialog showing Character options 

 

 

MTEXT Dialog showing Property options 

 

 

MTEXT Dialog showing Line Spacing options 

 

Pre-Selection of Objects 
The global PICKFIRST system variable controls whether you select objects 
before (noun-verb selection) or after you issue a command. 

0 Turns off PICKFIRST; you select objects after you issue a 
command 

1 Turns on PICKFIRST; you select objects before you issue a 
command 
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Object Snap 
Snap points of hatch pattern lines will be ignored during the point selection. 

Command FLXRECOVER 
This new feature enables the user to recover damaged flx-drawing files of  the 
FelixCAD 5 or 4.02 file format. 

Command DVIEW * 

 

The DVIEW command creates a perspective view in different display modes. 
Supported display modes are rendered, hidden line and wire frame. 

Different input modes make it easy to adjust the viewpoint of the drawing. The 
target point and the camera point can be selected in the drawing. The result can 
be saved in a bitmap file with a predefined resolution. 

The center view button brings the drawing into a base position at the center of 
the DVIEW output window. If the dialog is closed by the apply button, the 
current view direction of DVIEW will be set to the drawing. 
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Command SAVEAS401 and SAVEAS402 * 
The command SAVEAS401 saves a drawing in the previous FelixCAD 4.01 
file format. SAVEAS402 saves in the new recoverable FelixCAD 4.02 file 
format.  

Command DRAWORDER 
DRAWORDER changes the drawing and plotting order of any object in the 
FelixCAD drawing database. In addition to moving objects to the ”front” or 
”back” of the sort order, you can order objects relative to another object (that 
is, above or below a selected object). DRAWORDER provides the following 
options: 

Above Under Front Back 

    

• Above - Moves the selected object above a specified reference object. 

• Under - Moves the selected object under a specified reference object. 

• Front - Moves the selected object to the top of the drawing order. The 
selected object becomes the last drawn entity in the drawing database. 

• Back - Moves the selected object to the bottom of the drawing order. The 
selected object becomes the first entity in the drawing database. 

Differences between FelixCAD and AutoCAD 

Different object sort methods are not supported in FelixCAD. The object order 
is changed in the database directly, instead, using DRAWORDER.  A 
SORTENTS system variable for controlling the object sort mode is therefore 
not required. 

Recording of the User Input 
For support purposes we have integrated in FelixCAD, a new user-input-
recording function. FelixCAD writes all text window contents into a specified 
file. The command can be activated with the command LOGFILEON. The 
LOGFILEOFF command stops the prompt echoing to a file. An output file 
name and path can be set via the global system variable LOGFILENAME. The 
global system variable LOGFILEMODE controls whether or not  a logfile can 
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be written. (Please see also the system variable chapter in the developer 
section) 

Command and Function Enhancements: 

Purge Command 
Enhanced performance of the purge command. An internal reference counter 
makes the purging of unreferenced FelixCAD table entries faster. 

Transparent Alias Commands 
Alias commands can be used while a command is active. See the example of 
the transparent alias command ‘Z below: 

Definition in the FCAD5.key file: 
Z=ZOOM 

> LINE 
From point:  
To point:  
To point: 'z 
Zoom scale factor: Window 
First corner:  
Second corner:  
To point: 
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CONFIG Command 

 

In the register Directories of the CONFIG command, browse-buttons now 
extend the ability to adjust FelixCAD path settings.  The font path now 
supports multiple path selection, which can be useful if you have multiple text 
font directories. If two font directories contain the same font definition, the 
first-found font will be used. 

Autosave  
Autosave in FelixCAD essentially now operates in the same manner as in 
AutoCAD 
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Command Extensions: 

Layer Command: 
New line type definitions can be loaded without leaving the layer command. In 
the sub-dialog box you can select the Load button to accomplish this: 

 

In the layer manager the default button has been changed to the New button. If 
you type in a layer name and press the return key, a new layer will be created 
while you remain in the layer manager. 
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Text and ATTDEF Command: 
New text styles can be directly created while executing the text and ATTDEF 
command. The FONT command can also be started, by clicking on the font 
button beneath the current font list box. 
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Command Font: 
During font creation, a default text style name is displayed that is dependent 
upon the selected font name. If you make changes to the default name in the 
text style edit box, a new default name will no longer be suggested and your 
changes will remain in effect. 
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Command Open 
The file type box has been extended by the option ”All files (*.*). 

 

 

Open Command And The Import of MTEXT-Entities 
On opening an AutoCAD format DWG or DXF file,  “MTEXT” entities are 
converted directly to text entities. 

Command Save 
The save command creates a preview bitmap for AutoCAD R14 and 2000 
DWG files. 

Command Hatch 
A new solid hatch pattern is integrated into FelixCAD 5. 

Commands 3DVIEW and SETVIEWDIR (VIEW TWIST) 
Now the commands 3DVIEW and SETVIEWDIR support the rotation of the 
view in the XY-Plane. This is especially useful for quickly re-orienting the 
drawing within the drawing surround prior to plotting.  
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Roundtrip DWG/DXF 2000 
If you open an AutoCAD drawing, you now you have the possibility to 
”Roundtrip” all unsupported AutoCAD 2000 entities. That means, that while 
being edited in FelixCAD, unsupported AutoCAD 2000 entities remain 
unchanged and invisible the background. If the drawing is saved in AutoCAD 
2000 drawing format again, all entities including these unsupported AutoCAD 
2000 entities will be written back to the file. 

”Roundtripped” AutoCAD Entities: 

ARCALIGNEDTEXT  
BODY  
IMAGE  
LEADER  
MLINE  
OLE2FRAME  
PROXY  
RAY  
REGION  
RTEXT  
SOLID3D  
TOLERANCE  
WIPEOUT  
XLINE  
XRECORD-OBJECTS  

 
”Roundtripped” AutoCAD Table Information: 

DICTIONARYWDFLTOBJTYPE  
DICTVAR  
IMAGEDEF  
MLINESTYLE  
OBJECTPOINTER  
PLACEHOLDEROBJECT  
VBAPROJECTOBJECT  
WIPEOUTVAROBJECT  
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Default File Format  
The default file format for the open and save dialog can be predefined in the 
CONFIG command register Common. If you select the button Fileformat , you 
will get the dialog displayed below. In this dialog, you can select your default 
file format to work within FelixCAD. 
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DynaSnap 
DynaSnap stands for dynamic snap functionality. Now, FelixCAD has the 
possibility to identify the currently active snap point dynamically, by using 
distinctive symbols (markers).  You can choose the desired snap point or switch 
between different modes by the tab-key. DynaSnap mode can be turned on in 
the register ”Object Snap” of the SETTINGS dialog or by switching the marker 
and/or the tool-tip button on. Different colors of the marker can be also 
selected. The displayed markers or symbols are the same as shown in the 
following dialog to the left of each respective object snap mode. 
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Object Snap Modes: 
Turns on running object snap: 

Marker Mode Supported Entities 

 
Intersection Snaps to the intersection of an arc, line or, 

polyline segment. 

 
End Point Snaps to the closest endpoint of an arc, line or 

polyline segment, solid, or 3dface. 

 
Mid Point Snaps to the midpoint of an arc, line or polyline 

segment, solid, or 3dface. 

 
Point Snaps to a point object. 

 
Next on Entity Snaps to the nearest point on an arc, circle, line, 

point, or polyline segment. 

 
Center Point Snaps to the center of an arc, circle, or polyline 

arc segment. 

 
Quadrant Snaps to the quadrant point of an arc, circle, or 

polyline arc segment. 

 
Insertion Point Snaps to the insertion point of an attribute 

definitions, part/block, or text. 

 
Tangent Snaps to the tangent of an arc, circle, or polyline 

arc segment. 

 
Perpendicular Snaps to a point perpendicular to an arc, circle, 

polyline segment, line, solid, or 3dface. 
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New Temporary Object Snap Mode NONE 
In FelixCAD 5, all current selected object snap modes can be switched off for a 
single selection by selecting the NONE option 

Menu Echo Toggle ^P 
With the option ^P the user can toggle the menu echo on and off in one pull 
down menu command line. 

For example: 
MENUITEM, (#|ACTDB|<0), "&Line", {Draw line(s)|LINE}, 
[FCMD]^P^^LINE 
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WHAT'S NEW IN FELIXCAD 4.01 
A number of substantial program enhancements have been made to FelixCAD 
since version 4.0 was released in Spring of 1999. Please search the FelixCAD 
installation folder for "What's new" files containing information on updates and 
changes. 

For the latest information on FelixCAD product improvements and changes, 
please visit our web sites at www.fcad.com and www.fcad.de. FelixCAD 4.01 
highlighted additions and enhancements include: 

• Support for True Type fonts, and AutoCAD .SHX fonts (see FONTS) with 
font mapping. 

• Improved DWG®/DXF® file exchange capabilities. 

• Raster image import and handling has been improved and extended to 
support color BMP and TIF images, in addition to the existing 
monochrome RLC file formats (see RASTER). 

• Improvements have been made in display and object selection speed. The 
UNDO command has been sped up and improved. 

• Dramatic enhancements have been made to the printing/plotting function, 
with file sizes and printing times reduced by up to 90%. 

• A new batch processing (see BATPROC command) function has been 
added, allowing unattended printing or conversion of multiple files in a 
single operation. 

• A new Mouse Context toggle has been added (Tools>Mouse Context 
On/Off). When switched on, simply left mouse click on any drawing entity 
for a complete listing of available options. 

• New Dynamic zooming and panning functions (see DZOOM and DPAN). 

• Improvements to the FCAD Drawing Explorer™ (see XPLORER 
command). 

• A new graphic Image library has been added (Image Library icon in the 
FelixCAD program group) for simple management of bitmaps and slides. 
The ability to create slide .SLD files has been added. 

http://www.fcad.com/
http://www.fcad.de/


Introduction and Installation 

 25 

• Dimensioning has been improved and a new DIMLIN command is 
available. 

• New MEASURE and DIVIDE commands have been added allowing 2D 
objects to be divided into a set number of segments, or new points created 
at user defined distances. 

• New 3D commands have been added (Draw>3D), allowing for quick and 
easy creation of 3D boxes, wedges, cylinders/cones, spheres, ellipsoids, 
and toruses. See the corresponding command. 

• Memory management for polylines has been completely overhauled, 
making polyline processing more efficient. 

• The FelixCAD Lisp, C/C++, and Delphi programming API has been 
extended with new functions and calls. See the appropriate readme file 
and/or programming manual for details. 

• A new AutoPort™ tools library (Click on Tools icon in the FelixCAD 
program group) has been added to automate porting of existing 
AutoLisp® and ADS® programs written for use with AutoCAD. The 
library also includes tools to convert menus and dialogs. 
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Getting Started:  
The Basics of Drawing with FelixCAD 

This chapter provides you with an introduction to FelixCAD. You learn about 
some of the most frequently used commands and tools.  

This chapter begins with a description of how to start the program. This is 
followed by how to create a new drawing and open existing drawing files. You 
also learn how to save the result of your work and how to exit the program 
correctly. 

Later sections of this chapter describe the user interface, its elements, and 
components. You’ll find instructions to control the interface and the 
customized arrangement of its elements. 

To control FelixCAD, you may use the mouse or other pointing device (such as 
a digitizing tablet) to select commands the menu bar, tool areas, or palettes. 
Commands can also be executed using the keyboard. For defining points, 
distances, and angles, the keyboard provides you with the advantage of greater 
precision. Ideally, using a combination of the mouse and keyboard optimizes 
your productivity. 

We recommend that the novice CAD user read the parts of this chapter 
containing explanations of command selection, coordinate input, and command 
options -- whether by keyboard, mouse, or digitizer. FelixCAD provides many 
alternatives for data and command input and selection.  The variant that you 
choose depends on your personal style. 

General Remarks 
FelixCAD runs on a computer with Microsoft Windows 95, 98, and NT. All 
aspects of the program function according to Windows standards. This is true 
for pull-down menus, toolboxes, dialog boxes, edit boxes, scroll bars, etc. 
There are buttons for opening new and existing drawing files, to save and print 
drawings, as well as for changing window arrangements. It is recommended 
that you load FelixCAD on a PC with the most recent operating system and 
'patches' available. It is also good practice to have the latest device driver files, 
such as for Video Cards and Printers, on your system.  
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To work with FelixCAD, we assume that you already know how to use the 
Windows operating system. For this reason, we do not explain how to use the 
user interface elements. If you are not sure, please consult your Windows 
User’s Guide manual, the on-line help system, and other source of information 
on the subject of Windows. 

In this manual, the term drawing is used as a synonym for file. When we talk 
about “opening or closing a drawing,” it’s the same thing as opening or closing 
the file. 

 

Typical FelixCAD Screen (shown with 4 views open) 
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STARTING FELIXCAD 
During the installation of FelixCAD, the Windows Setup program places a 
FelixCAD icon on the desktop. (A detailed description of the installation is 
contained in the “Introduction” of this manual.)  

Start FelixCAD by double-clicking the icon. As an alternative, click the Start 
button on the taskbar, then select Programs > FelixCAD > FelixCAD.  

To Change the FelixCAD icon properties, 
right mouse click on the icon and scroll 
down to 'properties'. Under the 'Shortcut' 
tab of the icon properties dialog box, the 
following options can be changed:  

(1) 'Start in' - where FelixCAD first looks 
for and saves files,  

(2) 'Shortcut key' - allows assigning a 
Shortcut Key or Keys to launch the 
program  

(3) 'Run' - setting the Window size for the 
program to Run: minimized, normal or 
maximized.  

Look in your Windows documentation for details on changing an icon's 
properties. 



Chapter 1  The Basics 

 30 

OPENING AND SAVING DRAWINGS 
In this section, you learn about the commands for opening a drawing, for saving 
your work, and for exiting FelixCAD.  

 

 

 

 

 

 

 

 

 

 

 

 
By the end of this section, you should

Command Name Meaning 
New Starts a new
Open  Opens an ex

d iClose Closes the c
d iSave Saves the cu

Save As * (only FLX) Saves the cu
b h

File Operations

The File Pull-down menu 

Printing and Plotting setup and 
execution

Paper Layout Mode (Paper 
e) 

Batch Processing. Allows 
printing/plotting or conversion of 
multiple files at one time
space/Model Spac
 understand these commands: 

 drawing. 
isting 
urrent 
rrent drawing. 
rrent drawing 

System configuration, desktop 
management, and resource manager 

Last opened files 
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Save All  Saves all open drawings. 
File Manager Visual File Management 
Delete Locked Files Erases locked files. 
Exit Exits the FelixCAD 
 
These commands are located in the pull-down menu labeled File.  

There are also icons in the toolbar for the most used commands. The 
commands for printing and plotting your drawing, which are also found in the 
File menu, are explained in the Printing and Plotting chapter of this manual.  

FelixCAD 4.01 introduces batch processing of multiple files. Files can be 
printed/plotted, or converted from one format into another using batch 
processing which is described in a separate chapter of this manual (see 
BATPROC command). 

By default, FelixCAD saves drawing files with the file extension .flx. Each file 
contains the drawing and, if necessary, up to four independent views of the 
drawing. Files can optionally be opened or saved in .DWG or .DXF format. 

Each drawing, as well as each view of a drawing, is displayed in a separate 
window. FelixCAD can open up to four drawings, each with four independent 
views – for a maximum of 16 windows open at a time. All windows carry the 
filename on the title bar. In addition, a number between 0 and 3 indicates the 
view. See figure below. 

 

To avoid accidental loss of data, we strongly recommend that you periodically 
save your drawings as you work on them. For this purpose, use the AutoSave 
function. Here’s how: Select File > Configure, then click the Common tab. In 
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the Safety section, click the Automatic Save check box, then choose the 
interval in minutes. Do not use a value shorter than 10 minutes, unless you have 
a very fast computer or a very small drawing. 

New Drawing 
Before you can start drawing for the first time, a new file must be opened. The 
New command (select File from the menu bar, then select the New item) 
displays the following dialog box:  

 
 

The New File dialog box 

By default, FelixCAD names the new drawing Noname_0.Flx. As an 
alternative, you can type any filename up to 255 characters long in the File 
name field of the New File dialog box. In addition, you can choose the drive 
and folder (via the Save in list box) to store the file in. 

If a drawing file of the same name already exists, the program warns you and 
requires a confirmation to replace the existing file. 

Click OK. Notice that FelixCAD creates a new, blank drawing window. 
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Load Template 
A template drawing (called a prototype drawing in AutoCAD) may be used 
when starting a new drawing. A template drawing is a model, which can be 
used as basis for a new drawing. Templates are typically use to the 
establishment of a standardized drawing environment, such as: 

• Drawing border and title block. 
• Dimension settings. 
• Pre-defined layers. 
• Preset views. 
• Standardized linetypes. 
• Settings of system variables. 

To start a new drawing based on a template file, click the Load Template 
check box, then click Template Drawing button. FelixCAD displays the 
Template Drawing dialog box. Select the drawing to be to used as a template 
drawing and click OK. 

 
 

The Template Drawing dialog box 

Find 
If you do not know the exact storage location of a drawing file, click the Find 
button. In the Find File dialog box, select the drive to search. Enter as much of 
the file name you know. You may use the “wildcard” characters * (for any 
group of characters) and ? (for any single character). 

For example, entering Floor* finds Floor, Flooring, and Floors. On the other 
hand, Floor? finds only Floor and Floors. 
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Click Find and FelixCAD searches for the corresponding file names in the 
indicated drives.  

 

The Find File dialog box 

Open an Existing Drawing 
The Open command (File > Open) is used to open an existing drawing file. 
After entering the command, you see the Open File dialog box. 

 
 

The Open dialog box 

You may select a drive, folder (or sub-directory), 
file name, and file type. By clicking on "Files of 
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Type", FelixCAD can open .flx files, .dwg files saved by AutoCAD version 2.5 
through Release 14, or .dxf files created by other CAD programs.  

Click Open to load the drawing. 

 
 

The open drawing progress bar 

While opening a drawing, a blue progress bar appears at the bottom of the 
program window (the status line). It shows the progress of loading the file. The 
bar moves from left to right and disappears when the file is completely loaded. 

Open as Read-only 
You can specify that the file be opened as read-only. Click the Open as read-
only check box in the Open File dialog box. The read-only mode opens the file 
but does not allow you to save it, except by a different filename.  

This is a protective mechanism against inadvertently modifying or changing the 
file. After opening in read-only mode, you can modify the drawing in any way, 
but the modifications are not saved.  

When you try to save a read-only file, FelixCAD displays a warning and asks if 
the file should be saved under different name. If you want the changes saved, 
then select the Yes button, and type a filename in the Save As dialog box. 

Closing a Drawing 
When you have finished working on a drawing, you close the drawing. Closing 
the drawing saves it and removes the drawing from the program. FelixCAD 
itself remains open until you exit the program (more later). To close the 
drawing, type the Close command, or select File > Close from the menu bar, or 
press the shortcut keys Ctrl+F4. As an alternative, you can close the drawing 
(as in all Windows programs) by clicking the small x at the far right end of the 
title bar.  

 
The Close window button 

If a drawing has been changed before closing, a prompt asks you if you want 
the file saved -- this prevents the unintended loss of work. Drawings may be 
saved in .flx, .dwg (R12, R13, or R14), and .dxf formats. 
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Save the Drawing 
The Save command (File > Save) saves the drawing in the active window to be 
saved. (The active window is the one with the dark title bar; inactive windows 
have a light or gray title bar color.) 

The file is saved by its name in FelixCAD’s own .flx format. The file is saved 
in the same drive and folder as at the time of opening the file.  

Actually, before saving the drawing, FelixCAD renames the file with the 
extension of .bak as a backup file. 

Save All Drawings 
The SaveAll command (File > Save All) saves all open drawings. This is 
quicker than using the Save command four times, once for each open drawing. 

Save As * (only FLX) 
The SaveAs command (File > Save As) also saves the current drawing, like the 
Save command, but it allows you to change the name of the drawing.  

The Save As dialog box allows you make these changes: 

• Save by a different file name. 
• Save in another file format. 
• Save on another drive. 
• Save in another folder (sub-directory). 
 
Drawings may be saved in .flx, .dwg (R12, R13, or R14), and .dxf formats.   

Note: to convert multiple drawings from one format to another (e.g. convert 
five DXF files to BMP, or eighty DWG "blocks" to FLX), refer to the Batch 
Processing (BATPROC) section of this manual. 

File Manager 
The Fileman command (File>File Manager) visually displays all .FLX 
drawings in the current directory.  
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Deleting Files 
The DelFlk command (File > Delete File) deletes files, specifically lock files. 
Lock files are security files created by the program when a drawing file is 
opened. They carry the same name as the original file and can be identified by 
the extension .flk. The lock files prevent two or more users working on the 
same drawing at the same time in a networked environment. 

Normally, lock files are deleted automatically, if the drawing files are closed in 
the normal manner. If the program is unexpectedly interrupted and the files 
have not been closed before the interruption, the .flk do not get erased. When 
you try to reopen the drawing after the interruption you get the message, “File 
locked.” 

To gain access to the drawing, the corresponding lock file must be deleted. 
Delete the offending lock file and the drawing file can again be opened. 

Exiting the Program 
It is important that you end every working session correctly. This is done by 
using the Exit command (File > Exit) or pressing the ALT+F4 shortcut keys. 

If there are drawings still open that have not been saved, the program prompts 
you to save the files first. If you confirm, the Save File As dialog appears. 

After saving the drawings, the working session with FelixCAD is finished. 
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THE PROGRAM’S USER INTERFACE 
Upon starting FelixCAD, you see the desktop. It contains a series of standard 
elements, including the menu bar, the function bar, the vertical symbol bar, and 
the status bar. In addition, the desktop contains several palettes (toolbars) and a 
cursor menu, when applicable. 

The following picture shows the standard look of the desktop. 

 
The standard FelixCAD desktop 

 
Usually, the desktop layout appears as shown in the figure above. However, 
you can customize the menus, toolbars, and other components of the program’s 
desktop to suit your needs. In particular, you may wish to experiment turning 
various desktop components ON or OFF to achieve the best balance of quick 
function access and maximum drawing area.  

Note for AutoCAD Users: Refer to the "FelixCAD for AutoCAD" companion 
guide for instructions on how to convert the default FelixCAD desktop to an 
AutoCAD emulated desktop.  
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Alteration of the arrangement of the desktop layout can be achieved easily. In 
addition, you can replace the buttons of the toolbars of the program’s desktop 
on the fly. Below in this chapter you find the corresponding information on 
both topics. 

Advanced methods of desktop layout modifications are covered in the 
Programming and Customization Guide. 

Menu Bar and Pull-Down Menus 
The pull-down menus are arranged on the menu bar. Each pull-down menu 
contains groups of thematically-related commands: File, Edit, Draw, Modify, 
Detail, Dim (dimensions), Parts (blocks), Options, View, Window, and ? 
(help). 

 
Menu items can have these states:  

• Grayed-out commands are not available and cannot be selected. The 
command Save, for example, can not be executed if no drawing has been 
created or opened. 

• Three dots (...) behind the command, such as Settings... in the figure above, 
means that a dialog box will be displayed.  

• An arrow (!) behind a menu item, such as Set Color !!!! in the figure above, 
indicates that a submenu will be opened . 

 
Note: the contents of the menu bar can vary, depending on the menu loaded. 
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Different menu files may be loaded, which allows you to adapt the menu bar to 
your specific needs.  

Menu files are identified by the extension .mnu. The program contains a 
standard menu file located in the sub-directory \applic.  

To load another menu file, such as Fcad14e.Mnu (which provides a menu that 
looks similar to AutoCAD Rel ease 14’s menu), select File >  Resource  
Manager > Pulldown Menu (or type the Menu command). Refer to the 
FelixCAD for AutoCAD guide for further details. 

 
The standard FelixCAD pull-down menu 

For further information on menu and palette management, refer to the 
“Customization: Palette and Resource Manager” chapter of this manual 

FelixCAD offers you the opportunity to graphically create or edit custom 
menus, dialogs, and palettes. These files can be created and edited with the help 
of the Dialog and Menu Editor (see complete explanation in the Programming 
and Customization Guide).  

The Toolbar 
When you install FelixCAD, below the menu bar are two rows of buttons, on 
the left and on the right (with the command line area between them). This 
component of the desktop layout is called the toolbar.  

 
The File icons and command line 

The group of six buttons, located on the left side of the toolbar, executes 
commands from the File menu. Each button consists of a symbol (or icon), that 
represents a command. Simply click on a button to execute the command. This 
is faster than selecting the File menu, and then the menu item. 

The symbols are arranged by subject, in groups. You find detailed explanations 
of each command, its icon, and their use in this and the following chapters of 
the manual.  

File Icons Command line
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The button shown in the figure below are called the System buttons. They 
perform system commands. From left to right, these are: New, Open, Close, 
Save, Print, and Settings. Just as all FelixCAD menus, the Toolbar conforms 
to Windows guidelines. 

 
System icons for file operations 

The other group of symbols, also arranged in two lines, contains additional 
commands that are commonly used in FelixCAD.  

  
Additional buttons for commonly used operations. 

To find the meaning of a symbol, pause the cursor over a button. FelixCAD 
displays a brief, helpful explanation of the symbol in two places: (1) in a 
yellow ToolTip that floats over the button; and (2) on the status line at the 
bottom of the screen.   

 
The status line (bottom left) and ToolTip (upper right) display the meaning of symbols. 

 

For example, the “puzzle piece” symbol (first icon in the second row) is the 
Insert Block command. 

Command Line and Text Window 
The command line and the text window are the primary communications link 
between you and the program. In its default condition, FelixCAD places the 
command line directly below the menu bar. (In the figure above, the command 
line is the rectangular box containing the words “Loading C:\CAD…”.) 

The command line is the place where: 

Tool tip

Status
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• You type commands and option names, if you prefer typing to mouse 
clicking. 

• You specify coordinates and values, select objects, and confirm inputs. 
• FelixCAD displays the selection or input steps for the user (for example, 4 

selected). 
• FelixCAD displays messages, indications, and warnings (for example, 

Command not found). 
 
All commands you select, whether by menu, palette, or at the command line, 
are displayed at the command line. This lets you verify commands and options 
before they are confirmed. At the same time, the command line (and the text 
window) provides a history of your design session. You can read back and 
reconstruct program steps of the working session.  

The command line is not used for everything. When a command has many 
choices, FelixCAD displays a dialog box instead. Dialog boxes are used for: 

• Displaying and setting system variables. 
• Listing geometric information of selected entities. 
• Displaying information regarding layers, loaded linetypes, text styles, 

defined views, and user coordinate systems. 
 
The command line is not fixed in its location. Use the File > Desktop 
Manager > Command Line command to move the command line to the 
bottom of the screen or to turn it off (which provides more screen real estate). 

The text screen is a larger version of the command line. To see the text screen, 
click the  button in the toolbar or type the TScreen command. The text 
window can be arranged anywhere on your computer screen; the size of the 
screen can be adapted to your needs. As an alternative, the TScreenFull 
command shows the text window covering the entire display. 

In both the command line and the text window, with the help of the scroll bar, 
or with the PgUp or PgDn keys, the text can be scrolled up and down. 

Note: In the following chapters, the terms “command line,” “command line 
area,” and “text window” are synonyms. If there is any difference in the 
function of these terms, the correct term is used and the difference is spelled 
out. 
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The Options Bar & Menu 
Most commands in FelixCAD have two or more options. These options 
determine how the command progresses. For example, after you start the Line 
command (for drawing line segments), the following option menu appears 
below the command line: 

 
The options bar displays the command’s current options and sits in a fixed location 

 

The left end of the option bar contains three permanent symbols. From left to 
right, they are: 

• Cancel command (same as pressing the Esc key). 

• Redo last undone command (same selecting Edit | Redo). 

• Undo the last command (same as selecting Edit | Undo). 

The two arrowheads scroll the list of options, if the screen is not wide enough 
to list all options. 

To use a command option, you can either (1) select the option name from the 
options menu; or (2) type the capitalized letters at the command line. In the 
example above, to draw a continuous set of line segments, you can click the 
Continuous work on the option bar, or you can type the letter C at the command 
line: 

> line 
From point: C 
From point:  

As an alternative to the options bar, you can have the options appear in a 
floating menu. Select File > Desktop Manager > Options > Menu from the 
menu bar: 

 
The options menu displays the command’s current options and floats on the screen 

Note: The wording of the option menu and bar change with each step of a 
command. 
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The Property Bar 
The property bar gives you a quick and comfortable way of setting some main 
properties for further construction and drawing. To turn on the property bar, 
select File > Desktop Manager > Property from the menu bar. 

 
The property bar gives you fast access to the most important properties 

The first three buttons control: 

• O: Orthogonal mode. 

• S: Snap mode. 

• G: Grid display. 

Click the appropriate button to toggle the mode. Toggle means to turn off and 
on, like a light switch. Explanation of these drawing tools is found in Chapter 2 
“Drawing with Precision.” 

The remainder of the property bar set entity properties of layer, color, and 
linetype:  
• Layer button:  opens the Layer Manager dialog box, which is where you 

create new layers, specify their properties, rename them, and so on.  
• Layer drop-down list: contains all layer names of the current drawing, 

which is where you choose the layer you want to set as current.  
• Color button: displays the current color. Click the button open the Color 

dialog box for selecting another color, which is applied when creating new 
entities.  

• Linetype drop-down list: contains the linetypes defined in the current 
drawing, which is where you select another linetype.  

Note: We recommend that you set both the current color and the current 
linetype to the logical BYLAYER. This means that the entities take on the 
color and linetype of the current layer. It also means that entities moved to 
another layer will automatically change to the color and linetype of that other 
layer. In the long run, this makes drafting with FelixCAD much easier. 

You find detailed references about layer concepts, linetype, and color 
properties in Layer and Object Properties.” 
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The Control Panel 
The control panel is located on the left side of the screen. This panel contains a 
permanent series of command or function buttons. You can turn the control 
panel on and off by selecting File > Desktop Manager > Left Toolbar > On 
or Off. 

 

The control 
panel 

The symbols are arranged in the control panel in five 
groups: 

• Precision Drawing Assistants: 
Explanation of these commands is found in “Drawing 
with Precision.” 

• Controlling Drawing Views:  
Explanation of these commands is found in “Viewing 
Drawings.” 
 

• User Coordinate Systems and Layout Mode:  
Explanation of user coordinate systems are in 
“Viewing Drawings”; the layout mode is explained in 
“Printing and Plotting & Using the Layout Mode.” 

• Dimensioning, Hatching, and Text:  
Dimensioning is discussed in “Dimensioning”; 
hatching is explained in “Hatching”; and text editing is 
covered in “Text Objects.” 

• Inquiry Commands: 
Explanation of these commands is found in “Inquiry 
and Information Functions.” 
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The Status Line 
The status line is located at the bottom of the program’s desktop. It contains a 
series of information fields that report on the status of FelixCAD. You can turn 
off and on the status bar with the File > Desktop Manager > Status Bar. 

 
The status line displaying help text (left) and X, Y, Z coordinates at right 

The first field, at left, displays the current drawing coordinates in relative 
mode. For example, 1.00 < 90.00 means the entity being drawn is currently 1.0 
units long, at 90.00 degrees from the last point.  

 
 

The status line displays relative coordinate during drawing 
 

When the cursor is over the button of a symbol bar, menu item, palette 
(toolbar), a concise description of the command’s functions is displayed here.  
In the center, the current coordinate system mode is displayed: 

• WCS: world coordinate system (the default). 
• UCS: user-defined coordinate system. 
 
The last three information fields specify the X, Y, and Z coordinates of the 
current cursor position. 

The Drawing Area 
The drawing area is the part of the desktop where you draw and edit drawing 
entities. 

You can open up to four drawings, each with up to four viewports, 
simultaneously in the drawing area. As mentioned earlier in this chapter, each 
drawing and each view is represented by their own window. The windows can 
be tiled, cascaded, or enlarged to fill the drawing area. 

When more than one window is open, only one is the active window. The 
active window is recognized by its dark title bar. You can only work on the 
drawing in the active window. To make a window active, simply click on it.  
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Within the drawing area, the cursor appears as a tri-color crosshair: 
• Red: x-axis. 
• Green: y-axis. 
• Blue: z-axis. 

The tri-color cursor makes it easier to know where you are when working with 
three-dimension drawings. (Outside of the drawing area, the cursor assumes the 
typical Windows pointing shapes.) You can change the colors of the cursor 
with dialog box displayed by the File > Configure > Colors command. 

 
The tri-color cursor (center) and coordinate symbol (left corner) in a 3D view 

 

FelixCAD places a coordinate symbol in the lower left corner of each drawing 
window. This symbol indicates the position of the axes of the coordinate 
system. It uses the same color coding system as the tri-color cursor. You can 
turn off the coordinate symbol with the TIcon command. 

ENTERING COMMANDS 
To draw and edit with FelixCAD, you enter commands and their options, 
define points, distances, angles, and select entities. FelixCAD offers several 
options for doing this: all command input can be performed by the keyboard, or 
by the mouse controlling the cursor. Or, you can combine the two. 

For example, when drawing a line you can define the first point by typing the 
X, Y coordinates of the start point on the keyboard, and then define the second 
point by pointing the second point with the cursor control. The selection of 
input device is your decision.  
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Mouse Buttons 
The buttons on your mouse perform specific functions. We recommend that 
you memorize the meaning of these buttons: 

Left Mouse Button 
The left mouse button indicates points, select entities, and selects commands 
from pull-down menus and palettes (toolbars).  

Right mouse button 
The right mouse button is the same as the Enter key. It is used to: 

• Confirm input and output operations. 
• Accept default values. 
• Repeat a command. 

 
Middle Mouse Button 

The middle mouse button displays a floating menu. If your mouse has just two 
buttons, hold down the Ctrl key and press the left mouse button. 

During a command (when is command is active), pressing the middle mouse 
button displays an object snap menu with available options. 

When no command is active, the middle mouse button displays a menu of the 
most commonly used commands. (The commands are explained later in this 
manual, with more detail, in the appropriate sections.) 
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The floating menus displayed by the middle mouse button 
 

Command Options 
Almost all commands include options. For example, the Circle command has 
several options so that you can specify the circle several different ways, such as 
by centerpoint or circumference, radius or diameter, or tangent points. 

Keyboard 
Unlike most Windows applications, FelixCAD allows you to type commands 
via keyboard input. The advantages are that you work faster and can enter 
precise parameters. In fact, combinations of both keyboard and mouse input are 
still more efficient. An example would be starting a Line command by simply 
hitting the "L" key and a right mouse click to start the command, etc. 

Note for AutoCAD Users: Refer to the "FelixCAD for AutoCAD" companion 
guide for instructions on how to convert the default FelixCAD command 
"alias" to an AutoCAD emulated command alias.  

Most of the commands that create, modify, and detail drawings are keyboard-
based, as are FLISP expressions. Some specific Window operations are 
accessed via accelerator keys, such as Ctrl+F4 to close a window.  

To type a command at keyboard, enter the command name behind the command 
prompt in the Command Line area. The command prompt looks like this: > 
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You are then asked to enter additional input, which you can do with the 
keyboard or the mouse: 

> circle 
Center point: [pick] 
Radius: 2.35 
> 

Pull-Down Menus 
Commands (and their options) can be selected using the pull-down menus. You 
can click on the menu items or use the keyboard. 

To access the Circle command from the menus, click on the Draw menu, then 
click the Circle item on the pull-down menu. 

To use the keyboard, hold down the Alt key then press the underlined letter of 
the menu item. For example, for the Circle command, hold down Alt and press 
D. Let go of the Alt key and press the C key.  

Symbol Buttons 
Frequently used commands are grouped together in palettes. The palettes 
contain rows of button containing symbols. There are two kinds of symbol 
buttons on the desktop: 

• Permanently displayed symbols in the toolbar or the control panel (side bar). 
These buttons represent mainly commands from the pull-down menus File 
and View. 

• Symbols in palettes, arranged in any way, which can contain any command 
for which the palette is designed.  

 

 
 

The Draw symbol palette 

Commands and functions are called from a palette by clicking on the symbol. 

Transparent Commands 
Most commands are executed at the > command prompt. In fact, you usually 
cancel one command (by pressing the Esc key). Sometimes, however, you need 
to use one command during another command. For example, you may need to 
pan the drawing over during the Line command. 
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There is a special group of commands that you can use in the middle of another 
command. These commands are called transparent commands. You use a 
transparent command by prefixing the name with an apostrophe, such as 
’Zoom.  

Examples of transparent commands include: 

• Changing the view of a drawing – ’Zoom, ’Pan. 
• Arranging the drawing windows – ’WCascade, ’WTile. 
• Setting the precision – ’Grid, ’Snap, ’Ortho, an object snap functions. 
• Switching between command line area and text window – ’TScreen. 
• Loading and closing palettes – ’PalMan. 
• Calling the ’Help command. 

 
After the execution of the transparent command, the program continues with 
the original command.  

Note: Transparent commands cannot be executed if the program is requesting 
input of text or if a command’s dialog box is active. 

Repeating a Command  
Often, you find you need to repeat a command. For example, you might be 
using the Line command over and over again. To repeat the same command by 
pull-down menu or keyboard entry gets annoying and inefficient.  

You repeat the last command by one of three methods:  

1. pressing the Enter key or  

2. clicking the right mouse button or 

3. Pressing the Spacebar key.  

For example, the first Enter ends the Line command; the second Enter repeats 
the command: 

> line 
From point: P1 
To point: P2 
To point: P3 
To point: [Enter] 
 
> [Enter] 
LINE 
From point: P4 
To point: P5 
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To point: P6 
To point: Close  

Note: Some commands, like Point and Trim, automatically repeat themselves.  

Canceling a Command 
Sometimes you want to cancel a command before it has been completed. This 
can happen if you start a command was activated by accident, or if the 
command automatically repeats itself.  

To cancel the execution a running command: 

• Click the symbol  . 
• Press the Esc key. 
 
This interrupts the execution of the current command. At the command line, 
you see the message *** Cancel ***. . 

Reversing a Command (Undo) 
If you recognize that you made a mistake, you can reverse the effect of the 
command. FelixCAD archives all steps you’ve taken during the current drawing 
session. This archive is called the undo list.  

The Undo command reverses the each step sequentially. You can keep using 
the Undo command until you get back to the beginning of the drawing session. 
At that point, FelixCAD declares, “Undo list is empty!”. 

• Click the Undo button . 
• Select Undo from the Edit menu. 
• Type U at the keyboard and press Enter.  

Some commands are not stored in the undo list. These include commands that 
control the viewport (Zoom, Pan, and Window), set parameters, and other 
transparent functions. These steps cannot be reversed by the Undo command.  

The undo list is kept only with the current session of the program. It is not 
saved with the drawing.  

Restoring the Reversal (Redo) 
If you undo too far, you can use the Redo command. It cancels the last Undo 
operation. The drawing is restored to the last state prior to the Undo command 
– and this is only possible if there has been no other command executed 
between the Redo and Undo commands  
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• Call the Redo command by clicking the symbol   . 
• Select Redo from the Edit menu;  
• Enter the Redo command at the command line. 

 
Deleting & Undeleting Entities  

While creating a drawing, you may need to erase certain parts of the it. The 
Delete command erases entities from the drawing, as follows:  

• Click the symbol  .  
• Select the Delete command from the Edit menu.  
• Type the Delete command in the command line area. 
 
You can use the Delete command these entities: 

• Individual drawing entities, like lines, circles, rectangles, or for groups of 
these entities. 

• Parts and attributes.  
• Text objects. 
• Dimensioning and hatching. 

 
To delete an entity that is in a part (block), you must first explode the part with 
the Explode command. Delete the entity, then regroup the remaining entities 
into a part again with the PartDef command.  

Entities that have been deleted by mistake can be restored by the Undelete 
command:  

• Click the symbol   . 
• Select the Undelete command from the Edit menu.  
• Type the Undelete command at the command line. 
 
This causes all previously deleted entities to be restored. 

Renaming Names  
The Rename command allows you to alter the names associated with blocks, 
layers, linetypes, text styles, dimension styles, user coordinate systems, and 
views. Take these steps:  
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• Start the Rename command. 

• Select database table to be renamed from the option bar. 

• Enter the name of the object to rename. 

• Type in the new name of the item. 
 
> RENAME 
Rename symbol (BLock, Dimstyle, LAyer, LType, Style, Ucs,  
 or View): LA 
Current name: dimensions 
New name: dim 

Note: You can rename these named symbols with the Drawing Xplorer. 

Purging the Drawing  
The Purge command cleans the drawing file of unused named objects. You can 
remove blocks, layers, linetypes, text styles, or dimension styles that you have 
defined or loaded before but are not used in the drawing.  

> PURGE   
Purge unreferenced symbols (Blocks, Dimstyles, LAyer, LTypes, 
Textstyles or All):  

The Purge command can selectively purge the drawing, as follows: 
• You can use the command for deletion of unused named objects within 

only one of the drawing database tables. To do so, first select the type of 
table to be purged. You are prompted for the names -- one after the other -- 
of unused named objects of the specified table.  

• If you want to purge all drawing database tables, reply All to clean up the 
entire drawing in one operation. You may respond with a name pattern to 
limit the selection to certain names by using wildcard specifications (for 
example: TEMP*). 

To purge a drawing file 
To purge all unreferenced symbols in any drawing database table, respond as 
follows: 

> PURGE 
Purge unreferenced symbols (Blocks, Dimstyles, LAyer, LTypes, 
Textstyles or All): ALL 
Names to delete <* = All>: * 
Confirm each name? <Y>: N 
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Notes: Purging a drawing can significantly reduce its file size. This operation is 
a good habit before archiving or backing up a drawing file. 

Some standard objects cannot be purged: These include the layer named 0, the 
linetype CONTINUOUS, and the text style STANDARD. 

The Purge command does not handle named views and user coordinate 
systems, because these named objects are never referenced by another 
component of the drawing. Instead, you delete unused views and UCSs via the 
View and Ucs commands.  

Only one level of nested blocks is purged at a time. You may need to repeat the 
Purge command. 

DRAWING XPLORER * 
The Drawing Xplorer allows you fast and uncomplicated access to important 
information about the currently open drawing(s). The Xplorer can be used to 
alter properties of the current drawings.  

More precisely, the Drawing Navigator is a tool to manage the named objects 
of the drawing database tables. You can handle the tables and table entries of 
layers, linetypes, text styles, views, user coordinate systems, and blocks. 

To activate this tool, type the command Xplorer or select Drawing>Explorer 
from the Edit menu.  

The Xplorer window displays a preview bitmap of the currently open drawings 
in the area under the menu bar. To switch to another drawing, click the 
appropriate bitmap. A tooltip over the bitmap displays the drawing name, 
including drive and path.  
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The Table list box allows you to select a specific table. The named objects for 
the selected table are shown in the Name list. 

 

The Drawing Xplorer permits the following: 

• Delete unused, unreferenced table entries (allowed only for the active 
drawing). 

• Rename table entries (allowed only for the active drawing). 
• Set the layer, linetype, text style, user coordinate system, or named view 

(allowed only for the active drawing) by double clicking to one of the table 
entries. 

• Insert a block by double clicking to its name. 
 

Click the Tool button to display the corresponding dialog box associated with 
the table name. For example, if Layer is the table selected in the Drawing 
Navigator, the Tool button displays the Layer Manager dialog box. This lets 
you create new layers. 
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Customizing the User Interface  
You can customize FelixCAD’s user interface, so that the program better 
matches your needs and habits. You may remove (and reinstate) components, 
customize all the buttons in the tool areas, and change the menu system.  

Modifying the Desktop Layout 
The DeskConf command (File > Desktop Layout) displays a pop-up menu 
that lets you rearrange the desktop. The menu allows you to determine the 
layout of the command line, option menu or bar, property bar, left toolbar 
(control panel), and status line. 

 
 

The Desktop Layout pop-up menu 
 

Command Line 
The command line can be placed at the top of the screen (below the menu bar), 
or at the bottom of the screen (above the status line). If you are an advanced 
user familiar with the program’s command set, you might even turn off the 
command line. 

Options  
The options menu can be displayed as a bar (under the command line) or as a 
floating menu. Once again, if you are an advanced user familiar with the 
command options, you can turn off the option menu and bar.  

Properties  
The property bar can be turned on or off. We recommend you turn it on.  

Left Toolbar  
The control panel (also known as the left toolbar) can be turned on or off.  

Status Bar  
The status bar can be turned on or off. We recommend you leave it on.  
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Customizing Toolbars  
The toolbars (we call them palettes) assemble buttons that represent a common 
set of commands, or sequence of commands.  

Dragging an Icon to a Toolbar 
You add command icons (or symbols) to a toolbar by simply dragging a button 
from a palette into a toolbar. Follow these steps: 

1. Open a palette containing the icon of a command which you want to place 
into a toolbar. Type the PalMan command and select palettes from the 
Palette Manager. 

2. Hold down the left mouse button on the icon you want and drag the icon to 
the desired location within a toolbar. 

3. Release the left mouse button to drop the icon at that position. 

Adding an Icon to a Toolbar 
Follow these steps to add an icon to a toolbar: 
1. Right-click the button you want to place a new icon on. The following 

dialog box opens:  

 
 

Specifying the properties of a toolbar button 
 

2. Specify the command name, the bitmap file, and the messages for the 
tooltip of the button and the help string displayed in the status bar. 

3. Click OK. 

If you want to protect the button from being overwritten, enable the Protected 
check box. 
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Deleting an Icon from a Toolbar  
You can delete an icon from the toolbar only when the button is not protected. 
You unprotect a button by right-clicking the button and then disable the 
Protect option in the Toolbar Configuration dialog box.  

Follow these steps to delete an icon from a toolbar: 
1. Hold down the left mouse button over the icon you want to delete. 
2. Drag the icon onto the drawing window, or to the background area of the 

drawing area of the desktop. 
3. Release left mouse button. 

The icon is removed from the toolbar. You may then place another icon onto 
that button. 

Configuring FelixCAD  
The Config command (File>Configure) initiates a 
dialog allowing you to set up a variety of system 
parameters. A series of 5 tabs along the top of the 
dialog allows you to set:  

Common Tab  
File locking - If checked, other users trying to 
access the current drawing across a network will be 
denied permission.  

Safety - Allows you to select auto-saving of drawings, along with the file 
extension and interval for automatic backup. Note that each time a file is auto-
saved, the system will experience a slight delay (depending on the power of 
your computer and the size of the drawing), and the contents of the undo list are 
cleared. For this reason, it is advised you set the interval to 20-30 minutes.  

Directories Tab  
This is where all working directories of the system are set. Unless you are an 
advanced user, it is advised you do not alter the default settings.  
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Alias Commands Tab 
The alias command tab allows you to quickly and easily assign keyboard 
command "shortcuts" for any FelixCAD command. 

The standard command alias includes a variety of one or two character 
command shortcuts designed to speed up your work. And example would be 
typing ZW at the FelixCAD command line will execute the recursive command 
Zoom, then Window. 

You may add new command aliases, or edit existing aliases as needed. 

Note: Command aliases are saved in files with the extension .KEY. FelixCAD 
4.01 or higher ships with an AutoCAD command alias (Facad14e.key), which 
can be used in place of the default FelixCAD .KEY file. Refer to the FelixCAD 
for AutoCAD guide for further details. 

HotKeys Tab 
FelixCAD allows user defined setting of "hotkeys" to further improve your 
productivity. You may reassign the default values to suit your own preferences. 

Colors Tab 
This is where you can reassign the default screen colors for the coordinate icon 
(all 3 axis), the background screen for the drawing window, the drag cursor for 
drawing, and the selection color for editing. 

You can also assign alternate fonts for the system and tooltip text.
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Drawing with Precision 

During the CAD drawing process, it is often necessary to specify precise 
coordinates and other values used in drafting. When FelixCAD needs input 
from you, a prompt will appear in the text window. The prompt asks you to 
enter a value, examples of which include: 

• Coordinates for defining points of the drawing, such as the start and end 
points, center points, insertion points, base points, or target points. 

• Distance. 
• Angle. 
• Widths, for example the width of a line. 
• Numbers. 
 
In this chapter, you learn how to provide data input to FelixCAD. Also, this 
chapter describes commands that serve as drawing aids, such as: 

• Precision aids (grid, snap grid, and orthogonal mode). 
• Object snap functions. 
• Deleting and undeleting drawing objects. 
  
Most of the commands described in this chapter do not create or modify 
entities. The settings (grid, snap) and methods of selecting and snapping objects 
make the drawing much more precise. 

DATA INPUT 
FelixCAD lets you input data, such as coordinates and distances, via the 
keyboard or the cursor.  

Coordinate Input 
When you provide a FelixCAD command with coordinate data, they can be 
entered as absolute or as relative coordinate values. 

Absolute Coordinates 
Absolute coordinates use the origin of the current coordinate system as their 
reference (starting) point. In the case of angles, the reference is the angle to the 
X-axis of the coordinate system.  
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An example of absolute X, Y-coordinates (2D) is 34, 4. An example of absolute 
X, Y, Z-coordinates (3D) is –0.12, 5.7, 1.0.  

Relative Coordinates 
Relative coordinates use the last defined point as their starting point. Relative 
coordinates are specified by adding the @ sign before the value. 

An example of relative coordinates is  @10, 12 – this defines a point which has 
a distance of 10 drawing units in the positive X-axis and 12 in the Y-axes from 
the last entered point. 

Moving an entity can use relative coordinates, and looks like this: 

Select objects: [pick] 
Basis point: 5,2 
Target point: @3,0 

Cartesian Coordinates 
Cartesian coordinates define a 2D or 3D point by its X, Y, and Z values. These 
values are entered separated by a comma. A dot is used as a decimal point. 
Numbers may be positive or negative. If no Z value is entered, it is interpreted 
as Z=0. 

A sequence at the keyboard might look like this: 

> line 
From point: 2.5,0 
To point: 5.75,0 
To point: 0,3.25,2.5 
To point: [Enter] 

Polar Coordinates 
Polar coordinates define a 2D point by its distance from the origin, and the 
angle in the X,Y-plane (from the X axis). The < sign separates the two values. 

For example, 1.41<45 defines a point at a distance of 1.41 drawing units from 
the origin of the coordinate system and an angle of 45 degrees from the X axis. 

Spherical Coordinates 
Spherical coordinates define a 3D point by its distance from the coordinate 
origin, the angle in the X, Y-plane, and the angle to the X, Y-plane. 
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For example, 10<60<45 describes a 3D point with the distance of 10 drawing 
units from the origin of the coordinate system, an angle of 60 degree from the 
X-axis in the XY-plane, and an angle of 45 degrees from the XY-plane in 
direction to the Z-axis. 

Cylindrical Coordinates 
Cylindrical coordinates define a 3D point by its distance from the coordinate 
origin, the angle in the X,Y-plane and its Z value. Distance and angle are 
separated by < , angle and Z-value by comma. 

For example, 10<60,5 defines a point with the distance of 10 drawing units 
from the origin of the coordinate system, an angle of 60 degree from the X-axis 
in the X, Y-plane, and a Zvalue of 5 drawing units. 

Distance 
Some commands, such as the Trim command, require that you input a distance. 
You do this in two ways: 

• Enter a numeric value, either a whole number (an integer), or a real 
number. You can use decimal numbers (12.34), scientific notation 
(1.234E+10), or as a fraction (12-3/4).  

• Point the distance by picking two points with the cursor.  

Widths  
Some commands, such as the Polyline command, may require that you input a 
width. You do this in the same way as defining a distance.  

Angles 
When a command, such as the Arc command, asks for an angle, you can 
provide the angle in the same way as distances. Angles are normally specified 
in degrees, counterclockwise from the starting point. The starting point, 0 
degrees, is located at “East,” the positive X-axis. 

Entering a distance with an angle requires the use of the < sign before the 
angle, such as 10<45. Relative angles also go in the counterclockwise direction. 
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Numbers 
Some commands require a discreet number. For example, the Polygon 
command asks for the number of sides. The value you provide must be a whole 
number.  

The following table gives an overview of the input formats of the different 
coordinate types, both for absolute as for relative coordinates. 

Type of Coordinate Input Format Example 

Absolute Coordinates   

Cartesian (2D or 3D) X, Y 
X, Y, Z 

3, 8 
3,8,6 

Polar (2D) distance<angle 7.5<45 

Spherical (3D) distance<angle,Z 7.5<45,12.2 

Cylindrical (3D) distance<angle1<angle2 7.5<45<33 

Relative Coordinates   

Cartesian (2D or 3D) @deltaX,deltaY, 

@deltaX,deltaY,deltaZ 

@3,8 
@3,8,6 

Polar (2D) @distance<angle @7.5<45 

Cylindrical (3D) @distance<angle,Z @7.5<45,12.2 

Spherical (3D) @distance<angle1<angle2 @7.5<45<33 
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Pointing with the Cursor 
Pointing is using the cursor to specify data on the screen. You can use the 
cursor to specify points, straight lines, angles, and other quantities. FelixCAD 
always interprets the cursor position as a coordinate: either X, Y, Z or 
distance<angle.   

Pointing has one clear advantage over keyboard entry: dynamic preview (or 
dragging) provides a kind of preview image of the result of your action. 

We recommend that you use pointing you must relate to entities that already 
exist in the drawing. For example, the center of a circle could be defined by the 
intersection of two lines. In this case, it is easier to indicate the center point by 
pointing at the intersection. 

Using object snap ensures that the accuracy of the coordinate input by pointing 
is improved. Object snap modes recognize geometric features, such as start and 
end points, intersection, center point, and perpendiculars. Using object snap 
modes results in greater precision – and faster drafting -- than entering 
coordinates at the keyboard. Object snap modes are summarized later in this 
chapter.  

Coordinate Filters 
Coordinate filters lets you mix keyboard entry with cursor picks. You can, for 
example, point the X-coordinate on the screen and type the Y-coordinate value. 
Here is an example with the Line command: 

> line 
From point: P1 
To point: x,10 
X-coordinate: end 
of: P2 
To point: 15,y 
Y-coordinate: cen 
of: P3 

The x, 10 is an example of using coordinate filters. You provided the Y-
coordinate via the keyboard (10), then picked the X-coordinate on the screen. 

In addition, this example shows the use of object snap modes. The words end 
and cen are endpoint and center point, respectively. So, when you picked the 
X-coordinate, you used the ENDpoint object snap to pick at the end of an open 
object, such as a line or arc. 
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The coordinate filters are: 

Filter Meaning 

 X Provide Y (and Z), ask for X. 

  Y Provide X (and Z), ask for Y. 

  Z Provide X and Y, ask for Z. 

  x,y Ask for X and Y, optionally provide Z. 

  y,z Ask for Y and Z, provide X. 

  x,z Ask for Z and Z, provide Y. 

  x,y,z Ask for X, Y, and Z. 

 

From 
When you are prompted to enter a point, the From option allows you to 
identify a point relative to a base point. For example, in a running line 
command you see these prompts and responses: 

> line 
From point: from 
Base point: [pick] 
Offset point: @3,3 
To point:  

The From option is different from object snap modes in that it does not expect 
you to pick a geometric features. Instead, it serves to retrieve a relative point 
from a temporary base point. After this, control returns to the command in 
progress. 

When prompted for the “Base point:”, you can use absolute and relative 
coordinates, as well as object snap modes.   

But when you are prompted for the “Offset point:”, you should only use  
relative coordinates (use the @ prefix). You can specify an absolute 
coordinate, however, this cancels the specification of a relative point. As an 
alternative, you can invoke an object snap option at this prompt. 
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OBJECT SELECTION  
Most editing commands require that you select one or more entities in the 
drawing. This happens any time you see the following prompt:  

 Select objects: 

FelixCAD provides a rich variety of methods for selecting multiple objects. 
The option bar displays these options:  

 
You can pick one or more entities at the “Select objects:” prompt. (The prompt 
keeps repeating until you press Enter.) All entities you select are added to the 
selection set. The Remove and Add options allow you to remove and add enti-
ties from the selection set. Selected entities are shown in color (magenta, by 
default).  

Object Selection Modes 
To select options, you can simply pick them, one at a time. It is more efficient 
to use an object selection mode to pick multiple entities. The options  are: 
  

Object Selection Mode Abbreviation 
Add Ad 

All A 

Cpolygon (crossing polygon) Cp 

Crossing C 

Fence F 

Last L 

Previous P 

Remove Re 

Single Si 

Window W 

Wpolygon (window polygon) Wp 
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Window 
The Window selection mode defines a rectangle by two diagonal corner points. 
All entities completely within the window are selected.  

Select objects: w 
First corner: [pick] 
Other corner: [pick] 
Select objects:  

 

Continue object selection or terminate it by pressing Enter. 

Crossing 
The Crossing selection mode defines a rectangle by two diagonal corner 
points. All entities within and crossing the window are selected.  

Select objects: c 
First corner: [pick] 
Other corner: [pick] 
Select objects:  

 

Continue object selection or terminate it by pressing Enter. 
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WPolygon  
The WPolygon (short for “window polygon”) selection mode defines a 
polygon by two or ore vertex points. All entities within the polygon are 
selected.  

Select objects: wp 
First point: [pick] 
Next point: [pick] 
Next point: [pick] 
Next point: [Enter] 
Select objects:  

 

CPolygon  
The CPolygon (short for “crossing polygon”) selection mode defines a polygon 
by two or more vertex points. All entities within and crossing the polygon are 
selected.  

Select objects: cp 
First point: [pick] 
Next point: [pick] 
Next point: [pick] 
Next point: [Enter] 
Select objects:  
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Fence 
The Fence selection mode defines a polyline by two or more vertex points. All 
entities crossing the polylinare selected.  

Select objects: f 
First point: [pick] 
Next point: [pick] 
Next point: [pick] 
Next point: [Enter] 
Select objects:  

 

Continue object selection or terminate it by pressing Enter. 

Last 
The Last object selection mode selects the last drawn entity, and adds it to the 
selecting set. 

Select objects: l 
Select objects:  

It is not possible to repeatedly use the Last mode to add to the selection set, 
since it only works for the one last drawn entity.  

Note: If the last drawn entity lies on a frozen layer, you receive the message in 
the command line area that no entity was selected. 
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Previous  
The Previous option restores the previous selecting set. All entities are marked 
(and highlighted) from the previous selection operation. This option makes it 
fast to select the same selection set over and over.  

Select objects: p 
Select objects:  

Note: If the previous selection set lies on a frozen layer, you receive the 
message in the command line area that no entity was selected. 

All 
The All option selects all entities in the current drawing -- with the exception 
of those located on frozen layers. 

Select objects: a 
Select objects:  

Remove &  Add  
The last field of the option bar contains a toggle button to switch between 
adding and removing entities to the current selection set.  

Select objects: r 
Remove objects: [pick] 
Remove objects: add 
Select objects:  

Click the Remove button on the option bar (or type r) to change the selection 
mode to remove entities. You can only remove entities that are already in the 
selection set; entities already selected and marked are removed from the 
selection set. The Add mode allows you to select additional entities. This 
option only makes sense after you use the Remove option.  

Single 
The Single option deactivates all object selection modes for the next and 
subsequent operations, with the exception of the standard modes Window and 
Crossing. 

Select objects: si 
Select objects:  

Note: This option is not offered in the option bar, but may be selected by 
keyboard input. 
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DYNAMIC PREVIEW 
Dynamic preview mode is a visual aid that allows you to see the result of a 
pending operation before it is executed. If necessary, you can make corrections. 
Dynamic preview also aids you in understanding the effect of a command on 
your drawing. 

 
 

Rubberband 
Any command that requires selection of two or more points, a marking line 
(rubberband line) follows the cursor movement. This line connects the last 
selected point with the current cursor position. 

This gives you a visual impression of the operation and allows a better estimate 
of distances and angles between the last fixed point and the following point.  

The rubberband line is useful both in drawing and in modifying objects. Used 
during the drawing process it illustrates the: 

• Ending point of the next segment of a line, chain or polyline. 
• Radius or diameter of a circle. 
• Distance between starting- and ending-point of an arc. 
• Next corner point of a 2D or 3D plane. 
 
When used during modification of objects, the rubberband shows the distance 
and angle from one base point to a second point, as well as the target point for 
moving, copying, scaling or other modifying steps. 

Object Preview 
The object preview shows, in advance, the contours of an object to be designed 
or modified. It is possible to recognize the consequences of changing of 
parameters like the radius of a circle or like removing or changing the angle of 
a copy of the original object. This option allows you to interactively influence 
these changes. 
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PRECISION AND UNITS SETTINGS 
FelixCAD allows you to set the format and display accuracy of numbers and 
angles. The settings are saved with each drawing, so they can be set differently 
in each drawing. The Setup command displays the Drawing Setup dialog box: 

 

Linear Units 
Linear units can be given a display accuracy ranging from zero to eight decimal 
places. In the case of fractional units, the display accuracy ranges from 0 (no 
fractions) to 1/256. You can select five kinds of units: 

• Decimal units (metric) – 12.3456. 
• Fractional units (unitless fractions) – 12 3/4 
• Architectural units (feet and fractional inches) – 12’-3/4” 
• Engineering units (feet and decimal inches) – 12-3.456’ 
• Scientific units (exponential notation) – 1.234E+02 
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Angular Units 
The Angular Units can be given a display accuracy ranging from zero to eight 
decimal places. FelixCAD recognized these angular measurement systems: 

• Decimal degrees – 12.3456 
• Degrees - minutes - seconds – 12d34’56. 
• Grads (400 grads in a circle) – 12.34g 
• Radians – 12.34r 
• Surveyors units – N12d34’56 E 

 
Orientation 

In most drawings, angles are measured in the counterclockwise direction. This 
is the default in FelixCAD and is called Standard Angles.  

You can, however, change the orientation so that positive angles are measured 
in the clockwise direction, called Compass Angles.  

Angle Zero Direction 
In most forms of drafting, zero degrees is located at the positive X-axis (East, 
or 3 o’clock). FelixCAD allows you to change the location of zero degrees. For 
example, surveyors normally set zero degrees as up on the page (North, or 12 
o’clock). The display of the status bar is updated depending upon the settings 
of the angle zero direction and the orientation. 

 
 
 

Surveyor Units Entry  
Because the surveyor units are so different form the other forms of angle entry, 
we have included a few examples:  
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Type of coordinate Input Example (Surveyor Units)

Absolute Coordinates   

Polar distance<angle 7.5< N34D30’45”W 

Relative Coordinates   

Polar relative distance<angle @7.5< N34D30’45”W 

In surveyor’s notation, the N stands for North. The 34D is 34 degrees from 
North. The 30’ is an additional 30 minutes, and the 45” is an additional 45 
seconds from North. The W indicates that the angle is towards the West. 

There are 60 seconds in a minute, 60 minutes in a degree, and 360 degrees in a 
circle. Surveyors divide the circle into four parts, each with 90 degrees 
measured from the North or South poles in the direction of East or West. 

 
In the figure above, we see the four points of a compass: North, South, East, 
and West. As examples of how the Surveyor’s Units work, several lines have 
been drawn in various directions. We labeled these lines with the correct 
bearings. Note that all the letters used in the bearings are in capital letters, as 
required by FelixCAD. 

Note: When entering the N, S, E, W and D, be sure to enter them as capital 
letters -- lower-case does not work. 

DRAWINGS SETTINGS 
The Settings command (Options > Settings) is the primary command for 
setting up the drawing environment. The command displays the Settings dialog 
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box, which has six tabs that group together related settings. AutoCAD users will 
see this commands similarity with the Preferences option (previously the 
CONFIG command) for system parameters. 

 
 

Tab Command Reference 

Object Snap PrecPar Chapter 2 “Drawing with Precision” 

Snap/Grid PrecPar Chapter 2 “Drawing with Precision” 

Draw Modes DrawMode Chapter 5 “Basic Drawing Elements” 

Construction Points DrawMode Chapter 5 “Basic Drawing Elements” 

View Parameters ViewPar Chapter 3 “Viewing the Drawings” 

Edit Parameters EditPar Chapter 6 “Modifying Drawing Objects” 
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PRECISION DRAWING AIDS 
Working with CAD involves drawing new entities, modifying existing objects, 
and doing detailing operations (dimensioning, for example). To assist you, 
FelixCAD provides you with precision drawing aids that help you precisely 
define specific points in the drawing. 

The precision aids include snapping to a grid, drawing orthogonally, and object 
snap modes. These aids can be turned on, off, or changed – even in the middle 
of a command.  

With Snap activated, your cursor picks are made to the nearest snap points. For 
example, if snap is set to 0.1mm, you make picks to the nearest 0.1mm. You 
can set the snap spacing to any value. For example, if you want your drawing 
accurate to the nearest 1/4”, you would set the snap spacing to 0.25. 

The Grid display covers the drawing area with a visible array of dots. This 
helps you in several ways: (1) you see the limits of the drawing; (2) you get a 
sense of the drawing scale; and (3) you see the snap distance, a multiple 
thereof. As with the snap distance, you can set the grid spacing to any value. 
For example, if you want a 1-foot grid, you set the grid spacing to 12 inches.   

The grid does not cover the entire drawing. Instead, its extent is limited by the 
LimMin and LimMax system variables: 

• LimMin sets the lower left corner (limits) for the grid display area. 
LimMax sets the upper right corner (limits) for the grid display area. 

Ortho (short for “orthogonal”) mode constrains the movement of the cursor to 
the horizontal and vertical direction. This makes it easier to design and place 
parallel and orthogonal lines and other entities. 

OSnap (short for “object snap”) modes allow you to work with geometrically 
significant points of entities. These geometric features include end points, 
intersections, center points, and so forth. You use osnap modes in two ways: 
turn them on permanently (until turned off again), or temporarily (active for a 
single pick). You can display the object snap modes by clicking the middle 
mouse button, or via the Precision Aids dialog box. 
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CONTROLLING PRECISION PARAMETERS 

  The PrecPar command (short for “precision parameters; Options > 
Draw with Precision) displays a dialog box that contains settings for drawing 
with precision. You can also access the precision drawing aids by clicking the 
symbol (shown above) in the control panel. 

To toggle (turn on and off) Ortho, Snap, and Grid mode during a command, 
click on one of these buttons: 

 
These control panel buttons toggle Ortho, Snap, and Grid mode. 
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Snap Grid 
The Snap Grid area controls the spacing of the snap. With Active turned on, 
the cursor can only select points that are positioned directly on the grid. Width 
and Height lets you specify the snap distance. Origin lets you change the 
origin of the snap. The Snap Angle field lets you rotate the snap, which also 
rotates the Grid and Ortho mode. The snap grid always follows the axes of the 
current coordinate system. 

Note: The snap distance does not influence points defined by keyboard 
coordinate input. Even with snap activated, you can define points not on the 
grid by keyboard entry. 

Width & Height 
The Width and Height fields let you enter values for the horizontal and 
vertical distance between the snap points. Units of measurement for these 
values are drawing units. The value 1.0000 represents the distance of one 
drawing unit. The = button sets the height value equal to the width value. 

Origin 
The Origin fields allow you to define the origin of the snap on the X and the 
Y-axes.  

Note: This setting also affects the origin of the grid and hatch patterns. 

Snap Angle 
The Snap Angle field allows you to change the angle of the snap. To rotate the 
snap grid counterclockwise, enter a positive number (usually between 0 and 90 
degrees) in the edit box. To rotate the snap grid clockwise, enter a negative 
value (usually between 0 and -90 degrees). 

Note: This setting also affect the angle of the grid, hatch patterns, and ortho 
mode. The snap can also be rotated with the Z-Direction option when setting a 
User Coordinate System (see UCS command). 

You can also set the snap origin and angle with the SnapBase and SnapAng 
system variables.  
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Grid Spacing 
Turning on the Active checkbox displays an array of dots on the drawing called 
the grid. The grid offers you a visual impression of the distances, proportions, 
and other relations of the drawing.  

 
 

The small dots in the drawing area make up the grid display 

Often the grid spacing is a multiple of the snap distance. For example, the snap 
distance is 1 inch while the grid distance is 1 foot. The grid is meant to be a 
guide; when the grid is dense, the drawing is difficult to see. When the grid is 
too dense, FelixCAD does not display it. 

Factor 
The Factor field defines the ration of the grid spacing to the snap spacing. You 
can select a pre-defined value by clicking one of the buttons. 

Note: The grid and snap settings become effective after the dialog box is 
closed. 

The grid only appears in the area specified by the LimMin and LimMax 
system variables. These two variables control the area of the drawing covered 
by the grid, when turned on. 



Chapter 2   Drawing With Precision 

 81 

Orthogonal Mode 
Orthogonal mode is useful while drawing or modifying entities: it forces the 
cursor to move in horizontal (along the X-axis) and vertical (Y-axis) directions.  

You can rotate ortho mode by specifying an angle via the Snap Angle field of 
the Snap Grid area in this dialog box. 

Note: Ortho mode is effective only when picking points using the pointing 
device. You override ortho mode when you type coordinates at the keyboard. 

 

Ortho mode aids in designing by allowing: 

• Lines, chains and polylines to be designed along lines parallel to the axes of 
the coordinate system; 

• Changes of direction when drawing lines, chains or polylines to be 
perpendicular to the current axes; 

• Construction points for geometrical objects (such as radius, diameter, arcs, 
ellipses, ending points for polylines, chains and so forth) to always be 
parallel to the axes of the coordinate system. 

 
When you are modifying objects, ortho mode means that points for scrolling, 
scaling, rotating, and so forth, are exactly parallel or perpendicular to the axes 
of the defined base point.  

The orthogonal mode is effective to use in drawing and modifying rectangular 
aligned geometry. 
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Isometric Snap/Grid 
FelixCAD allows you to draw in isometric mode, which produces the illusion 
of 3D. The isometric snap style assists you in isometric drawing. In addition, 
isometric mode skews the shape of the cursor (see figure). 

 The lines aligned to the angled, isometric axes give the impression that you are 
looking at front, top, and side views of an object. Rectangular objects, for 
example, are usually drawn as parallelograms with 30, 90, or 150-degree 
angles. 

 
The isometric grid 

The Left, Top, and Right radio buttons determines the current isometric plane:  

 
• Left: isometric crosshairs at 90° and 150° 
• Top: isometric crosshairs at 30° and 150° 
• Right: isometric crosshairs at 90° and 30° 

Note: You must turn on the grid to see isometric grid. 

The isometric snap grid has three major axes. By default (as long as no rotation 
of the snap grid is applied), the axes of the isometric style are 90° (the vertical 
axis), 30° and 150°. 

The cursor moves in only two of the three axes at a time. Each of the three iso-
planes has an associated pair of axes. 
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OBJECT SNAP MODES 
For precise drafting, many commands require that you select an exact position 
in the drawing. You can pick the precise location by typing the coordinates, or 
by picking a point in conjunction with an object snap. Object snap allows you 
to pick geometrically significant points on existing entities. 

Object snap mode can be activated permanently or called for a single pick. The 
OSnap command lets you turn on object snap modes; transparent commands – 
such as mid and qua -- temporarily activate an object snap mode. 

The procedure for using the object snaps is always the same: 

1. Start a command that requires a point, such as “From point:”. 
2. When the point is requested, reply with an object snap mode; the command 

prompts for the point with “of”.  
3. Select the object with the cursor. 
 
Here is an example of using object snap. A line is drawn from the center (cen) 
of the circle to the corner (int) of the rectangle: 

> line 
From point: cen 
of [pick] 
To point: int 
of [pick] 
To point: [Enter] 

 
 

Drawing a line using object snap modes 
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Some object snap modes make no sense. For example, you can not define the 
end point of a circle (use the qua mode instead), nor can you pick the center of 
a line segment (use the mid mode instead). 

On the other hand, you can use several osnap modes on entities. For example, a 
line can use the end mode (twice, one for each end), mid mode, and per 
(perpendicular) mode. An arc can use end mode (again, twice), mid, cen, per, 
qua (quadrant points) and tan (tangent) modes.  

The end object snap mode does not differentiate between starting or ending 
point of an entity; you must be careful with your pick point. The object snap 
selects the nearest of the two possible points.  

The illustration below shows the connection between the point selected and the 
point snapped: 
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Running Object Snap 
Using the Precision Aids dialog box, object snap modes are turned on. This is 
called running mode. 

 

Click the checkboxes for the desired mode(s). A check mark indicates the mode 
is active. Clicking the off button deactivates all running snap modes. 

When several object snap modes are on, you differentiate between them by the 
way you select an entity. For example, End Point and Intersection are on; pick 
a point nearest an end point, then the end is selected. If you pick a point near 
the intersection of two entities, then the intersection is selected. Properly 
configured, this feature can speed the drawing of entities significantly. 

Temporary Object Snap 
You can choose between several options for a one-time activation of an object 
snap mode. You can use the Snap Palette to activate an object snap mode just 
one time during a command.  

An effective method of calling an object snap mode is to bring up the cursor 
menu. Press the middle mouse button (or hold down the Ctrl key and press the 
left mouse button on a two-button mouse). The following menu is displayed, 
from which you select an object snap mode: 

 
Use the keyboard to type a command abbreviation. The object snap modes and 
their abbreviations are shown in this table:  
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Object Snap Mode Abbreviation
End point end 
Mid point mid 

Center point cen 

Quadrant qua 

Intersection int 

Implied Intersection Imp 

Perpendicular to Per 

Tangent to Tan 

Next point on entity Nxt 

Insertion point Ins 

Point entity Pnt 

Object Snap Modes in Detail 
There is a difference between object selection and object snap modes. Object 
selection treats a group of entities, such as a rectangle, chain, and polyline, as a 
single object. In contrast, object snap modes treat these as individual entities. 
For example, you can snap to each segment and vertex of a polyline. This is 
also true for polygons and 2D and 3D faces.; the edges are interpreted as by 
object snap as individual lines In this way, the object snap modes can be used 
for the edges of planes as well as for segments of chains and polylines. 

For simplicity, when this text refers, for example, to the “end point of a line” 
the term also refers to polyline segments and the edge of a plane.  



Chapter 2   Drawing With Precision 

 87 

ENDpoint   
The End object snap snaps to the endpoint of a line or of an arc. The endpoints 
of planes and faces can be accessed. 

 

MIDpoint   
The Mid mode snaps to the center of a line or an arc. Te edges of faces may 
also be snapped.  
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CENterpoint   
The Cen mode snaps to the center point of a circle, arc, and polyarc.  

 

QUAdrant  
The Qua mode snaps to the nearest quadrant of a circle or an arc.  Quadrant 
refers to the points situated on the circumference at 0, 90, 180 and 270 degrees. 
Only the next visible quadrant of an arc can be snapped. 
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INTersection   
The Int mode snaps to the intersections of a pair of lines, arcs, and other 
entities -- or any other combination of them. This includes dashed and 
centerlines where the intersection point may not have line segments actually 
touching. 

 

IMPlied 
The Int object snap mode only returns an intersection point of entities that have 
a real intersection. In contrast, the Imp mode snaps -- in addition -- to an 
implied (intersection point. This is the point where the extension of two entities 
would intersect. 

PERpendicular   
The Per mode snaps to the perpendicular to an entity. This mode requires that a 
starting point already been selected. For example, when a perpendicular is 
desired, the ending point for the perpendicular is picked. The result is a 
perpendicular line from the ending point to the chosen entity.  
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TANgent   
The Tan mode snaps to the tangent point of a curve. This mode requires that a 
starting point has already been selected. For example, when a tangent to a circle 
is desired, the ending point for the tangent line is picked. The result is a tangent 
line from the ending point to the chosen entity. 

 

NeXT   
The Nxt mode snaps to the next situated point of an object when at least one 
point of this object lies within the borders of the selecting cursor box. This 
ensures that entities that are designed or modified by use of the object snap 
mode share a point with the selected object.   

(If you select a point in 3D space without using this object snap mode, it is 
possible that the selected point is not on the desired object. The two objects 
would not have a common point, or a closure.)  
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INSertion   
The Ins mode snaps to the insertion point of a part, an attribute, or a text 
object.  

PoiNT   
The Pnt mode snaps to a point entity, which was created by the Point 
command.  
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Viewing Drawings 

Unlike a paper drawing, using a CAD program involves a trade-off between 
seeing all of the drawing (with little detail) or seeing a detail portion (of a small 
part of the drawing).  

Also, unlike a paper drawing, a CAD program allows you to view the drawing 
in three dimensions, and from an infinite variety of 3D viewpoints. 

In this chapter, you learn how to: 

• Work with windows, such as creating new views and switching windows. 
• View the drawing from different 3D directions. 
• Enlarging and reducing the view, as well as moving the visible drawing 

portion. 
• Create and use a coordinate system. 

 
FelixCAD has commands, such as Zoom, that change the viewing size of the 
drawing, which enlarge and or reduces the visible portion of the drawing. 
Another command, Pan, keeps the size of the drawing constant, but moves the 
drawing around in the window. 

Other commands change the viewpoint, so that you can see the left side or top 
view of a 3D drawing. 
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SETTING VIEW PARAMETERS  
You can preset parameters for the Zoom and Pan commands. The ViewPar 
command (View > View Parameters) displays the View Parameters dialog 
box.  

 

Zoom and Pan 
The Zoom In Factor and Zoom Out Factor fields lets you specify how far 
FelixCAD zooms with the ZoomIn and ZoomOut commands.  

The Pan Factor field lets you specify how far the drawing moves (called 
panning) with the PanUp, PanDown, PanLeft, and PanRight commands. A 
pan factor of 0.5, for example, moves the drawing by about half of the visible 
drawing area. 

Drawing Viewports  
FelixCAD is capable of opening as many as four drawings at the one time. 
Each drawing is viewed in its own window. Further, you can open as many as 
four viewing windows (viewports) of each drawing. Viewports allow you to see 
the drawing from different angles, or see different details – at the same time.  

A number, ranging from 0 to 3 identifies the windows. This number appears 
immediately behind the filename on the title bar, separated by a vertical line, as 
in Filename | 2.  

The windows can be arranged in tiles, cascades, or enlarged to fill the entire 
drawing area.  

When more than one window exists, only one window is the active window. 
The active window is identified by the color of the title bar. You pick another 
window to make it the active window; click on any part of the window with the 
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cursor. FelixCAD’s standard viewing angle is the top view (also called the plan 
view). At this angle, the X, Y-plane is viewed straight down the Z-axis. The 
drawing or construction plane is parallel to the screen.  

Creating a New Viewport  
Once a drawing is open, you create additional viewports with the WOpen 
command (Window > Open New Viewport). Before the program opens a new 
window, the New Window dialog box asks for the view direction. The 
AutoCAD equivalent to this command is the MVIEW command.  

 

Select a standard view from the View from buttons, or specify a custom view 
with the Theta and Phi sliders. (The view you select can be changed at any 
time.) Click on OK. The new window is created in standard size and arranged 
in the manner proscribed with the existing windows (tiled, cascaded, etc.). 

Theta / Phi 
The preview window, showing a house, lets you interactively change the 3D-
view direction. Move the Theta and Phi sliders and watch the house rotate in 
three dimensions. When satisfied with the viewpoint, click OK. 

View From 
Select a standard view from the View From buttons.  
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Plan View 
To switch quickly to a plan view, use the PlanView command (View > Plan 
View to Construction Plan). 

Changing the View 
The 3dView command (View > 3D View) displays the View Direction dialog 
box, which is the same as the New Window dialog box discussed above. It 
allows you to look at a drawing from any point in space that you wish to define. 
You must define the view direction, as described above. 

To change the 3D viewpoint at the command line, such as in macros or FLISP 
routines, use the SetViewDir command.  
> SETVIEWDIR 
Viewpoint (X,Y,Z): Rotate 

The Rotate option allows you to specify a new view direction, based on two 
angles entered as real numbers, as shown by the following prompts: 

Angle theta (rotation angle in x-y-plane) <0.0>:  
Angle phi (rotation angle to x-y-plane) <0.0>:  

The Angle theta is measured from the X-axis in the XY-plane. The Angle phi 
is specified up and down from the XY-plane. 

Note: The SetViewDir command cannot be used in paper space. 
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Changing the Active Window 
Once you have more than one window open, there are two ways you can 
change the active window: 

1. Click any part of a window to make it the active window.  
2. Click the Window menu, which lists the names of all open windows.  The 

active window is marked by a checkmark in front of its name. You may 
choose one of the listed windows as the active window by clicking on that 
view, or by entering the number assigned the view. 

Copying a Window 
The QWOpen command (Window > Copy Viewport) opens a new window 
and allows you to make a quick copy of the active window (Copy option) or of 
the plan view (Plan option). 

> qwopen 
New Window: Copy 

Closing a Window 
The WClose command (Copy > Close Current Viewport) closes the current 
viewport. Or, you may use the standard Windows methods of closing a 
window: type Ctrl+F4 or click the x in the upper right corner of the window. 
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ZOOM  
The zoom commands change the viewing scale of the drawing, or of the portion 
of the drawing chosen by the user. The absolute ratios of scale of the entire 
drawing to the included objects chosen remains unchanged.  

These variations on the zoom command are available:  

• Zoom Window 
• Zoom Back 
• Zoom Fit 
• Zoom In 
• Zoom Out 
• Zoom Scale 

 
Transparent Zoom 

The Zoom command, like most other view commands, is transparent 
commands that can be used at the same time another command is being 
executed. For example, you can use the ZoomOut command during the Line 
command. Remember that transparent commands need an apostrophe before 
the command name, such as ’zoomwin. 

> LINE 
From point: P1 
To point: P2 
To point: ’ZOOMOUT 
To point: P3 
To point: [Enter] 

The Zoom Palette 
You can select the zoom commands from the palette. The symbols used to 
activate the zoom options are: 

 

To activate a zoom command, click on its symbol. If you prefer to type 
commands at the keyboard, the zoom variations are found in the following 
table.  
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Zoom Options Command 

Zoom window ZoomWin 

Zoom to previous view ZoomBack 

Zoom to fit ZoomFit 

Zoom in ZoomIn 

Zoom out ZoomOut 

Zoom factor ZoomFac 

 
Zoom Window 

The ZoomWin command allows you to zoom into a rectangular area that you 
specify by opposite corner points with the cursor. As an alternative, you can 
type coordinates.  

> ZOOMWIN 
First corner: P1 
Second corner: P2 

There may be a difference between the window you chose, and the view you 
see on the screen. This is due to different ratios of height and width of your 
chosen window and the screen.  

The following figure shows the usage and result of the Zoom Window 
command. 

 

Zoom Back 
The ZoomBack command is like using the Undo command: it backs up to the 
previous view. Using this command allows you to switch quickly back and 
forth between two view to seen the drawing as a whole, or to see its details 
more clearly. 
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Zoom to Fit 
The ZoomFit command allows you to see the entire drawing as large as 
possible in the window.  

 

 
Zoom In 

The ZoomIn command enlarges the view with each successive use, by a factor 
defined by the View > View Parameters command. By default, this is 0.5.  
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Zoom Out  
The ZoomOut command is the opposite of the ZoomIn command. It reduces 
the view with each successive use, by a factor defined by the View > View 
Parameter command. The default is 2.0.  

 

Zoom Factor 
The ZoomFac command prompts you to enter the zoom factor. Numbers less 
than 1.0 reduce the size (equivalent to ZoomOut) and greater than 1.0 enlarge 
the size (like ZoomIn) 

> zoomfac 
Zoom factor: 1.2 

Zoom Page  
The ZoomPage command zooms out to the page size defined for your printer 
(or plotter)   

PAN 
The Pan command moves the visible portion of the drawing. The drawing can 
be moved to the right, to the left, upward, or downward. You now see  objects 
that were previously not visible because they were off the viewing surface. In 
contrast to the Zoom command, the view scale does not change.  

The Pan command, like most other view commands, is a transparent command 
that can be used at the same time another command is being executed. For 
example, you can use the PanDown command during the Line command. 
Remember that transparent commands need an apostrophe before the command 
name, such as pandown. 
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> LINE 
From point: P1 
To point: P2 
To point: ’PANDOWN 
To point: P3 
To point: [Enter] 

You can think of the Pan command like holding a camera. Think of being the 
photographer looking through the camera’s viewfinder, and moving the camera 
left and right, up and down.  

The Pan Palette 
You can select the pan commands from the palette. The symbols used to 
activate the pan options are: 

 

To activate a panning command, simply click its symbol. 

If you prefer to type commands at the keyboard, the pan variations are found in 
the following table. 

Pan Options Command 

Move view to the left PanLeft 

Move view to the right PanRight 

Move the view down PanDown 

Move the view up PanUp  
 

After selecting one of these commands, the visible drawing portion is 
immediately moved in that direction. The amount of movement is determined 
by a factor defined by the View > View Parameters command. By default, this 
is 0.5. 
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DYNAMIC ZOOM AND PAN 
Two commands allow you to zoom and pan directly, compared to the 
commands described above. 

DZoom 
The DZoom command lets you zoom in and out in real-time -- nearly 
seamlessly, in one operation (in the current drawing window). Dynamic zoom 
can be used transparently (in the middle of another command). 

Select View > Dynamic Zoom. Notice that the cursor changes to a magnifying 
glass with a plus and minus sign. To start the dynamic zoom process, drag 
(click and hold the left mouse button) up and down. To zoom in, drag up (in the 
direction of the plus sign). To zoom out, drag down (in the direction of the 
minus sign).  

When you reach the edge of the drawing window, release the mouse button, 
move the cursor away from the edge, and drag again. 

To exit dynamic zoom mode, press ESC or ENTER. You can also right-click to 
open the option menu, which contains the Exit option.  

Notice that the cursor menu also contains options for Dynamic Pan and Zoom 
Extents.  

Dpan  
The DPan command lets you pan around in real-time -- nearly seamlessly, in 
one operation (in the current drawing window). Dynamic pan can be used 
transparently (in the middle of another command). 

Select View > Dynamic Pan. Notice that the cursor changes to a hand. To start 
the dynamic pan process, drag (click and hold the left mouse button) around in 
any direction.  

When you reach the edge of the drawing window, release the mouse button, 
move the cursor away from the edge, and drag again. 

To exit dynamic pan mode, press ESC or ENTER. You can also right-click to 
open the option menu, which contains the Exit option.  

Notice that the cursor menu also contains options for Dynamic Zoom and 
Zoom Extents.  
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SAVING VIEWS 
When working with many drawing portions and view directions, it can be 
convenient to save (and later to retrieve) the viewpoint. You do this with the 
View command (View > View Manager).   

 

Saving the Current View 
First, use the zoom and pan commands described previously to set up a view 
direction. To save the view, start the View command. Then:  

1. In the Save/Retrieve View dialog box, select the New option. 
2. The View option save the current view; the Window option prompts you to 

select a rectangular window as the view.  
3. Enter a name for the view. Later, you use the name to retrieve the view. 
4. Click OK. 

 
During the drafting process, named views can be applied in two situations: 

• Printing: the Print command has an option for printing a named view. Hint: 
this is useful in printing different 'sheets' (i.e. 'sheet1', 'sheet2') that may 
exist in one drawing. 

• Paperspace:  when calling the command View in layout mode outside the 
Viewport command, you can create nam ed views within paper space (for 
example to zoom fast to portions of the drawing sheet). 



Chapter 3   Viewing Drawings 

 105 

Restore a Named View 
A previously saved view is retrieved with the View command. Follow these 
steps: 

1. In the Save/Retrieve View dialog box, choose one of the saved views from 
the list box. 

2. Click the Show button. The saved view then becomes the present view. 

 
Delete a Named View 

When you no longer need a named view, you can delete as follows: 

1. Select one of the names of defined views in the list box of the 
Save/Retrieve View dialog box. 

2. Click onto the Delete button. The named view is removed from the list 
immediately. 

 

USER COORDINATE SYSTEMS 
A user coordinate system is a coordinate system that you define. It is primarily 
used for 3D drafting. Creating your own UCS allows you to drawn in “plan 
view” at any angle in space.   

Until you create a UCS, you are drafting in the world coordinate system. Via a 
UCS, you can:  

• Move the origin (0,0,0) to any point in the world coordinate system.  

• Turn one or more axes relative to the world coordinate system. 

• Move and angle the user coordinate system. 

The user coordinate system, for example, makes it possible to change the 
location of the drawing plane so that it always lies parallel to the objects to be 
drawn. This makes it easier to construct 3D objects. 
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To determine the coordinates of a point, distances are measured from the point 
to the X- and Y-axis; in a 3-D system, measurements are also taken along the Z-
axis. FelixCAD differentiates between a world coordinate system (WCS) and 
the user coordinate system (UCS). 

 

World Coordinate System 
The world coordinate system is the permanent Cartesian coordinate system 
used as a standard for all drawings. The X-axis measures the horizontal 
distance; the Y-axis the vertical distance from the origin. The Z-axis is 
orthogonal to the X- and Y-plane and measures the distance of a point to this 
plane. You cannot change the world coordinate system. 

Instead, it is possible to create many user-defined coordinate systems for a 
drawing. The user coordinate system is saved along with the drawing and can 
be used again later. 

Creating a New UCS 
A UCS is created in two steps. First, you specify the origin and direction of the 
axes for the new UCS. Second, you have the UCS by name, so that you can 
reuse the UCS without having to reenter its parameters. 

The UCS command creates a new user coordinate system. At the “UCS origin 
<0,0,0>” prompt, enter the coordinates for the origin of the new user coordinate 
system. Or, press Enter to use 0,0,0. 

> ucs 
UCS origin <0,0,0>:  

Or, use the following options to interactively determine the origin of the user 
coordinate system and the direction of its axis: 

Control World Z-Direction 3Point View Rotation 
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Control 
The Control option displays the User Coordinate System dialog box to select 
an existing UCS. The dialog box also lets you create a new UCS, rename it, or 
even delete it.  

 

World 
The World option changes the UCS back to the world coordinate system.  

Z-Direction 
The Z-Direction option changes the parameters of the coordinate system in two 
steps: 

1. You determine the origin by entering the new coordinates (in X,Y,Z format) 
or by picking a point . 

2. The direction of the axes of the user coordinate system is determined by 
fixing the z-axis. To do that, choose a point through which the positive Z-
axis should go. The X- and Y-axis remain the same. The XY-plane is  
orthogonal to the Z-axis. 
 
> ucs 
UCS origin <0,0,0>: Z-axis 
UCS origin <0,0,0>: [Enter] 
Point on the positive z-axis: P1 

3Point 
The 3Point option is meant for drawing planes that are neither parallel to the 
viewing plane nor to the axis of active coordinate system. We recommend you 
use the cursor to pick the coordinates: 
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1. You determine the origin by entering the new coordinates (in X,Y,Z format) 
or by picking a point . 

2. Pick a point (or type coordinates) through which the positive X-axis should 
run. This determines the axis unambiguously. 

3. The direction of the other axes is determined by fixing a point in the 
positive area of the XY-plane. This point does not necessarily have to lie on 
the Y-axis. 
 

For practical reasons, you should locate the axes of the UCS so they are 
oriented with the plane of the drawing object. For example, choose the corner 
points of this plane with object snap. The selected plane becomes the drawing 
plane. All entities are drawn on this plane. 

> ucs 
UCS Origin <0,0,0>: 3Point 
UCS Origin <0,0,0>: P1 
Point on the positive x-axis: P2 
Point on the positive xy-plane: P3 
 

View 
The View option orients the user coordinate system parallel to the active view. 
The UCS command does not ask you for any coordinates. The X-axis of the 
coordinate system lies parallel to the horizontal axis of the viewing plane; the 
Y-axis is oriented vertically; and the z-axis is orthogonal to it 

> ucs 
UCS origin <0,0,0>: View  

Rotation 
The Rotation option rotates the active coordinate system around one axis. You 
may choose the angle of rotation and the direction of the rotation. 

> ucs 
UCS origin <0,0,0>: Rotate 
Rotate around x-, y-, or z-axis: Z 
Rotation around Z-Axis <0>: 30 

To rotate the coordinate system around two or three axes, repeat these steps for 
each axis: 

1. Determine the axis around which to rotate the coordinate system. Either type 
its character or click its option (X, Y, or Z) from the option bar. 



Chapter 3   Viewing Drawings 

 109 

2. Determine the direction and angle of the rotation. Entering or pointing an 
angle does this. 
 

You specify the angle of the rotation by typing the angle or by picking two 
points in the drawing. The orientation point for the angle of the rotation is 
always the positive x-axis of the active coordinate system. Entering a positive 
value for the angle of rotation results in a rotation to the left, a negative value 
(for example, -30) results in a rotation to the right. 

Controlling the UCS 
Of course, it would not be very effective if you had to make the above 
adjustments every time you needed to change the coordinate system. Therefore, 
FelixCAD allows you to save pre-defined user coordinate systems by name, 
which are saved with the drawing. Once a UCS is saved, you can always reuse 
it; the UCS names can also be renamed or deleted.  

All this is possible via the UCS command’s Control option. Or, from the menu 
bar, select Options > User Coordinate System > UCS Manager. 

Creating a New UCS 
You create a new user coordinate system in these steps: 

1. Create the UCS with an option as described above: Z-Direction, 3Point, 
View, or Rotate. 

2. Open the dialog box and type a name in the UCS Name field. The name can 
be up to 31 characters long, as well as dash ( - ) and underscore ( _ ), but no 
spaces.  

3. Click New. 
4. Click OK. 
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Renaming a UCS 
If you need to rename a  UCS: 

1. Select a UCS name from UCS Name list.  
2. Click the name and type a the new name.  
3. Click Rename. This verifies the renaming; the new name of the UCS 

appears in the field. 
4. Click OK.  
 
Note: the world coordinate system cannot be renamed. 

Deleting a UCS 
Erasing a UCS is similar to renaming a user coordinate system: 

1. Select a UCS name from the UCS Name list.  
2. Click Delete. The UCS is then deleted; its name no longer appears in the 

list. 
3. Click OK. 
 
Note: the world coordinate system cannot be deleted.  

Changing the Active UCS 
You can create as many user coordinate systems as you need in a drawing, but 
only one user coordinate system can be the active coordinate system. To change 
the active UCS:  

1. Select a UCS name from the UCS Name list.  
2. Click Active. The user coordinate system becomes the active coordinate 

system. The field shows the name of the active coordinate system. 
3. Click OK. 

 
Reverting to the Previous Coordinate System 

To change to a previous coordinate system, click the Previous button. It 
enables you to quickly change between two coordinate systems. When you 
click this button, FelixCAD changes to the previous coordinate system without 
verification. 
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Layers and Object Properties 

The concept of working with layers in FelixCAD is analogous to manual 
drafting using layers of transparent Mylar. Parts of the drawing are drawn on 
different sheets of Mylar, such as the base plan, the electrical, the plumbing, the 
roadwork – each on its own Mylar sheet. When all sheets are imposed on top of 
one another, they form the entire drawing.  

Layers are useful in separating objects, such as parts, sub-assemblies, and 
structural components like pipes and building materials. In CAD drawings, 
layers separate drawing elements, such as construction lines, center lines, 
outlines, and dimension lines. The advantages of creating a drawing in this 
manner – whether manually or digitally – lie in a clearer drawing and improved 
control over drawing on a single sheet. 

This chapter describes how to create and use layers, as well as ways of 
controlling layers. Control refers to the visibility of the layers, their color, and 
the type of lines used. Management of layers is accomplished through the Layer 
Manager. 

In the second half of this chapter you find explanations on object properties and 
the advantages of working with them. An object may be a part, a sub-assembly, 
a group of similar entities (such as parking spaces in an architectural drawing), 
or any other entity that you wish to separate from other entities in the drawing. 

LAYER BASICS  
Instead of working with sheets of Mylar, as you might when drafting by hand, 
CAD software works with layers, which have the characteristics similar to 
Mylar. Layers make it possible to structure a drawing through logical or content 
characteristics. 

Drawing layers always lie exactly on top of each other. All aspects of a 
drawing, such as the coordinate system, the zoom factor, the view arrangement, 
and fonts, are valid for all layers. Other aspects may differ for each layer, such 
as the color and linetype of entities drawn on a particular layer. In addition, 
layers can be “turned off,” which means that all entities on that layer become 
invisible. 
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In CAD software, a new object is always drawn on the current layer. When the 
object is drawn, the layer’s properties (specifically, linetype, visibility, and 
color) apply to the object. FelixCAD has commands that let you change the 
properties of all objects on a layer, or of each object independent of the layer’s 
global setting.  

Layers are identified by name. All drawings contain at least one layer, given the 
name “0” (pronounced “layer zero”). All other layers can have their own 
number or name. Layer names help describe the purpose of the layer and can be 
up to 31 characters long. 

You can create up to 4,095 layers in a FelixCAD drawing, a number that should 
be more than enough for any practical drawing. Layers do not necessarily 
follow one another in some sequential order. It is not necessarily true that layer 
2 lies “on top” of layer 1 or “underneath” of layer 3. All layers are arranged in 
one single plane, which is not possible when drawing manually on different 
Mylar. When one entity hides other entities on different layers, the rule is that 
the object last drawn lies over already existing objects and “hides” them.  

As mentioned earlier, every drawing contains one default layer name layer 0. 
This layer has several special properties that distinguish it from all other layers. 
It is generated automatically by FelixCAD when a new drawing is created. The 
color 7 (black) and the linetype Continuous are automatically established for 
this layer, although you may change the color and linetype. This layer cannot 
be erased or renamed. Layer 0 has a special property when defining and 
inserting parts. You can find more on that subject in the “Parts and Attributes” 
chapter. 

One layer in the drawing is always the current layer. All new entities are 
automatically drawn on this layer. Naturally, you change the current layer 
whenever you need to. As long as layer 0 is the only one existing, it is also the 
current layer. If there is more than one layer in a drawing, as there should be, 
you switch between layers using the Layer Manager or the Properties toolbar. 

Although you can only draw entities on a single layer (i.e., the current layer), 
you edit entities residing on any layer at any time – with on exception: you 
cannot edit entities on layers that have been frozen, turned off or locked (more 
later). 
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The layer names, their status, and their properties are part of the drawing. They 
are saved with the drawing and can be shared with other drawings via the 
Drawing Xplorer.   

LAYER PROPERTIES 
Layers have four properties: name, color, linetype, and visibility setting.  

Layer Name 
To identify layers and differentiate between them, each layer has a distinctive 
name. You can assign any name you want up to 31 characters long. The name 
can consist of letters, numbers, and two special characters:  _ (underline) and $ 
(dollar). All characters in the name are automatically capitalized. 

If you are not sure what layer names to use, you can check with the regulating 
body for your discipline. Some organizations have Standing Committees on the 
subject and have layer guidelines. One of these is the International Standards 
Organization (Standards ISO 13567-1 & -2:1998, ISO/DTR 13567-3:1998)   

http://www.iso.ch/isob/switch-engine-
cate.pl?searchtype=general&KEYWORDS=CAD  

Another is the American Institute of Architects for the AEC industry. Their 
WEB site for purchasing the AIA standard is 
http://www.aiabooks.com/detail.asp?productid=R809-
97&search=layer&position=1. In some cases, your client or your office may 
have a layer naming specification. For informal drafting, you can create a few 
layers with self-explanatory names like: 

• Existing for the pre-construction floorplan. 
• Constr for the planned construction. 
• Text for text. 
• Dim for dimensions. 

 

Color 
Every layer has a color; the default color is black. You can choose one of 255 
color shades. Every color has its own number. The standard color of the layer 
can be marked in the color box as BYLAYER.  

http://www.iso.ch/isob/switch-engine-cate.pl?searchtype=general&KEYWORDS=CAD
http://www.iso.ch/isob/switch-engine-cate.pl?searchtype=general&KEYWORDS=CAD
http://www.aiabooks.com/detail.asp?productid=R809-97&search=layer&position=1
http://www.aiabooks.com/detail.asp?productid=R809-97&search=layer&position=1
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Since it is possible to draw on the current layer only, objects still to be drawn 
are in the standard color of the current layer, unless a new color is chosen with 
the Object Color option. If the standard color of the layer is changed using the 
dialog box for layer control then all drawing elements of this layer that are 
marked with the color BYLAYER assumes the new color. 

Linetype 
Similarly, every layer has a linetype; the default is Continuous (solid). The 
chosen linetype is marked in the dialog box BYLAYER. All elements are 
drawn in the linetype of the layer unless another linetype is chosen for the 
element. 

If the linetype of a layer is changed using the dialog box layer control, all of the 
drawing elements of that layer which are marked with BYLAYER assumes the 
new linetype. 

While every drawing contains all 255 colors, a new drawing contains only the 
Continuous linetype. Before you can assign other linetypes to a layer, you must 
load the linetype definitions into the drawing. 

How to Load Linetypes 
Linetypes vary by discipline. The linetypes used for an electrical drawing differ 
from a civil engineering drawing. For this reason, FelixCAD does not store 
with a fixed set of linetypes, but allows you to load linetype files  specific to a 
particular discipline. 

Linetype files have the extension .lin and can be found in the \applic folder. 
FelixCAD ships with two linetype files: Mm.Lin for metric drawings and 
Inch.Lin for imperial drawings. Your office or your client may provide you 
with project-specific linetype files. In addition, you may use most existing 
AutoCAD .lin files or create customized linetypes by following the syntax of 
the .lin files. 
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To load a linetype file: 

1. Select Linetypes from the Options menu, or type the Linetype 
command. FelixCAD opens the Open Linetype File dialog box. 

2. Type the name of the linetype file in the Filename input field or choose 
a .lin file from the file list. 

3. Next, choose one (or more or all) linetypes from the list in the 
Linetype dialog box. The preview area at the top of the dialog box 
assists you to find the appropriate linetype.  

 

4. After you choose and load the linetype(s), you assign them to a layer by 
using the Layer Manager. Or, they may be associated with an existing 
drawing objects with the PropEdit command 



Chapter 4   Layers and Object Properties 

 116 

Layer Visibility 
One of the primary advantages of working with layers is that they aid you in 
visualizing the part, or drawing. The visual clarity of a drawing can be 
improved by turning off the visibility of some layers; this “hides” the entities 
residing on those layers. 

Every layer can be turned on or off independent of all other layers. Changing 
the visibility is done through the Layer Manager (Layer command). 

On / Off Status 
When a layer is turned off, you no longer see the entities drawn on that layer. 
New layers are created with the status on. 

Locked / Unlocked Status 
It is possible to lock layers so that entities on the layer are visible but may not 
be edited. New layers are created with the status unlocked.  

When a layer’s status is locked, it is not possible to change, add, or delete 
entities assigned to this layer. This function makes it difficult to make an 
accidental change to the drawing .The status must be changed to unlocked if 
you want to work with the entities of this layer.  

You can draw new entities on a locked layer. The standard color of the layer 
may be changed. A locked layer may be designated active, visible or invisible, 
frozen or thawed.  

Thaw / Freeze Status 
The Thaw and Freeze status controls visibility in a manner somewhat 
differently from On and Off. 

A frozen layer is both invisible and locked and thus impossible to change. 
Entities on a frozen layer are regenerated. When working with complex 
drawings, freezing unneeded layers helps increase the speed of drawing 
considerably. 

Thaw undoes the freezing of a layer. The layer becomes visible and changes 
may be made once more. 

Note: The current layer cannot be frozen. 
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LAYER MANAGER 
Creating new layers, choosing a current layer, and controlling layer properties 
is accomplished through a dialog box called the Layer Manager. You access 
the dialog box with the Layer command (View > Layer Manager).  

 

The top section of the Layer Manager dialog box contains a field for the name 
of the current (active) layer and a report of the number of layers already defined 
in this drawing. In a new drawing, this reads: 

 Current Layer: Used Layers: 
 0   1 of 4096 

Buttons allow you to create new layers, rename layers, and select the current 
layer. Other buttons change the state of the layer and select linetype and color. 

The Alphabetically Sorted checkbox lists layers in alphabetical order (when 
on) or in the order they were created (when off, no check mark). 
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The lower section of the dialog box lists the names of all the existing layers in 
the drawing. The status, color, and linetype are also shown for each layer. 
Select a layer with your cursor.  

The meanings of the abbreviations used are: 

Abbreviation Status 

On On: entities on the layer are visible. 

Off Off: entities on the layer are invisible. 

Unlk Unlocked: entities can be edited. 

Lock Locked: entities cannot be edited. 

Thw Thawed: entities are visible and can be edited. 

Frz Frozen: entities are invisible, cannot be edited, and 
are not regenerated. 

 
Creating a New Layer 

You can create a new layer at any time. You do not have to draw entities right 
away on a newly created layer. Remember that you can only draw on the 
current layer. 

A new layer is created in two steps: 
1. Type the name for the new layer in text entry box at the top of the dialog 

box. Remember the limits of naming (see earlier in this chapter).  
2. Click the New button. Notice that the layer appears in the list. Every new 

layer has color 7 (black) and the linetype Continuous. You may assign other 
linetypes and colors, as described later in this chapter. 
 

Renaming a Layer 
A layer is given a different name in three steps: 
1. Select the layer from the list of layer names.; 
2. Notice that the name appears now in the text entry box. Type the new name 

over the old name.  
3. Finish renaming by clicking the Rename button. Notice that the renamed 

layer appears in the list. 
Selecting the Current Layer 

You select the current (working or active) layer in two ways: 
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1. Click on the Layer Manager Icon and from the dialog box, select the layer 
you want to become current. Finally, click the Current button.  

2. Click the Layer Drop-Down List. Once it opens, scroll down and click on 
the layer you want to become current.  

 

Alternatively, you can type in SETLAYER (See SETLAYER command, later 
in this chapter).  

Changing the Layer’s Linetype 
A newly created layer has the linetype Continuous automatically assigned to it. 
You change the linetype in three steps: 

1. Select the layer(s). Hold down the Shift key to select a range of layers, or 
hold down the Ctrl key to select a dispersed range of layers.  

2. Click the Linetype button. Notice that the available linetypes are shown in 
the Linetype dialog box. Note: you must first load linetypes into the 
drawing, as described earlier in this chapter.  

3. Select the linetype to be used and click OK. Notice that the selected layer(s) 
have the new linetype assigned to them. 

 
This makes the selected linetype the standard linetype of this layer. All entities 
on this layer take on that linetype. 

Elements of the layer drawn with a linetype different than the BYLAYER 
linetype are not affected by the change. Further instruction on drawing 
elements with a linetype different than the standard linetype can be found in the 
Object Properties section in this chapter. 
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Changing the Layer’s Color 
When a new layer is created, it is automatically assigned the color 7 (black). A 
new color can be assigned to the new layer via the Color button. You change 
the color of a layer in three steps: 

1. Select the layer(s). Hold down the Shift key to select a range of layers, or 
hold down the Ctrl key to select a dispersed range of layers.  

2. Click the Color button. The Colors dialog box appears. 
3. Select another color from the colors displayed, or type a color number (in 

the range of 1 to 255). The chosen color appears at the upper left corner. 
Click OK to dismiss the dialog box. Notice that the layers have the new color 
assigned to them.  

 

 
This makes the chosen color the standard color for this layer. All entities on 
this layer now appear in this color. 

Entities drawn with a different color are not affected by the change. 
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Controlling the Layer Status 
The layer properties that determine the status of the layer were discussed earlier 
in this chapter. Changing the status of a layer is as simple as clicking the proper 
button. The status of each layer is displayed next to the layer’s name.  

• The On and Off buttons control the display visibility of the layer. 

• The Unlk and Lock buttons control access to the layer. Unlk allows editing; 
Lock prohibits editing. 

• The Thw and Frz buttons control the ability to see, edit, and regenerate the 
layer. Thw unlocks and makes visible; Frz locks and makes invisible.  

The layer status is changed in two steps: 

1. Select the layer(s). Hold down the Shift key to select a range of layers, or 
hold down the Ctrl key to select a dispersed range of layers.  

2. Click the button appropriate to the change in status. For example, to freeze a 
layer, click the Frz button. 

 
Remember that the current layer cannot be frozen. 
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QUICK ACCESS TO LAYERS  
In addition to the Layer Manager, FelixCAD provides a palette (toolbar) with 
the three most important layer functions: 
• Change the current layer. 
• Draw with a linetype other than BYLAYER.  
• Draw with a color other than BYLAYER. 

To access these functions, select the buttons found on the palette on the left-
hand of the desktop. 

 

SETLAYER Command: Set Current Layer  
This function allows you to set a new current layer either from the palette 
(toolbar) or typing SETVAR and pressing the <Return> key.  

Note: It is not possible to create a new layer or to change any characteristics of 
the existing layer with this button. These changes must be made in the fashion 
described above in the Layer Control section.  

Selecting this button opens the Layer dialog box, where you can select another 
current layer.   
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The letters in front of the layer names show the status of the characteristics 
visibility, access, and thawing/freezing. They have the following meaning: 

Abbreviation Meaning 

On  On: visible. 

Off  Off: invisible. 

Unl  Unlocked: full access. 

Loc  Locked: no editing access. 

Tha  Thawed: not frozen. 
 

A frozen layer cannot become the current layer, so that choice does not appear 
for the current layer. Select a layer name in the list box and click OK. 
 

Set Current Linetype 
You may want to override the linetype assigned to the layer (known as the 
BYLAYER linetype). 

(To change the linetype of an entity after it has been drawn, use the PropEdit 
command, described later on in this chapter.) 

To change the current linetype, click the Linetype button in the control panel. 
The Layer Manager dialog box appears, which is the same dialog box as 
described earlier. Choose a linetype from the list and click OK. 

Set Current Color 
You may want to override the color assigned to the layer (known as the 
BYLAYER color). 

(To change the color of an entity after it has been drawn, use the PropEdit 
command, described later on in this chapter.) 

To change the current color, click the Color button in the control panel. The 
Layer Manager dialog box appears, which is the same dialog box as described 
earlier. Choose a color from the list and click OK. 
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Set Layer by Reference 
The LayRef command (Options > Set Layer) provides an alternative form of 
layer control which you may find more appropriate and direct. You can set, turn 
off, freeze, lock, or unlock a layer by picking a reference entity.  

Choose one of the options from the options bar:  

Off Lock Freeze Unlock On… Thaw… 

 
The Set option is the default option for LayRef; it is used if you select no other 
option. When you choose Set, the routine prompts: 

Select reference entity to set layer:  

The layer on which the picked entity is located is now the current one. 

The command also provides options to turn disabled layers on or to thaw frozen 
layers in a dialog box. All layers with the corresponding mode are highlighted 
in a list box. When you choose the OK button all marked layers in the list box 
is turned on or frozen. 
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MODIFYING OBJECT PROPERTIES 

   The PropEdit command (Edit > Modify Object Properties) changes 
the properties of objects. The characteristics of objects are said to be the 
“properties.” Objects may have a different: 

• Layer: default = 0. 
• Color: default = 7, black. 
• Linetype: default = Continuous. 
• Thickness: extrusion in the Z-direction; default = 0.0 units. 
 
All of these characteristics are automatically associated with an entity when it 
is created. You may want to, in some cases, to change (or override) these 
parameters. You do this with the command.  

The PropEdit command allows you to make these changes:   

• Objects may be placed on a different layer. 
• Objects may be given a different color. 
• Objects may be given a different linetype. 
• The thickness of objects may be modified. 
 
You may change any or all of these properties at a time. The changes apply to 
one, several, or all objects in the drawing. 

Select the entities whose properties you want to change. Remember that all 
selected objects are changed. If three objects are selected, all three receive the 
same changes.  
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Press Enter to end object selection. FelixCAD displays the Edit Properties of 
Entities dialog box. Choose the object properties that are to be changed by 
clicking the proper button. 

 

The color, layer, and linetype properties each have a separate dialog box. These 
dialog boxes are identical to those opened for layer linetype and color control. 
Choose the new characteristic in each case. Thickness is applied directly and 
does not require a dialog box. 
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MODIFY OBJECT LAYER   

 The PropLayer command (Edit > Modify Object Layer) transfers 
selected objects from their current layer to another layer. 

Select the entities to be transferred. The following dialog box appears. Choose 
a target layer and confirm the selection by OK. 

 

 
COPY OBJECT PROPERTIES 

 The CopyProp command (Edit > Copy Object Properties) allows you 
to change the properties of entities to match those of another entity. This makes 
it easy to make a group of entities take on the same look as a red dotted entity. 
Only properties that are common to all objects (layer, linetype, and color) are 
transferred to the selected objects.  

To change the properties of the selected objects takes two steps: 

1. Select a reference entity 
2. Select one or more objects to be changed. 
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THICKNESS 
By applying the thickness property to entities, you create a three-dimensional 
effect called “2½D.” The extrusion of entities creates the illusion of depth. 
Thickness is measured in the Z-direction. You can give thickness to the 
following entities:  

• Arc. 
• Circle. 
• Line. 
• 2D polyline. 
• 2D face. 
 
If any of these entities are drawn with a non-continuous linetype pattern (such 
as dash-dot) or if they are a wide polylines, then the pattern and width is 
extruded.  

Thickness can be assigned to other drawing objects, such as 3D polylines,  3D 
faces, text, attributes, attribute definitions, block insertions, dimensions, and 
hatches, but FelixCAD does not display the extrusion. To set a preference for 
subsequent drawing, set the Thickness system variable. Type the system 
variable name and enter a numeric value. To turn off thickness for further 
drawing, set the value to zero. To alter the thickness of drawing object, use the 
PropEdit command (see earlier in this chapter). 

Applying Object Selection and Object Snap to Extruded Entities 
When selecting or snapping to entities with an extrusion thickness, keep these 
two rules in mind: 

• Object Selection: When requested to select objects, FelixCAD recognizes 
extrusion lines. 

• Object Snap: When you snap to extrusion line of entities with thickness, 
FelixCAD finds the appropriate point of the entity’s base. 

 
Treatment of Extruded Objects in Rendering and Hidden Line Removal 
Objects with thickness are recognized by the rendering and hidden-line removal 
commands: ARender, Render, Hide, and FHide.
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Draw: Drawing Basic Entities and Objects 

In this chapter, you learn about the commands that draw basic geometric 
entities. FelixCAD draw lets you drawing with simple entities, like lines and 
circles, as well as advanced 3D entities, such as surfaces of revolution and 
three-dimensional polylines. The entities you draw may be changed later using 
the editing commands (see Chapter 6).  

All of the following commands are available from the 
Draw menu: 

  

Drawing commands prompt you for input, such as the 
starting point of a line, the length of the line, the center 
point of a circle, or the points to define an arc. You 
enter the points and distances by pointing with the 

cursor or by typing discreet coordinates or values on the keyboard.  

Options for each command are shown in the option bar. The default is the first 
option, which is selected by the left mouse button.  

Using Object Snaps 
When defining points by pointing with the cursor, you should use object snap 
options in ensure precise drawings. For more information about object snap, 
refer to Chapter 2 “Drawing With Precision.” 
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Loading Linetypes 
The Linetype command allows you to choose linetype definitions for later use. 
The linetype chosen with this option does not become the active linetype. It is 
only added to the list of linetypes that are available.  

To add a linetype to the linetype table of the current drawing, proceed in this 
manner:  

1. From the Options menu, select Line Types (or type the Linetype 
command). Notice the Open Linetype File dialog box. 

2. Select a file with the extension of .lin. Usually linetype files are found in 
the \applic folder. FelixCAD ships with two linetype files: Mm.Lin 
contains metric linetypes, while Inch.Lin contains imperial linetypes. 

3. Click Open. Notice the Linetype dialog box. 
4. Select one or more linetypes that you want to load into the drawing. 
5. Click OK. FelixCAD adds the linetype definitions to the drawing. These 

are saved with the drawing and are available the next time you open the 
drawing. 

 
To set a linetype, use the Layer command and assign linetypes to layers. Or, 
use the SetLinetype command to preset the linetype for all entities drawn after 
this point. 

Applying Text Styles 
The Fonts option from the Detail menu allows you to load text styles from font 
files. A text style lets you adapt a font file for special drawing needs, such as 
presetting its size. You find a more detailed explanation in the “Text Objects.” 
chapter 

Specifying the Dimension Type 
The Dimension Type option allows you to choose the type of dimensioning to 
be used. More detailed explanations of this function are found in the 
“Dimensioning.” chapter 
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DRAWING MODES  

 Draw > Drawing Modes (DrawMode command) lets you specify the 
proper visibility and display control of drawing entities. The command displays 
the Visibility and Display Modes for Drawing Entities dialog box: 

 

When you change a setting in this dialog box, the setting applies to all objects 
drawn from then on. The changes do not affect all drawn objects until the 
active view has been regenerated, using the Regenerate command found in  the 
Window menu.  

Linetype: Scale Factor 
The Linetype Scale Factor (LtScale command) determines the scale factor for 
lines drawn with a linetype. The default is 1.0. A larger number results in 
extended line patterns (dash lines are longer); a smaller number contracts the 
line patter (dash lines are shorter). To change the scale factor, enter a new 
number in the text edit box.  

Note: If the linetype scale factor is set to a very low number, dashed or center-
ines may appear to be continuous type. In such cases, re-set the ltscale to a lar-
er value and perform a regen afterwards to see the gaps in these types of lines.  

After a regeneration of the drawing, the scale of line patterns already drawn is 
adjusted to the new value.   
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Fill Solid Entities  
The Fill Solid Entities option specifies whether or not polygons are filled 
(polygons are polylines with a width greater than zero, or are 2D faces). A 
check mark in the box indicates the fill function is on. The default is on. 

This option must be turned on to draw filled planes. If the Fill Solid Entities 
option is off, then the Fill Polygons option is not available in the Print/ Plot 
dialog box (more details in Chapter 13 “Printing and Plotting”). The figure 
below shows the effect of filling and not filling a polygon. 
 

 

Option Fill Solid Entities activated (left) and deactivated (right) 

Attribute Display Modes 
This option allows you to choose how attribute text should be displayed. The 
options are:  

Display as defined Attributes are displayed according to their 
definition (the default). 

All invisible All attributes are made invisible, e.g. their 
status is defined as invisible. 

Display all All attributes are displayed, regardless of how 
they were defined. 

Choose a display option by clicking its radio button. 

3D Face Edges 
In 3D views, if you want to hide intersections or lines that are behind other 
objects, select the Displayed as defined option (the default).  

If all intersections are to be displayed, then select the Display all option.  
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Arc Segments 
All CAD programs display arcs and circles on the screen as a series of very 
short straight-line segments.  

This option specifies the number of segments that FelixCAD uses to draw all 
arcs and circles. You can type any value between 8 and 1024. A smaller value 
makes the arcs or circles appear jagged, but regenerates the drawing more 
quickly. A larger number tends to smooth them out. The default is 48. 

Note that this number affects the output quality of some printers and plotters. 

 

Display of a circle with 48 (left) and 18 (right) straight line segments 

Point Representation 
This area of the dialog box allows you to choose from 20 types of point 
displays. You don’t see the new point mode until you regenerate the drawing; 
all points take on the new display mode. Note: AutoCAD users will know this 
point display option as the PDMODE command 

Point Size 
Although mathematically points have no size, you can specify the display size 
in two different ways:  

Absolute Size The size of points is determined in the absolute 
scale of 3 drawing units; the default.  

Relative to 
Screen 

The display of points is determined by a 
percentage relative to the size of the visible 
drawing plane. 
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LINE 

 The Line command (Draw > Line) draws lines and line segments. You 
specify the line by two points: the starting point and the ending point of the 
line. The Line command displays four choices on the option bar: 

Continuous Segments Append TT   

 
Continuous Option 

Continuous is the default option when drawing lines; this option is used when 
no other option is chosen. The Continuous option allows you to draw line 
segments in sequence until the Line command is terminated by pressing the 
right mouse button or the Esc key. 

The Line command requests a “From point:” (start point) for the first line 
segment, and continues to request “To point:” until the command is terminated. 
Each subsequent point is connected to the previous point by a line. 
 

 

From Point: P1  
(Points are defined by the coordinate system chosen, with the first coordinate the X 
coordinate, then the Y coordinate The coordinates are separated by a commas:) 
To Point: 2.5,2.5  
(+ 2.5 units in the X direction, and 2.5 units in the Y direction). 
To Point: P2 
To Point: P3 
To Point: P4 

When continuous line mode is chosen, the Undo and Close options are added 
to the option bar. 
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The Undo option can be used repeatedly to erase the previous line segment, 
until the line is completely gone. 

The Close option connects the last drawn point with the start point, to create a 
closed shape. 

To terminate the Line command, press Enter or Esc. 

Segments Option 
The Segments option creates single line segments, as opposed to a multi-
segment (continuous) line. 

As with continuous lines, the Line command prompts for the start and end 
points of the first segment. The program then repeatedly asks for start and end 
points. Note the difference: the lines drawn have start points independent of the 
previous end point; segments are usually not appended to previous line 
segments. To end the drawing of line segments, press Enter or Esc. 

 

From Point: P1 
To Point: P2 
From Point: P3 
To Point: P4 
From Point: <hit Enter key> 
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Append Option 
The Append option allows you to connect a new line to the end of an existing 
line or arc. Users familiar with AutoCAD will find this similar but exactly the 
same as joining a line segment to another with the PEDIT command and 'join' 
option. When prompted, select the line or arc to connect: 

From Point: append 
Select line or arc: [pick] 
To Point: [pick] 

The new line is connected to the end of the line or arc nearest to the pick point. 

When appending the line to an arc, you are prompted the length of the line. The 
appended line is drawn tangent to the end point of the arc. You can either type 
the length, or pick the length with the cursor; for precision, it is better to type 
the length.  

 

Select line or arc: P1 
To point: P2 
To point: <hit Enter key> 

Close and Undo Options 
After you select one of the Line command’s option listed above, FelixCAD 
displays the following options on the option bar: 

Undo Close     

 
The Undo and Close options are available on the option bar when drawing a 
line, chain, 2D polyline, or 3D polyline.  
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Undo 
The Undo option allows you to undo the last step taken. In other words, the 
last-drawn segment is erased. The end point of the last line segment may then 
used as a starting point of another segment if required. Undo can be repeated as 
long as a segment of the line exists. The last segment is erased with each 
successive Undo. 

The end point of the previous segment can then used as a starting point of the 
next segment.  

Close 
This option allows you to draw a closed polygon. Choose the Close option 
from the option bar or type C at the keyboard. FelixCAD draws a line segment 
that connects the end point of the last line to the start point of the first line. 
(The Close option also allows you to create closed 3D polylines. )  

TT Option 
The TT option is short for “Tangent Tangent.”  It allows you to draw a line 
tangent to two arcs or circles. The TT option is useful in creating compound or 
reverse curves with a line segment in between the arcs.  

You are presented with two prompts, as follows; 

Tangent from:  
Tangent to: 

After picking the two arcs or circles, the Line command continues with the  
“To point:” prompt. 
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CIRCLE  

  The Circle command (Draw > Circle) draws circles. There are several 
ways to geometrically describe a circle. FelixCAD allows you to choose from 
among several methods to draw the circle in the most convenient manner. A 
circle can be drawn by any of the following options:  

• Specify the center point of the circle, and the radius or diameter. 
• Specify three points on the circumference of the circle.  
• Specify two points on the circumference (and, hence, the diameter) of the 

circle.  
• Specify two points tangent to other lines, arc, or circles. 

The following options appears on the option bar when calling the command 
CIRCLE: 

Center 3Points 2Points Radius Diameter Tangent 

 
Center Option 

Since the Center option is chosen most often in drafting, it is the default: it is 
activated automatically when no other option is selected. You are first 
prompted for the location of the center point; the second prompt asks for the 
radius:  

> circle 
Center point: [pick] 
Radius <1.00>: [pick] 

The radius prompt displays the radius, such as <1.00> above, you entered 
earlier. To accept the default radius, press Enter; to change the radius, type or 
pick a new value. 

 

To enter a diameter value, select the Diameter option from the option bar. 
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3Points 
The 3Points option draws a circle that passes through three points on its 
circumference. This option is convenient when the circle must intersect three 
tangent lines, or when drawing a circle within a polygon. 

P1

P2

P3

 

The prompt asks for three points: 

> circle 
Center point: 3P 
First point: [pick]  
Second point: [pick]  
Third point: [pick]  

 You may pick the points on the screen (we recommend you use object snaps), 
or enter the coordinates through the keyboard.  
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2Points 
The 2Points option draws a circle whose diameter passes through two points: 

> circle 
Center point: 2p 
First point:  [pick] 
Second point: [pick]  

The points may be picked using the object snap functions, or may be entered 
from the keyboard. 

 

Radius Option 
The Radius option is useful when the radius of the circle is a known, but the 
center point is undefined, or when the radius follows from geometry already 
established. To define the radius: 

• Verify the last radius by pressing Enter. 
• Enter a new value for the radius manually. 
• Pick two points for the radius in the drawing. This is especially useful when 

the radius follows from existing geometry. 

> circle 
Center point: Radius 
Radius <1.00>: 1.24 
Center point: [pick] 
Center point: [pick] 
Center point: [Enter] 

This option repeatedly draws circles based on the center points that you pick. 
Press Enter or Esc to end the Circle command. 
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Diameter Option 
The use and the implementation of the Diameter option follows exactly the  
Radius option, except that you specify the diameter. 

Tangent Option 
The Tangent option is used to draw a circle of given radius or diameter tangent 
to two lines. 

The first prompt asks for the tangent elements. First, select these entities. After 
choosing the second object, enter the radius of the circle to be drawn. The 
radius of the last circle drawn is displayed as the default value by the program. 
Verify this choice with Enter or choose a new value manually or by pointing it 
on the screen. The circle is placed so that it touches, tangentially, the two 
chosen entities.  

 

If the chosen radius is smaller than the distance of the two objects to each 
other, the circle is moved in the direction of the imaginary point of intersection, 
so that the defined radius touches the extension of the elements. 

 

If the specified radius for a tangential construction is not valid, the program 
gives the message: Circle does not exist! 
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ARC 

  The Arc command (Draw > Arc) draws arc objects. There are many 
ways to geometrically describe an arc. FelixCAD provides you with these 
options:  

• 3Point: specify three points, the starting point, a second point, and the end 
point. 

• SEnd: specify two points and the radius, or the angle of the arc, or a tangent 
through the starting point. 

• SCenter: specify two points and the center point. 
• CStart: specify the center point, the starting point, and the angle. 
• CRadius: specify the center point, radius, the starting angle, and the ending 

angle. 
• Append: continue an arc from an existing arc or line. 

 
 

TIP 

Arcs are measured counterclockwise (to the left), starting from the positive X-axis. 
 

To pick points for the construction of arcs, we recommend that you use object 
snaps to ensure accuracy. 

The Arc command displays these options on the option bar: 

3Point SEnd Scenter CStart CRadius  Append 
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3Point Option: 
Start Point, Second Point, End Point 

The most common method for drawing arcs is to select three points on the arc. 
The arc is defined by three points: the starting point, a second point on the arc’s 
circumference, and the end point of the arc. This is the default in FelixCAD; it 
is used if you chose no other option. Remember the direction convention: the 
arc is drawn counterclockwise starting at the positive X-axis. 

 
Start point: P1 
Second point: P2 
End point: P3 

SEnd Option:  
Start Point, End Point, Radius/Angle/Tangent 

The SEnd option creates arcs with the starting and end point defined. After 
that, you can specify a radius, an angle, or a tangent. The defaults of this option 
simply follow the prompts: entering the starting point, end point, and the radius 
of the arc by picking or by entering coordinates at the keyboard. 

 
Starting point: P1 
End point: P2 
Radius: Value 

Instead of the radius, you can enter an angle or a direction (from the starting 
point) by selecting Angle or Direction from the option bar. 
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Angle Option 
The Angle option defines the arc by the included angle. The included angle is 
the angle between the starting point and its end point; the vertex of the angle is 
at the arc’s center point. 

> arc 
Start point: SEnd 
Start point: [pick] 
Endpoint: [pick] 
Radius: Angle 
Included angle: 45 

Enter the value through the keyboard or by picking points on the screen. When 
picking a value, remember that the X-axis is the point of reference, not the last 
point entered. 

Direction Option 
The Direction option defines the arc by a tangent that touches the arc at its 
starting point. Since the starting point of the arc is already defined, you need 
only define a tangent by keyboarding or picking another point on the entity to 
be tangent.   

> arc 
start point: SEnd 
Start point: [pick] 
Endpoint: [pick] 
Radius: Direction 
Direction from start point: [pick] 
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SCenter Option 
Start Point, End Point, Center Point 

The SCenter option draws the arc based the starting point, the end point, and a 
center point.  

 

Select SCenter from the option bar when prompted for the start point, as 
follows: 

> arc 
Start point: SCenter 
Start point: P1 
Center point: P2 
Endpoint: P3 

You may enter the coordinates of the center point manually or pick them with 
the cursor. The arc is defined when the end point is entered.  

It is possible to end the arc by entering an angle manually or picking it instead 
of the end point. The program expects a closed angle and defines it as the angle 
between the starting point, the center point, and the end point of the arc. 
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CStart Option 
Center Point, Start Point, End Point 

The CStart option draws the arc beginning with the center point, followed by 
the start and end point.  

After choosing CStart from the option bar, define the center point. Then enter 
the starting point and the end point of the arc. It is possible to enter a closed 
angle instead of the end point. 

Center point: P1 
Start point: P2 
End point: P3 or angle specification 

CRadius Option 
Center Point, Radius, Angle 

The CRadius option starts an arc by defining its center point. After that, you 
specify the radius, and the starting and ending angle of the arc. A rubberband 
line helps you to determine the angle. 

Center point: P1 
Radius: radius specification 
Starting angle: P2 
Ending angle: P3 

Append Option 
The Append option appends an arc to lines and other arcs. The arc is 
determined by two points: the starting point is the connection with the existing 
line or arc; the end point belongs to the new arc. First choose a line or an arc to 
which the new arc should be appended. Then determine the end point of the arc 
to be drawn. 

 

Choose the line or arc: P1 
End point: P2 
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RECTANGLE 

  The Rectangle command (Draw > Rectangle) allows you to construct 
rectangles of any size and aspect ratio, as well as squares. When the command 
is active, the option bar has a single option: 

Width      

 
Rectangles are drawn by one of two methods. The first is by entering via 
keyboard input (i.e. @X,Y or X,Y for relative or absolute co-ordinates). The 
second is by picking two opposite corners. The resulting rectangle is a single 
object. 

 

First corner of rectangle: P1 
Opposite corner: P2 

The Width option allows you to enter or pick a numeric value for the thickness 
of the lines making up the rectangle. To use the last entered value (as offered 
by the prompt) just press Enter. 

Width <0.00>: 0.2  
First corner of rectangle: P1 
Opposite corner: P2 
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NGON 

  The Ngon command (Draw > N-gon) is used to draw a regular polygon 
of three to 1,024 sides – more than enough for any practical need.   This 
command provides options for three different principles of construction:  

• Side: specify the length of the sides of the polygon. 
• Outside: specify the center point and a radius of an external circle. 
• Inside: specify the center point and a radius of an internal circle. 
 
Select the command for drawing a polygon, and indicate the number of sides. 
You may specify a width, if desired. The resulting polygon is treated as a single 
object. 

Width      

 
Next, choose one of the options from the options bar. 

Side Outside Inside    

 
Side Option 

The Side option is the default option for drawing regular polygons. (It is used if 
no other option is chosen.) The polygon is defined by the length and placement 
of one side. 

To draw a regular polygon, first enter the number of sides: enter a value 
between 3 and 1024. The default is four sides; if you previously drew a 
polygon, that number appears in the prompt. To reuse the same number of side, 
press Enter. 

After specifying the number of sides, determine the starting point and the end 
point of the first side. You may either type the coordinates or pick points with 
the cursor.  
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Remember that the polygon will be drawn counterclockwise, starting from the 
first side. 

 

Number of sides <4>: 6 
First corner point of the side: P1 
Distance or second point of the side: P2 

Outside Option: 
Circumscribing the Polygon 

The Outside option defines a polygon by determining a center point and the 
distance to its corner points. This distance is the radius of a circle that contains 
the polygon, a point on whose circumference all corner points of the polygon 
lie. After entering the number of sides, choose Outside from the option bar. 

Determine the center point of the polygon by entering its coordinates or picking 
it. Next, determine the distance to its corner points. The polygon is drawn 
counterclockwise, starting from the first corner point. 

 

Number of sides <4>: 6 
Center point of the polygon: P1 
Distance to its corners: P2 
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Inside Option: 
Inscribing the Polygon 

The Inside option defines the polygon by a circle whose circumference touches 
each side of the polygon at its midpoint (fits inside the polygon).  

Select Inside from the option bar, then enter the number of sides. Next, 
determine the center point of the polygon by entering its coordinates or picking 
them, then determine the radius of the circle. The polygon is drawn 
counterclockwise, starting from the defined side. 

 

Number of sides <4>: 6 
Center point of the polygon: P1 
Distance to its corner points: P2 
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TRAPEZOID  

  The Trapezoid command (Draw > Trapezoid) draws a quadrilateral 
with two parallel sides (trapezoid) on the current layer.  

You create the trapezoid by specifying an insertion point and angle of 
inclusion, followed by the length of the cone and the diameters of its top and 
bottom edges. The insertion point is the midpoint of the first base. You 
determine the points through pointing or entering the values or coordinates at 
the keyboard.  

The cone can also be drawn using a taper ratio. To do so, press Enter at the 
“Diameter of second side:” prompt. Type a ratio, which must be a real number 
greater than 1. 

P2 P1 

 

> trapezoid 
Insertion point: P1 
Insertion angle <0>: [Enter] 
Diameter of first side: 5 
Length: 6 
Diameter of second side: 2.5 

Taper Ration Option 
1 : 5 

P1 P1 
1 : 5 

 

> trapezoid 
Insertion point: P1 
Insertion angle <0>: [Enter] 
Diameter of first side: 5 
Length: 6 
Diameter of second side: [Enter]  
Ratio 1 :  5 
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ELLIPSE 
The Ellipse command  (Draw > Ellipse) draws a full ellipse. FelixCAD 
provides two methods for drawing ellipse-shaped polygons: 

• Center: specify the center point, then the radii; the default.  

• Endpoint: specify the endpoints of the axes. 

Center Endpoint     

 
Center Option 

The Center option is the default. You first identify centerpoint of the ellipse, 
then specify the primary radius (endpoints of the longer axis), and finally the 
secondary radius (endpoints of the smaller axis). Note that specifying the 
primary radius locks down the orientation of ellipse. 

> ellipse 
Center point:  
Primary radius: @3<45 
Secondary radius: 2 

Endpoint Option 
The Endpoint option is the alternative method of constructing an ellipse. You 
first specify the start and the end point of the major axis, then specify the 
secondary radius (by entering a numerical value or by rubberbanding and 
picking the radius from the midpoint of the major axis). 

> endpoint 
Center point: Endpoint 
First axis endpoint:  [pick end point of major axis]  
Second axis endpoint: [pick end point of minor axis]  
Secondary radius:  

Note: The ellipse will be created as closed polyline of many straight line 
segments. The CAD user therefore cannot later pick center points of the two 
radii. 
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CHAIN 

  The Chain command (Draw > Chain) is a combination of the Line and 
Polyline commands. The differences between drawing a line, a polyline, or a 
chains are:  

• Continuous line draws each segment as a separate entity, which is useful 
when you want to later select each segment separately.  

• Chain draws continuous lines similar to the Line command with the 
Continuous option. The chain, however, is treated as a single object, which 
is selected as a whole for editing purposes. 

• Like a polyline, you can specify a width for the entire chain object. The 
width last entered for a polyline is used as the default for the next chain, and 
vice versa. However, a single width must be specified for the entire chain. 

 
A chain is drawn by specifying the points that are the starting and end point of 
each chain segment. The end point for each segment serves as the starting point 
for the next segment. Terminate the command by pressing Enter or Esc. 

First point: P1 
Next point: P2 
Next point: P3 
Next point: <hit Enter key> 

Width TT     

 

Width Option 
The Width option allows you to specify the width of the entire chain. The 
width must be specified before entering the first point. Picking or entering the 
first point is understood as a verification of the default width value.  

TT Option 
The TT option draws the chain tangent to an arc or circle to the tangent of a 
second arc or circle. For more details, see the Line command’s TT option. 
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POLYLINE 

  The Polyline command (Draw > Polyline) draws 2D entities that consist 
of connected line and/or arc segments.  Each segment can have a different 
width; in addition, the width of each segment can be tapered. Polylines are 
always drawn with solid fill. 

A polyline is defined as a single object and is treated as such for editing 
operations, in contrast with entities drawn with the Line and Arc commands. 

After you select the Polyline command, the option bar has these options: 

Arc Width Halfwidth Append TT  

 
Polyline segments are always drawn by defining their start and end points, and 
their width, regardless if they are arcs or lines. After drawing the first segment, 
you are prompted for the endpoint of the next polyline segment. (The start point 
becomes the end point of the segment last drawn.) To terminate drawing the 
polyline, press the Enter key or the Esc key. 

First point: P1 
Next point: P2 
Next point: P3 
Next point: P4 
Next point: [Enter] 
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Width and Halfwidth Options 
The Width and Halfwidth options assist in defining the width of a polyline.   

Width defines the entire width of a polyline segment, whereas Halfwidth 
defines the width from the centerline to one side of the polyline segment. 
Accept the default (last entered) value by pressing Enter or enter a new width 
manually or by picking it. 

The following rules affect both width options: 

• Uniform Width: When you choose the Width or Halfwidth option before 
picking the start point of the first polyline segment, then the width is in 
effect for the entire length of the polyline. 

 

 
Width for the entire polyline <0.500>: [Enter] 
First point: P1 
Next point: P2 
Next point: P3 
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• Tapered Width: When you choose the Width or Halfwidth option after 
picking the start point for the first polyline segment, you may enter different 
values for the width at the starting point and end point.  

 

 
First point: P1 
Next point: Width 
Starting width <0.500>: [Enter] 
Ending width <0.250>: 0.750 
Next point: P3 
Next point: P4 

 

First point: P1 
Command: Halfwidth 
Starting width (half) <0.50>: <hit Enter key> 
Ending width (half) <0.25>: 0.75 
Next point: P3 
Next point: P4 

• Changing Widths: The most-recent width is used for all following polyline 
segments – until you change the width by selecting the Width or Halfwidth 
again. 
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Arc Option 
The Arc option lets you include one or more arcs in the polyline; you may give 
the arc(s) a width. The methods for drawing a polyarc are identical to drawing 
arc with the Arc command.  

To draw polyline arcs with a line width, follow these steps: 

1. Pick the first point of the arc. This can be the end point of the previous 
polyline segment. 

2. Select the Width or Halfwidth, option, then specify the starting width and 
ending width. 

3. Determine the other parameters for drawing arcs using the same procedure 
as drawing regular arcs. 
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Append Option 
The Append option starts the polyline at the end of another line, polyline, or 
arc. Choose the element (line or arc) to which the polyline still to be drawn is to 
be appended. Select the Width or Halfwidth options, if required, and 
determine the starting and the ending width. 

Polyline to Line Option 
To choose an object, select an existing line or polyline. Remember that the 
polyline is connected to the end point of the line closest to the point selected. 

Polyline to Arc Option 
To append a polyline to an existing arc, enter the polyline length after selecting 
the existing arc. A polyline with the specified length is drawn tangent to the 
end of the arc. 

 

Select line or arc: P1 
Length of line: P2 

To end the Polyline command, press Enter. 

TT Option 
The TT option allows you to draw from a tangent of one arc or circle to a 
second tangent of an arc or circle. See the Line command’s TT option for more 
information. 
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PCONTOUR 
The Pcontour  command (Draw > Polyline Contour) creates a boundary 
polyline from existing objects that form an enclosed area. (You may recognize 
this command by the name Boundary or BPoly.) The original entities can be 
made from a combination of lines, arcs, circles, polylines, chains, and ellipses. 
They can be in any arrangement, as long as the boundary can create an enclosed 
area without looping back upon itself. The result is a closed polyline, created 
on the current layer. 

This command can be used in conjunction with the Area command to make the 
job of area calculations easier. 

When you start the Pcontour command, the following prompts are displayed: 

Select boundary edges: [any valid selection method is allowed] 
Select boundary edges: [Enter] 
Ray cast to find start entity <+X>: [described below] 

Next +X -X +Y -Y  

 

Select point inside boundary contour: Pick inside the enclosed area 

When you pick a location that does not work or one of the boundary entities is 
not a valid entity, then you see the following error message: 

Point located outside of a boundary contour or given geometry 
too complex! 
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Next Option 
The Next option runs a line from the point you specify to the nearest object and 
then traces the boundary in a counter-clockwise direction. 

Usually the Next option produces a desirable result. It may not, however, be 
satisfactory when the space between two possible boundaries is very narrow. 
By selecting one of the other options, listed below, FelixCAD looks for the 
boundary in a specific direction from the point you select. 

+X Option 
The +X option projects an imaginary line in the positive X-direction. The line 
run from the point you specify to the first object encountered. After that, 
FelixCAD traces the boundary in the counterclockwise direction. 

-X Option 
The -X option projects an imaginary line in the negative X-direction. The line 
run from the point you specify to the first object encountered. After that, 
FelixCAD traces the boundary in the counterclockwise direction. 

+Y Option 
The +Y option projects an imaginary line in the positive Y-direction. The line 
run from the point you specify to the first object encountered. After that, 
FelixCAD traces the boundary in the counterclockwise direction. 

-Y Option 
The -Y option projects an imaginary line in the negative Y-direction. The line 
run from the point you specify to the first object encountered. After that, 
FelixCAD traces the boundary in the counterclockwise direction. 
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FILLED FACES 

  The 2DFace command (Draw > Filled Faces) draws a solid-filled plane 
with straight-line borders. The planes can have three or four sides. The 
command may be done continuously or using segments. It is also possible to 
connect 2D planes to existing 2D faces. 

Two-D faces are always drawn by determining the corner points (there are 
either three or four corners). The Close option is for drawing triangular planes: 
the third entered point is connected with the starting point of the plane.  

The 2DFace command is sensitive to the order in which corners are picked. 
You should always specify the end points of the edges in the same direction. If 
the end points of the edges of a plane are determined clockwise or 
counterclockwise, a butterfly effect results. The figure below shows the 
consequences of picking corners in two different ways. 

 

Enter the command 2DFace for drawing filled faces and select an option from 
the option menu: 

Continuous Segments Append    
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Continuous Option 
The Continuous option is the default for drawing filled planes; it is used 
automatically when no other option is chosen. 

When drawing rectangular planes, determine the end points of the edges. 
Remember that the first and third points are connected on a single edge, as are 
the second and fourth points. The four edges will make up the plane. 

After determining the end points of the first two edges, you may enter 
additional points. These are used as the third and fourth edge. The command 
repeats itself, allowing you to add more planes connected to the preceding 
plane. To terminate the command, press Enter. 

 

> 2DFACE 
First point: P1 
Second point: P2 
Third point: P3 
Fourth point: P4 
Third point: P5 
Fourth point: P6 
Third point: [Enter] 

To draw a triangular plane, specify three end points for two of the edges, then 
choose the Close option. 

> 2DFACE 
First point: P1 
Second point: P2 
Third point: P3 
Fourth point: Close 
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Segments Option 
The Segments option draws a single rectangular or triangular filled plane. This 
option ends after the entry of the points required for one plane, in contrast to 
the Continuous option. For triangular planes, there is no difference from the 
Continuous option . 

 

> 2DFACE 
First point: P1 
Second point: P2 
Third point: P3 
Fourth point: P4 

Append Option 
The Append option allows you to append a 2D plane to existing planes. You 
can only append a plane to the edge of the last drawn plane. After choosing the 
option, select an edge of an existing plane, then determine the corner points of 
appending plane. 

 

> 2DFACE 
Choose a side: Identify edge 
Third point: P5 
Fourth point: P6 
... 
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RINGS (DONUT) 

  The Ring (or Donut) command (Draw > Rings) draw solid rings (solid-
filled or thick-walled circles). The ring is a special case of a closed polyline; it 
is essentially two polyarcs with width. The filled circle is a special case of a 
ring: it is a ring with the interior diameter equal to zero. 

Rings can be edited with any of the polyline editing commands. They behave 
just like a polyline object. 

The last entered diameter values are used as an option for the next entry. If you 
want to keep using the same values, just pick a new center point. The Ring 
command repeats itself, always creating identical rings, until you press Enter. 

> RING 
Center point: P1 
Center point: P2 
Center point: [Enter] 

Diameter Option 
The Diameter option determines new values for the inside and outside 
diameters. 

Diameter        

 

> ring 
Center point: Diameter 
Inside diameter <0.50>: 0.75 
Outside diameter <1.00>: 1.25 
Center point: P1 
Center point: [Enter] 
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POINTS 

  The Point command (Draw > Construction Points) draws a point. The 
points can be displayed in a variety of styles and sizes. With the Point 
command, you can: 

• Point: insert individual points. 
• Measure: insert points at a specified distance from each other along a line, 

arc, polyline, etc.  
• Segments: insert a number of points along a line. 
 

Point Measure Segments    

 
The shape and size of the points is determined by the DrawMode command’s 
Drawing Parameters dialog box (see the beginning of this chapter for more 
details).  

The points are always be inserted on the current layer. 

Point 
The Point option is the default option. You determine the position of the point 
by typing coordinates at the keyboard or by picking points on the screen. The 
command automatically repeats itself until you press the Esc or Enter key. 

> point 
Point: [pick] 
Point: 1,2 
Point: [Enter] 
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Measure 

  The Measure option allows you to insert points along lines, polylines, 
circles, and arcs at a defined spacing. This dissects the entity into sections of 
constant size (the drawing object is not cut into pieces but remains a complete 
object.) Remember that all entities are not an exact multiple of the length of the 
segment, so there may be a remainder. After starting the Point command, select 
the Measure option from the option bar: 

> point 
Point: Measure 
Select line, arc, circle, or polyline: [pick] 
Length of segments: 0.1 

Choose an entity and specify the spacing between segments (in drawing units), 
either by typing a numerical value or by picking points on the screen. The 
measurement of the distance between points begins from the start point of the 
segment, and progresses to the end point. When inserting points on a circle, the 
starting point lies at the intersection of the radius with the positive X-axis. 

Segments Option  

  The Segments option allows you to separate lines, polylines, circles, and 
arcs into segments of equal length by inserting points of construction. The size 
of the segment is determined by the length of the distance to be dissected and 
the number of construction points to be inserted. 

In contrast to the Measure option, there is no remainder when using the 
Segments option (the object being segmented is not cut into different pieces 
but remains one complete object).  

Select the Segments option from the options bar, then select an object. Specify 
the number of segments; the number of segments should be a whole integer bet-
ween 2 and 4,096. 

The insertion of segmentation points on a line, polyline, or an arc is done 
starting from the beginning of the segment and progressing to its end point, 
without inserting a point at the beginning or at the end. When inserting points 
into a circle, the starting point lies at the intersection of a radius, which begins 
at the center of the circle and continues along the positive X-axis. 
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COMMAND MEASURE AND COMMAND DIVIDE 

Introduction 
The command measure and the command divide orders points or a block 
multiple along a 2D-Object. This object can be an arc, a line, a circle or a 2D-
Polyline. If a block is selected, it can be inserted aligned or non-aligned to the 
object. Both commands work very similar. While the command MEASURE 
asks for a distance, DIVIDE requests for the number of points and calculates 
the distances itself. 

Command sequence for MEASURE and DIVIDE 
Measure 
After commencing the Measure command (or selecting it from the menu 
DRAW), the following prompt appears: 

> measure 
Select a line/circle/2d-polyline or an arc to measure: 

After selecting the entity it is highlighted and the following question appears: 

Block or Distance: 

Here you can input either a distance directly (by putting in a real value or 
selecting two points) or you can type "Block" (or "B". "Bl" etc), to use a block. 
If inputting a distance, the points at each distance from the beginning to the end 
of the object are inserted and the command is now completed. If you type in 
"Block", you are then asked for the block name: 

Name of Block to insert: 

Now type in the name of an existing block. You will be asked for the offset 
angle for the alignment of the block along the object.  

Offset angle for alignment the block along the object (or 
ENTER for none alignment): 

Here you can press return to avoid the alignment or put in any offset angle 
which is added to the tangential angle of the object at the point of insertion. 
Finally, you are asked for the distance again. 

Distance for dividing the Object: 
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Here, you have to input a distance either by giving a real value or by selecting 
two points. Now the Block at each position is inserted and the command is 
complete. 

Divide 
The sequence for the Divide command is the same. The only difference is that 
you are asked for a number of points or blocks to insert instead of a distance. In 
this case, the command will compute the length between the insertion points 
itself. 

Example 
The following pictures show a sample polyline and how the commands 
MEASURE and DIVIDE work with it: 

  
The initial state: The entity to 
measure is a polyline. Moreover the 
block  SOLARR is defined. 

After measuring the polyline using the 
distance, points at each distance along 
the polyline are sampled, started at the 
start point of the polyline 

  
After dividing the polyline in ten 
pieces the block SOLARR is inserted 
ten times along the polyline, but it is 
not aligned. 

In this case the polyline is divided into 
12 pieces with the option block and 
aligned with an angle of 0 degrees, this 
means the block is inserted tangential at 
the object at each point. 
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Technical Notes for Divide Command 
The command Divide inserts number +1 entities along the object unless a circle 
is selected. So it might be necessary to delete the first or last inserted entity, if a 
closed polyline is selected. However, this is much easier then creating an 
additional entity manually. 

The command is not an internal command and so it available for usage inside 
the (command ...) – function. To use it inside of a LISP-application, use the 
related LISP-Function (MesDiv EntName Dist|Nr BlName OffsAngle) 
instead, which is defined in MesDiv.LSP in the FCAD-Applic directory. 

3D POLYLINE  
The Poly3D command (Draw > 3D > 3D Polyline) draws an entity made of 
connected straight line segments. You can specify X, Y, Z coordinates for each 
vertex.     

Unlike 2D polylines, you cannot include arc segments in a 3D polyline, nor can 
you give the 3D polyline a width. The entire 3D polyline has a width of zero. 

As opposed to a line created with the Line command, a 3D polylines is treated 
as a single object. Terminate the command by pressing the Enter key. 

> POLY3D 
First point: P1 
Next point: P2 
Next point: P3  
Next point: [Enter] 

Undo and Close Options 
During the command, the option bar displays the following options:  

Undo Close      

Undo 
The Undo option allows you to undo the last step taken. In other words, the 
last-drawn segment is erased. The end point of the last polyline segment may 
then used as a starting point of another segment if required. Undo can be 
repeated as long as a segment of the polyline exists. The last segment is erased 
with each successive Undo. 

The end point of the previous segment can then used as a starting point of the 
next segment.  
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Close 
This option allows you to draw a closed polyline. Choose the Close option 
from the option bar or type C at the keyboard. FelixCAD draws a polyline 
segment that connects the end point of the last line to the start point of the first 
line.   

3D FACES * 

  The 3DFace command (Draw > 3D > 3D Faces) creates a three- or four-
sided surface in 3D space; you may specify XYZ coordinates for its vertices. 
The difference between 2D and 3D surfaces is that the 3D surfaces are not 
shown as solid areas but as a wireframe. 

The points defining the 3D face are in either a clockwise or counterclockwise 
direction, so that one edge of a 3D surface is used as the base for the next 3D 
face. You may specify invisible edges, which is useful for improving the clarity 
of complex 3D models.  

These options to draw 3D faces may be selected from the options bar: 

Continuous Segments Append Invisible   

 
Continuous Option 

The Continuous option is the default when drawing 3D surfaces. To draw a 3D 
face, define the corner points in a clockwise or counter-clockwise direction. 

Triangular 3D Faces 
For a triangular 3D face, define three corners, then select the Close option. The 
last defined point is then joined to the first point, forming a triangle.  

> 3DFACE  
First point: P1 
Next point: P2 
Next point: P3 
Next point: Close 

Rectangular 3D Faces 
For a rectangular 3D face, define four points. After having completing the 
fourth vertex, FelixCAD creates the four-sided object.  
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The command then continues. You are prompted for further points: the next 3D 
face uses the last drawn edge as the base for the next 3D face.  

 

End the 3DFace command by pressing the Enter key. 

> 3DFACE 
First point: P1 
Second point: P2 
Third point: P3 
Fourth point: P4 
Third point: P5 
Fourth point: P6 
Fourth point: P8 
Third point: [Enter] 
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Segments Option 
To draw a single 3D-face use the Segment option. The method is nearly 
identical to that just described: 

> 3DFACE 
First point: Segments 
First point: P1 
Second point: P2 
Third point: P3 
Fourth point: P4 

In contrast to the Continuous option, the command ends with the fourth point. 
The Segment option permits the Close option, allowing you to create a single 
triangular 3D face. To add more 3D surfaces to an existing one, use the 
Append option. 

Append Option 
The Append option allows you to connect new 3D faces to existing 3D faces. 
First, select the edge that should act as the base for the connection, then define 
the vertices for the new 3D surface. The option automatically changes to 
Continuous mode. This means that after having connected one 3D face, you 
can specify additional points to create more surfaces. 

 

> 3DFACE 
First point: Append 
Select line or edge of 3DFace: [pick] 
Third point: P1 
Fourth point: P2 
Third point: [Enter] 
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Invisible Option 
The Invisible option draws the 3D face. with invisible edges. This feature is 
useful when dealing with complex drawings containing a large number of 3D 
faces. The invisible lines makes the drawing more understandable.  

This function is available for all modes used in 3D face drawing. The function 
must be activated prior to the definition of the starting coordinate of the 
invisible line. 

> 3DFACE 
First point: P1 
Second point: Invisible 
Second point: P2 
Third point: P3 
Fourth point: P4 

and results in the following: 
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POLYGON MESH * 
The PFace command (Draw > 3D > Polygon Mesh) creates three-dimensional 
polygon meshes of arbitrary topology and surface properties.  

To create a polyface mesh, first specify the control points (vertices). Then 
specify which vertex is on which face of the polyface mesh.  

> PFACE 
Control point 1: [Specify a point] 
Control point 2: [Specify a point] 
Control point 3: [Specify a point] 
Control point 4: [Enter] 
Face 1, Control point 1: 1 
Face 1, Control point 2: 2 
Face 1, Control point 3: 3 
Face 1, Control point 4: [Enter] 
Face 2, Control point 1: 1 
Face 2, Control point 2: 3 
Face 2, Control point 3: 4 
Face 2, Control point 4: [Enter] 
Face 3, Control point 1: 2 
Face 3, Control point 2: 3 
Face 3, Control point 3: 4 
Face 3, Control point 4: [Enter] 
Face 6, Control point 1: [Enter]  

Pressing Enter twice in a row exits the command. 

Polyface properties 
You edit a polyface mesh as a single entity by applying editing commands, 
such as Delete, Move, Copy, Rotate, Scale, Stretch, PropEdit, and ChProp. 
You cannot use the PolyEdit command to edit polyface meshes, nor can you 
use the Explode command on polyface meshes. 

Note that users rarely employ the PFace command. Instead, the command is 
meant for generating meshes by FLISP routines, based on 3D point lists (such 
as surveyor’s measurement points).  

Do not confuse polyface meshes created by PFace with polygon meshes 
created by the 3DMesh command. 
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3D MESH * 
The 3DMesh command (Draw > 3D > 3D Mesh) draws polygon meshes. 
Usually, it is used for generating irregular surfaces, vertex by vertex. For 
example, it is used in surveying and GIS applications to create topological 
surfaces.  

A 3D mesh is a wireframe rectilinear blanket composed of M column lines by N 
row lines passing through a matrix of M x N three-dimensional points in space. 
M and N are indices specifying the number of rows and columns that make up 
the mesh, and determine the number of vertices required in the mesh. 

To create a polygon mesh: 

1. Specify the mesh M and N size.  
2. The command prompts for vertex coordinates until you have defined all 

vertices in the M direction, then in the N direction. You are prompted for 
each vertex in order, starting with vertex (0,0), continuing with the second 
vertex in the first column (0,1), and so on.  

3. Once all vertices of a column are specified, the first vertex of the next 
column is requested. For example, vertex (1,0) is the first vertex in the 
second column. In the figure below, the last vertex is (3,2). 
> 3DMESH 
M-value of the mesh (between 2 and 256): 4 
N-value of the mesh (between 2 and 256): 3 
Vertex (0,0): 110,170,4 
Vertex (0,1): 130,190,4 
Vertex (0,2): 160,190,6 
Vertex (1,0): 150,130,0 
Vertex (1,1): 170,140,0 
Vertex (1,2): 190,170,2 
Vertex (2,0): 200,120,0 
Vertex (2,1): 220,140,-2 
Vertex (2,2): 240,170,0 
Vertex (3,0): 260,110,0 
Vertex (3,1): 270,130,0 
Vertex (3,2): 290,150,0 
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Meshes can be open or closed, depending on whether the mesh joins in either 
the M or N direction, or both. A donut-shaped mesh is an example of a mesh 
closed in both directions. 

The 3DMesh command is rarely used as an explicit command in drawing 
practice. However, the command provides an easy way to generate meshes by 
FLISP routines based on 3D point lists (like surveyor’s measurement points). 
The command is primarily designed for usage within applications (either based 
on FLISP or on other programming languages) to construct general polygon 
meshes. 

Do not confuse polygon meshes created by 3DMesh with polygon faces created 
by the PFace command. 
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SURFACE OF REVOLUTION * 
The RevSurf command (Draw > 3D > Surface of Revolution) creates a 3D 
surface by revolving a path curve (the profile) around an axis of revolution. The 
curve sweeps around the axis to define the surface in the N direction of the 
mesh. The M direction of the mesh is determined by the axis of revolution. 

The density of the mesh is based on the value of the SurfTab1 and SurfTab2 
system variables. 

To generate a surface of revolution: 

1. Pick an entity, such as a line, arc, circle, or polyline. This entity determines 
the profile. 

2. Pick an entity to be the axis, such as a line or open polyline. The profile 
revolves around the axis. 

3. Specify the start angle, and the included angle through which to revolve the 
profile. The default is a full circle. 

 
> REVSURF 
Select path curve to revolve: [pick] 
Select axis of revolution: [pick] 
Start angle <0>: [Enter] 
Included angle to revolve entity (+=ccw, -=cw) <360>: [Enter] 

Note: To close the mesh in the N direction, select a circle or closed polyline as 
the curve. 

  
Revsurf Path Curve & Axis (P1 & P2) and Completed Revsurf Surface 

 

RULED SURFACE * 
The RuleSurf command (Draw > 3D > Ruled Surface) creates a ruled surface 
between two boundary curves (two profiles). Valid entities that define the 
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edges of the surface can be points, lines, arcs, circles, 2D polylines, and 3D 
polylines. You can use a mixture of these entities, such as a point and a line. 

The SurfTab1 system variable determines the number of equal intervals 
between the resulting vertices on the defining profile entities. The number of 
intervals is the same for each curve. 

The resulting surface is a polygon mesh. 

To create a tabulated surface: 

1. Pick an entity that defines the first profile. 

2. Select another entity for the other boundary outline. 

 
> RULESURF 
Select first defining curve of ruled surface: [pick] 
Select second defining curve of ruled surface: [pick] 
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Tips 
If the first entity is an open entity (such as an arc or line), the second entity 
must also be an open entity. If the first entity is a closed entity (such as a circle 
or a closed polyline), the second entity must also be a closed entity. 

If one entity defining an edge is a point, the other entity cannot be a point 
entity. 

To create a mesh, select each entity at the same end. If you select each outline 
entity at opposite ends, FelixCAD generates a self-intersecting polygon mesh. 

   
Correct Method for Rulesurf command and result 

   
Incorrect Method for Rulesurf command and result 
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TABULATED SURFACE * 
The TabSurf command (Draw > 3D > Tabulated Surface) creates a tabular 
(or extruded) surface using a path curve and a direction vector.  

You can extrude lines, arcs, circles, 2D, or 3D polylines. The entity provided as 
path curve defines the surface of the mesh. The direction vector (extrusion 
path) is determined by picking a line or an open polyline. 

The SurfTab1 system variable defines the number of M-direction surfaces on 
the extruded entity. When extruding a line, arc, or circle, the number of M-
direction surfaces is evenly divided determined by the value of the SurfTab1 
system variable. When extruding a polyline, extrusion lines are drawn at the 
ends of the line segments, and the arc segments are divided evenly into the 
number of surfaces determined by the value of the SurfTab1 system variable. 

If the polyline has been curved (fitted) or splined, the number of M-direction 
surfaces is evenly divided using the SurfTab1 variable.  

The resulting surface is a polygon mesh (stored in the drawing database as a 
complex polyline entity). 

To create a tabulated surface: 

1. Select the entity for the path curve. 
2. Specify the direction vector:  

> TABSURF 
Select path curve: [pick]  
Select direction vector (line or open polyline): [pick]  

The direction and length of the line determine the direction and length of the 
extrusion. Only the first and last points of a polyline are used when determining 
the extrusion path. The point at which you specify the entity determines the 
extrusion direction. 

   
Tabsurf command. Two mouse click points (P1, P2) and resulting surface. 
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RECOMMENDED MESH CONSTRUCTION * 
The system variables that control the M and N indices of meshes are SurfTab1 
and SurfTab2. SurfTab1 sets the M index, and SurfTab2 sets the N index.  

Although you can specify values up to 256 for either index, it is not 
recommended to use high values in mesh construction. The reason is that a 
dense mesh increases the processing time of your drawing. 

You cannot change the M and N values an existing mesh. If you are not 
satisfied with the mesh, you must erase the mesh, reset the SurfTab1 and 
SurfTab2 variables, and then recreate the new mesh. 

NEW 3D FUNCTIONS * 

 

Starting with FelixCAD version 4.01, a series of new 3D functions are 
available to the CAD user. Object creation is based on intuitive input options 
available to the user and/or programmer.  

The new objects are under the 3D option in the DRAW menu are:  

Box * 
The command 3DBOX (Draw>3D>Box) allows simple creation of a 3 
dimensional box. 

Wedge * 
The command 3DWEDGE (Draw>3D>Wedge)  allows creation of a 3 
dimensional wedge. 
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Cylinder/Cone * 
The command 3DCONE (Draw>3D>Cylinder/Cone) allows creation of a 3D 
cone, cylinder, prism, or pyramid. Object creation is determined by user input. 
Smoothing, or "roundness", is entered as a unit number. A lower number will 
create less 3D object faces, resulting in less smoothing, and a quickly generated 
result. A higher number (e.g. 200) will create more 3D faces and better 
smoothing. Using a higher number takes longer to compute. 

Sphere * 
The command 3DSPHER (Draw>3D>Sphere) allows creation of a 3D sphere. 
Smoothing, or "roundness", is entered as a unit number. A lower number will 
create less 3D object faces, resulting in less smoothing, and a quickly generated 
result. A higher number (e.g. 200) will create more 3D faces and better 
smoothing. Using a higher number takes longer to compute. 

Ellipsoid * 
The command 3DELLIPS (Draw>3D>Ellipsoid) allows creation of a 3D 
ellipsoid object. Smoothing, or "roundness", is entered as a unit number. A 
lower number will create less 3D object faces, resulting in less smoothing, and 
a quickly generated result. A higher number (e.g. 200) will create more 3D 
faces and better smoothing. Using a higher number takes longer to compute. 

Torus * 
The command 3DTORUS (Draw>3D>Torus) allows creation of a 3D torus. 
Smoothing, or "roundness", is entered as a unit number. A lower number will 
create less 3D object faces, resulting in less smoothing, and a quickly generated 
result. A higher number (e.g. 200) will create more 3D faces and better 
smoothing. Using a higher number takes longer to compute. 
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Modifying Drawing Objects 

In this chapter, you learn about the modification and editing 
commands found in the Modify menu.  

These commands let you modify entities by moving, rotation, scaling, 
mirroring, and copying them. They also provide a way easily perform 
time-consuming editing, such as fillet, chamfer, trim, and stretch.  

Some commands are specific to some entities, such as editing 
polyline vertices. Before you can use any of these commands, a 
drawing must be open, and at least one entity must be in the drawing. 
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Object Selection 
All modify commands request that you select one or more objects for 
modification. The option bar displays all the methods of object selection 
available: 

 

For most commands, you may select more than one object for editing. 
However, some commands, such as Trim and Expand, expect a single object 
for some of their prompts.  

When multiple objects are selected, they are transformed together in the same 
relationship as they are currently placed. For more information on objet 
selection, see Chapter 2 “Drawing with Precision”. 

MODIFY PARAMETERS 

  The EditPar command (Modify > Modify Parameters) allows you to 
define the default values for some modifying and editing commands. The 
command displays the Edit Parameters dialog box:  

Mirror / Flip 
The Mirror / Flip area determines what happens to the orientation of text and 
hatch patterns after the commands that mirror or flip objets.  
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Mirror Text 
When the Mirror Text option is on (a check mark is shown), text objects are 
mirrored. When turned off (the default) text is copied, and not mirrored, about 
the specified axis. The following figure shows the influence of this option on 
text objects. 

 
Mirroring of a text object, option Mirror Text activated (left) or not activated (right) 

 
Mirror Hatching  

When the Mirror Hatching option is on (a check mark is shown), hatch 
objects are mirrored. When turned off (the default) hatching is copied, and not 
mirrored, about the specified axis.  

Offset & Fillet / Chamfer 
The Offset and Fillet / Chamfer areas are discussed later in this chapter. The 
values set for in this dialog box are only default values, which can be changed 
by the Offset, Fillet, and Chamfer commands themselves. 

Common 
The Highlight objects when selected option determines whether objects you 
select are highlighted by a different color When on (the default), selected 
objects are displayed in the magenta (pink) color. When off, selected objects do 
not have the dashed line, which is useful for slower computers. 

The Display highlighted objects as a dashed line option determines the look 
of highlighted objects. When on, selected objects are displayed by dashed lines, 
which is useful for monochrome displays. When off (the default), selected 
objects do not have the dashed line. 
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The Let Groups be selected option determines what happens when you pick 
an entity that is part of a group. When this option is on (the default), picking 
the entity picks the entire group; when off, only the entity is picked. Groups are 
discussed in detail in “Parts and Attributes, XRefs, & Groups.” 

Mouse Context ON/OFF. Found under the TOOLS menu. When activated 
('ON') this tool will automatically show any modifications available to any 
object via an option dialog box, by simply left-mouse clicking on it. It allows 
changes to objects without searching for the applicable commands. 

MOVE 

  The Move command (Modify > Move) move drawing objects within the 
coordinate system.  

> move 
Select objects: [pick] 
Select objects: [Enter] 
Basepoint: [pick] 
Second point of displacement: [pick] 

Select the objects to be moved. You may select more than one object; they will 
be moved together in the same relationship as they are currently placed. End 
object selection by pressing Enter. 

 
Position of an object before (left) and after (right) the moving 
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The next prompt asks for the location of the Basepoint. This is the point that 
you choose as the base from which to begin the move. 

Basepoint Rel.Point     

 
If, however, you need to move the objects a specific distance from their current 
location, select the Rel.Point option from the option bar. The prompt asks for 
distances in the X, Y, and Z directions: 

Basepoint: Rel.Point 
Relative point dX,dY,dZ: [pick] 

The third method is to select the objects with the cursor, and drag them to the 
new location. Remember to use object snap modes to make the move more 
accurate.  
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COPY 

  The Copy command (Modify > Copy) duplicates objects within the 
coordinate system. The copies created by this command are exact copies of the 
selected entities. All entity attributes such as layers, line type, color, etc. are 
copied as well as the outline of the objects. 

> copy 
Select objects: [pick] 
Select objects: [Enter] 
Specify base point or select option (Relative Point, 
Multiple): [pick] 
Target point: [pick] 

Select the objects to be copied, and end object selection with Enter. The option 
bar displays the Basepoint and Rel.Point option: 

Basepoint Rel.point     

 
The Basepoint option prompts you for base point and the target point (the 
position to which the copy is to move).  

The Rel.Point option asks for the relative points by specifying the move in the 
X, Y, and Z directions. (You don’t to specify a Z delta.)  

> COPY 
Select objects: P1 
Select objects: [Enter] 
Basepoint: Rel.Point 
Relative point dX,dY,dZ: 2,-3 

 
Position of objects before (left) and after (right) the copying 
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ROTATE  

  The Rotate command (Modify > Rotate)  rotates entities through an 
angle about an axis.  

> ROTATE 
Select objects: P1 
Select objects: [Enter] 
Basepoint: P2 
Rotation angle: 60 

Select the objects to be rotated. 

Angle Reference     

 
The command prompts for a basepoint, which is the point about which the 
entities are rotated. We recommend that you pick a corner or the center of an 
entity, but you may pick any point -- whether on or off of the geometry.  

When prompted, enter the rotation angle. Rotation takes place to the specified 
angle. 

As an alternative, you may select a reference angle: 

> ROTATE 
Select objects: P1 
Select objects: [Enter] 
Basepoint: P2 
Rotation angle: Ref.Angle 
Reference angle <0>: 44  
New angle: 45 

The Reference option asks for a starting angle, then prompts for a new angle to 
which the object will be rotated. Rotation occurs counterclockwise. As before, 
rotation occurs about the basepoint.  
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SCALE 

  The Scale command (Modify > Scale) changes the size of selected 
objects. The objects are scaled uniformly in the X and Y directions. 

> SCALE 
Select objects: P1 
Select objects: [Enter] 
Basepoint: P2 
Scale factor: 1.5 

Select the objects to be scaled. 

The command prompts for a basepoint, which is the point from which the 
entities are scaled. We recommend that you pick a corner or the center of an 
entity, but you may pick any point -- whether on or off of the geometry. 

Note: If the basepoint is part of the selected object, it keeps its original position 
during the scaling, while all the other points are scaled by the same relative 
values in the X and Y directions. When the basepoint is not on the object, the 
distance from the basepoint to all other points on object are changed by the 
same scale factor. 

The command then displays the options bar: 

Sc.Factor Reference     

 
The Sc.Factor (short for “scale factor”) option is the default option. 
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Enter a scale factor: 

• A scale factor larger than 1 enlarges the selected objects. 
• A scale factor between 0 and 1 reduces the objects by that factor. 
• Negative scale factors are not permitted. 

For example, a scale factor of 3.0 enlarges the selected objects by three times, 
while a scale factor of 0.25 reduces the objects to one-quarter of their original 
size. 

The scale factor can be specified by indicating a second point. To do this, move 
the cursor after the fixing the basepoint. The distance (measured in drawing 
units) is interpreted as the scaling factor. The advantage is that you see the 
effect of the scaling while moving the cursor; the disadvantage is that the scale 
factor is less precise. 

Reference Scale 
The Reference option allows you to change of the size of an entity without 
need to first calculate the scale factor. For example, if you need to enlarge an 
object with a length of 3.45 drawing units up to 6.9 drawing units, you would 
first calculate the scaling factor (6.9 / 3.45 = 2).  

The Reference option makes this calculation for you. Select the Reference 
option from the option bar. Enter the reference length, and then enter the new 
length: 

> SCALE 
Select objects: P1 
Select objects: [Enter] 
Basepoint: P2 
Scale factor: Reference 
Reference length <1>: 3.45 
New length: 6.9 
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FLIP 

  The Flip command (Modify > Flip) flips selected entities about a 
specified axis. (This is unlike the Mirror command, where the original entities 
remain in place.)  The flip axis can be at an arbitrary angle, or be parallel to the 
X- or Y-axis. 

> FLIP 
Select objects: P1 
Select objects: [Enter] 
First point of mirror axis: P2 
Second point: P3 

Select the object, then select an axis option from the option bar: 

Axis Horizontal Vertical    

 
Axis 

The Axis option allows you to specify the flip axis, and is the default option. 
Indicate two points or type the coordinates. The axis may have any alignment: 
aligned with the objects, or any of the axes. 

 

If the axis is supposed to run through any points of existing geometry, we 
recommend that you use object snap options to define the points precisely. 
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Horizontal  
To flip the marked object about the horizontal axis, choose the Horizontal 
option. The flip axis runs parallel to the X-axis of the coordinate system. A 
single point is only required to define this axis. 

> FLIP 
Select objects: P1 
Select objects: [Enter] 
First point of mirror axis: Horizontal 
Horizontal reflection point: P2 

Vertical  
To flip the marked object about the vertical axis, choose the Vertical option. 
The flip axis runs parallel to the Y-axis of the coordinate system. A single point 
is only required to define this axis. 

> FLIP 
Select objects: P1 
Select objects: [Enter] 
First point of mirror axis: Vertical 
Vertical reflection point: P2 

MIRROR 

 The Mirror command (Modify > Mirror) makes a mirrored copy of 
selected entities, and keeps the original entities in place. This is different from 
the Flip command, which erases the original entities. 

> MIRROR 
Select objects: P1 
Select objects: [Enter] 
First point of mirror axis: P2 
Second point: P3 

Select the object(s). Press Enter to end object selection. 

The next prompt asks for the definition of the mirror axis, displaying the 
options on the options bar. 

Axis Horizontal Vertical    
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Axis 
The Axis option allows you to specify the mirror axis, and is the default option. 
Indicate two points or type the coordinates. The axis may have any alignment: 
aligned with the objects, or any of the axes. 

If the axis is supposed to run through any points of existing geometry, we 
recommend that you use object snap options to define the points precisely. 

 

Horizontal  
To mirror the marked object about the horizontal axis, choose the Horizontal 
option. The mirror axis runs parallel to the X-axis of the coordinate system. A 
single point is only required to define this axis. 

> MIRROR 
Select objects: P1 
Select objects: [Enter] 
First point of mirror axis: Horizontal 
Horizontal reflection point: P2 

Vertical  
To mirror the marked object about the vertical axis, choose the Vertical option. 
The mirror axis runs parallel to the Y-axis of the coordinate system. A single 
point is only required to define this axis. 

> MIRROR 
Select objects: P1 
Select objects: [Enter] 
First point of mirror axis: Vertical 
Vertical reflection point: P2 



Chapter 6   Modifying Objects 

 195 

Mirroring Text 
If there is text among the selected objects, it is likely that you do not want  that 
text mirrored. For this reason, FelixCAD does not, by default, mirror text 
entities. 

If you need the text mirrored, use the EditPar command (Modify > Modify 
Parameters) to display the Edit Parameters dialog box. Click the check box 
next to Mirror Text and click OK. 

STRETCH 

  The Stretch command (Modify > Stretch) stretches entities that lie on 
the border of the selection rectangle, but moves entities that lie within the 
selection rectangle. (This command performs like a combination of the Move 
and Lengthen commands). Stretching is useful for enlarging or reducing 
entities in one direction. This is in contrast to the Scale command, which scales 
in both the X and Y directions). 

Like other editing commands, you must select objects for stretching. The 
Stretch command, however, is more sensitive in the selection of entities.  You 
must carefully plan which entities will be stretched and which not.  Different 
types of entities may be stretched at the same time. A typical use of this feature 
would be stretching a hatched object with a dimension. The object, associated 
hatch and dimension lines would stretch in the desired direction. Additionally, 
the dimension text is updated automatically to the correct value.  

During the command, the method of selection has an influence on which 
entities are moved and which are stretched, according to these rules: 

Crossing Cpolygon Remove    

• Entities totally enclosed by the crossing window (or polygon) are moved. 
• Entities crossing the crossing window (or polygon) are stretched 

(lengthened). 
• All other entities retain their position and shape. 
 



Chapter 6   Modifying Objects 

 196 

 

After selecting entities, according to the rules listed above, the command 
displays these options: 

Basepoint Displacem.     

Basepoint 
The default Basepoint option is useful for moving selected entities to a 
particular position, and for stretching entities on the selection border.  

Select the basepoint for the stretch by typing the coordinates or pick the 
basepoint. 

> STRETCH 
Select objects: P1 
Select objects: [Enter] 
Basepoint: P2 
Second point of displacement: P3 

Finally, determine the end point of the stretch. The basepoint is moved to the 
end point. 

Displacement 
The Displacement option stretches selected entities by a vector (a straight line 
defining length and distance). Enter the value for the move in the form of X, Y, 
and (optionally) Z coordinates. 

> STRETCH 
Select objects: P1 
Select objects: [Enter] 
Basepoint: Displace. 
Displacement dX,dY,dZ: 2,-3 
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ARRAY  
The Array command (Modify > Array) creates multiple copies of selected 
entities at random or in a pattern. The pattern may be in horizontal rows and 
vertical columns, in a circle, or in an arc. In addition, the entities can be rotated 
when arrayed in the circular or arc patterns. 

After entering the command and selecting the entities, select an option: 

Individual Rectangular Circ.NRot Ci.Rot   

 
Individual   

 The Individual option copies the selected entities repeatedly, just as if 
you were to use the Copy command over and over. This option is the default 
for the Array command. 

> ARRAY 
Individual> [Enter] 
Select objects: P1 
Select objects: [Enter]  
Basepoint: P2 
Target point: P3 
Target point: P4 
Target point: [Enter] 

Select the basepoint. A discreet point on the geometry (such as an edge, corner, 
or intersecting points) is often more useful.  

 

Type the coordinates of the target point, or pick the points for placement of the 
copies. The command creates a copy of the selected entities at each target 
point. 
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Until you terminate the command, you keep placing a copy, as required. 
Terminate the command by pressing Esc or Enter. 

Rectangular   

 The Rectangular option arranges the array in rows and/or columns, 
called a rectangular array. 

> array 
Individual> Rectang 
Select objects: [pick] 
Select objects: [Enter] 
_RECTANG 
No. of columns: 2 
No. of rows: 3 
Distance between columns: 4 
Distance between rows: 5 

Start the Array command, then select Rectang from the option bar. After 
selecting the entities to array, specify the number of the columns and rows. 
Finally, define the distance between the columns and the rows. 

Note: The rows and columns are normally array up and to the left. To array the 
entities down and to the right, use a negative number for the distance.  

 

Circ.NRot & Ci.Rot   

 The Circ.NRot and Ci.Rot options copy the selected entities in a circular 
path, called a circular array. The copying can be around a full 360-degree 
circle, or a partial circle (an arc.). 

The Circ.NRot option creates a circular arc without rotating the selected entity. 
The Ci.Rot option rotates the selected entities so that they always “face the 
center.”  
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Both options prompt you for the following parameters: 

> ARRAY  
Individual> Circ.NRot or Ci.Rot 
Select objects: P1 
Select objects: [Enter] 
Center: P2 
Number of entities: 4 
Angle to fulfill <360>: [Enter] 

• Center: the center point of the circular array. 
• Number of entities: the number of times the Array is to reproduce the 

selected entities. 
• Angle to fulfill: the distance the array should go around the circle;  360, if 

the array is to be a full circle. 
 
When creating a circular array, the command uses a reference point on which to 
position the entities on the circumference of the circle, as shown in the 
following table: 

Entity Reference point 

Arc Center of arc. 

Circle Center of circle. 

Line Start or end point. 

Part Insertion point. 

Point Insertion point. 

Rectang Start point. 

Text Insertion point. 
 

For example, when you array a circle entity (to represent bolt holes around a 
pipe flange, for example), the Array command arrays the circle at its center 
point.  

If you wish to change this reference point, the Basepoint option lets you define 
an alternate reference point on the entity to be array. Remember to use an 
object snap mode with this option. 
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Array Without Rotation   

 The Circ.NRot option (short for “circular, no rotation”) arranges the 
entities around a circle (or arc) path without changing the alignment of the 
entity.  

> Array  
Individual> Circ.NRot 
Select objects: P1 
Select objects: [Enter] 
Center: P2 
Number of entities: 4 
Angle to fulfill <360>: [Enter] 
Angle between entities: 60 

Select the objects for the array, choose the Circ.NRot option, and define the 
center of the circular path. Then determine either: 

• The number of the entities to be arrayed (including the original). 
• And the included angle of the circle (arc). 

or  
• The included angle of the circle (arc). 
• And the included angle between the arrayed object to be reproduced 

(measured between the reference points of the objects). 
 

 

Note: Circular arrays are constructed counterclockwise from the starting point. 
For a clockwise rotation, enter negative values for the angle. 
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Array With Rotation    

 The Ci.Rot option (short for “circular, rotated”) rotates the arrayed 
entities when placing them along the circular path. The entities are rotated in 
the same direction as the circle describing the path. The rotation angle 
corresponds to the angle between the copies (measured between the reference 
points of the arrayed entities). 

> ARRAY  
Individual> Ci.NRot 
Select objects: P1 
Select objects: [Enter] 
Center: P2 
Number of entities: 4 
Angle to fulfill <360>: [Enter] 

After starting the Array command, select the entities, and choose the Ci.Rot 
option  from the option bar. Define the center of the circular path and then 
determine either: 

• The number of the entities to be arrayed (including the original). 
• And the included angle of the circular arc, 
 

or  

• The included angle of the circular arc. 
• And the included angle between the entities to be arrayed (measured 

between the reference points of the objects). 
 

 

The default value is 360 degrees. Either confirm, or choose the value. 
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OFFSET THROUGH POINT 

  The Offset command (Modify > Offset Through Point) creates parallel 
copies of lines, circles, arcs, and 2D polylines. The command copies the 
selected entity and places it a specific distance from the original. The original 
entity stays in place.  

Note: The Offset command can create unexpected results, depending on the 
entity selection:  

• Line and straight 2D polyline: an identical copy is created, to make parallel 
lines. 

• Circle and arcs: an copy is created, but is scaled by a factor to make 
concentric curves. The center of the original circle or arc is used as a 
basepoint for scaling.  

• 3D polyline made of line and arc segments:  due to the arc portions being 
scaled, the offset polyline may look very different from the original. 

 
Lines & 2D Polylines 

Start the Offset command, and select the line(s) or polyline(s) to be offset. 

There are two ways to specify the offset distance. One method is to pick a 
point, using object snaps if necessary. FelixCAD offsets the copy at the pick 
location. 

> OFFSET 
Select objects (line, circle, arc, 2D-polyline): P1 
Offset by point: P2 
Select objects (line, circle, arc, 2D-polyline): [Enter] 

The second method is to select the Distance option. Enter the offset distance. 
You are then prompt “Offset to Side?”. Pick a point on either side of the 
original entity.  

> OFFSET 
Selection of an entity  
(Line, circle, arc, 2D-Polyline): P1 
Offset by point: Distance 
Distance <5> 10 
Offset to side ? P2 
Selection of an entity  
(Line, circle, arc, 2D-Polyline): [Enter] 
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In both cases, the Offset command continues, until you press Enter or Esc. 

 

Circles & Arcs 
The Offset command creates concentric circles and arcs with a small or larger 
diameter than the original entity.  

After selecting the objects to be offset, the position of the offset is determined 
by: 

• Picking a point. 
• Typing the coordinates of a point on the circle or arc. 
• Using the Distance option. 
 

 

> OFFSET 
Select objects (line, circle, arc, 2D-polyline): P1 
Offset by point: P2 
Select objects (line, circle, arc, 2D-polyline): [Enter] 
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Distance 
The Distance option allows the offset to be created a specific distance from the 
original entity. Select this option from the option bar. 

Distance      

 
Determine the distance between the original entity and the offset by either a 
numeric value input (in drawing units) or by cursor selection. Then, point (and 
click) with the cursor to the side of the original entity on which the offset is to 
occur. 

> OFFSET 
Selection of an entity  
(Line, circle, arc, 2D-Polyline): P1 
Offset by point: Distance 
Distance <5>: 10 
Second point P3 
Offset to side ? P4 
Selection of an entity  
(Line, circle, arc, 2D-Polyline): [Enter] 

Both Sides 
You can offset an entity to both sides by selecting the BothSides option when 
you are asked to specify the side to offset: 

> OFFSET 
Select entity (line, circle, arc, 2D-polyline): [pick] 
Offset through point: Distance 
Distance <0.98> [pick] 
Second point: [pick] 
Side to offset ? BothSides 
Select entity (line, circle, arc, 2D-polyline): [Enter] 
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OFFSET DISTANCE  
The DOffset command (Modify > Offset Distance) creates lines and curves 
parallel to an existing entity.  

The DOffset command is similar to the Offset command, but prompts you for 
the offset distance before you select entities. (This command has been added 
for convenience of users familiar with other CAD programs.) 

> DOFFSET 
Distance or select option ThruPoint <1.00>: 0.30 
Select entity (line, circle, arc, 2D-polyline): [pick] 
Side to offset ? [pick] 
Select entity (line, circle, arc, 2D-polyline): [Enter] 

Through 
To indicate a through point (such as an significant point in the geometry), 
select the ThruPoint option (or type T, for short): 

> DOFFSET 
Distance or select option ThruPoint <0.30>: T 
Select entity (line, circle, arc, 2D-polyline): [pick] 
Offset through point: [pick] 
Select entity (line, circle, arc, 2D-polyline): [Enter] 

BothSides 
You can offset an entity to both sides by selecting the BothSides option when 
you are asked to specify the side to offset: 

> DOFFSET 
Distance or select option ThruPoint < 0.50 > : [Enter] 
Next point: [pick] 
Select entity (line, circle, arc, 2D-polyline): [pick] 
Side to offset ? BothSides 
Select entity (line, circle, arc, 2D-polyline): [Enter] 
Side to offset ? 
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TRIM 

  The Trim command (Modify > Trim) cuts off entities that cross a 
“cutting edge.” The cutting edge is the intersection with another entity. The 
entities are trimmed on the side that you pick. The command keeps repeating 
until you end it with the Esc key. 

> TRIM 
Select entities for intersecting edges 
(Line, circle, arc, 2D-Polyline): P1, P2 
Select entities for intersecting edges 
(Line, circle, arc, 2D-Polyline): [Enter] 
Select entity for trimming 
(Line, circle, arc, 2D-Polyline): P3, P4 
Select entity for trimming 
(Line, circle, arc, 2D-Polyline): [Esc] 

Start the Trim command and select one or more entities that will become the 
intersection edge.  

The next prompt asks you to select the entity that you want to trim. The 
selection is sensitive to location: the point you pick is the portion that will be 
trimmed away. As entities are selected, they are trimmed; the trimmed portion 
disappears from the drawing.  
 

 

Note: Some objects will not trim other entities, most notably Parts or 
Blocks.  
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EXPAND  

  The Expand command (Modify > Expand) lengthens entities to a 
boundary edge. The boundary edge is another entity, such as a line, arc, circle, 
or 3D polyline. Use this command to close polygons, and to extend entities to 
the proper boundary edge. Note: AutoCAD users know this command as 
EXTEND. 

Note: the Expand command does not work with “closed” objects, such as 
circles. Entities to be expanded are lengthened. They do not change direction. 
A line remains a line; an arc remains an arc.  

Start the Expand command, then select the entities that will act as the 
boundary edge. You may select one or more lines, circles, arcs, and 2D 
polylines. Press Enter to end the boundary edge selection.  

> EXPAND 
Select entities with boundary edges (line, circle, arc,  
 2D-polyline): P1, P2 
Select entities with boundary edges (line, circle, arc,  
 2D-polyline): [Enter] 
Select entity for expanding (line, circle, arc,  
 2D-polyline): P3 
Select entity for expanding (line, circle, arc,  
 2D-polyline): [Enter] 

Then select the entities to be expanded. This is sensitive to your pick location. 
For example, an arc is expanded in the direction of your pick location. The ex-
pansion of selected entities is always executed from the endpoint that lies 
nearest to the cursor when it selected the entity. When more then one boundary 
edge has been selected, the entity is expanded to the first boundary edge first. 
Picking a second time results in the expansion continuing to the second 
boundary edge. 
Note: Some objects cannot be used to expand to other entities, most notably 
Parts or Blocks. 
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FILLET 

  The Fillet command (Modify > Fillet) rounds the intersection of two 
lines. These can also be lines of an object such as a rectangle. The Fillet 
command treats 2D polylines differently from lines: every vertex of the 
polyline is filleted. The command cannot fillet curved objects, such as arcs. 

When the fillet radius is 0.9 (the default), this command precisely cleans up the 
intersection of two lines.  

The Fillet command prompts you to select the two lines to be filleted.  

> FILLET 
Select first line: P1 
Second line: P2 

Then these options are shown in the options bar: 

Polyline Radius No_Trim    

 
Polyline 

The Polyline option fillets a single polyline. Every vertex of the polyline is 
given the fillet radius.  

> FILLET  
Select first entity: Polyline 
Select 2D-polyline: P1 
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Radius  
The Radius option allows you to define the radius for the fillet. By default, the 
radius is 0.0. When you change the radius, FelixCAD remembers it for the next 
command operation. 

> Fillet 
Select first line: Radius 
Filleting radius <0.0000>: .75 
Select first line: P1 
Second line: P2 

 

No_Trim 
The Trim option functions as a switch: it decides whether or not the lines 
beyond the fillet are erased. When the options bar displays Trim, you switch 
off the trimming by clicking the word; it then changes to No_Trim. 

The following figure shows the effect of the No_Trim switch.  

 

Trim option switched on (left) and switched off (right). 
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CHAMFER  

  The Chamfer command (Modify > Chamfer) creates a beveled corner 
between two intersecting lines. 

> CHAMFER 
Select first line: P1 
Second line: P2 

Select the two entities to be chamfered by picking them with the cursor.  

 

Polyline Distance No_Trim    

 
Distance 

The Distance option allows you to specify the two chamfering distances.  

> CHAMFER 
Select first line: Distance 
First chamfering distance <1.0000>: [Enter] 
Second chamfering distance <0.5000>: 1.000 
Select first line: P1 
Second line: P2 

No_Trim 
The No_Trim option functions in exactly the same manner as described with 
the Fillet command. 

Polyline 
The Polyline option functions in exactly the same manner as described with the 
Fillet command. 
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INTERSECT 

  The Intersect command (Modify > Intersect) is a special case of the 
Fillet command, with the fillet radius always set to 0. This makes the command 
useful for trimming intersecting lines to be trimmed.  

> INTERSECT 
Select first line: P1 
Second line: P2 

Select the two lines to be trimmed. Be sure to make the pick on the segment of 
each line that is to remain. 
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LENGTHEN  

  The Lengthen command (Modify > Lengthen) changes the length of 
open entities, such as lines and arcs. Unlike the Expand command, Lengthen 
works without a boundary edge; it extends an entity by a specific value or ratio 
(percentage value) of the original size.  

Although the command is called “Lengthen,” is may be used to lengthen or 
shorten entities. Entities are changed in length, not scaled. Entities are always 
lengthened at the end laying closest to the cursor pick point. 

> lengthen 
Select entity (line, arc): [pick] 
Current Length <7.11>: Dynamic:  

After selecting the line or arc to lengthen, the command reports the entity’s 
current length. The Dynamic option is the default; the option bar displays other 
options: 

Total Percent Relative   Angle 

 
Dynamic 

The Dynamic option is the default option of the Lengthen command. You drag 
the line or arc to its new length. When you click with the cursor, the new length 
is fixed. 

> LENGTHEN 
Select entity (line, arc): P1 
Current length <100.00>: Dynamic P2 
Select entity (Line, Arc): [Enter] 

The Lengthen command continues until you press Enter or Esc. 

Total 
The Total option changes the length to an absolute distance. The change is 
applied to the length of a line or to the circumference of an arc. To assist you, 
the current length of the selected entity is displayed in parentheses. 

> LENGTHEN 
Select entity (line, arc): P1 
Current length <100.00>: Total 
Total: 200.00 
Select entity (Line, Arc): [Enter] 
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Percent 
The Percent option allows you to specify the new length by a percentage value. 
This percentage value relates to either line length or the circumference of an 
arc. For example, specifying 200 doubles the length of the line or the arc, while 
the value of 50 shortens the entity to half its original length.  

> LENGTHEN 
Select entity (line, arc): P1 
Current length <100.00>: Percent 
Percent: 60 
Select entity (Line, Arc): [Enter] 

Relative 
The Relative option lengthens a line or arc by a value defined by the distance 
between two points. This option is useful when the entity must be lengthened 
by reference to another object. (If the Angle option has been selected, you 
determine the angle by which the arc is lengthened by indicating two points in 
the XY-plane.) 

> LENGTHEN 
Select entity (Line, Arc): P1 
Current length <10.00>: Relative 
Relative: P2 
Second point: P3 
Select entity (Line, Arc): [Enter] 

Angle 
To lengthen arcs, use the option Angle. This option functions like a switch. 
Selecting it from the option bar causes all of the following options to display a 
prompt for the included angle of the arc. 

> lengthen 
Select entity (line, arc): [pick] 
Current Length <9.32>: Dynamic: Angle 
Included angle of arc <205.90>: Dynamic: [pick] 
Select entity (line, arc): [Enter] 
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DELETE PARTIAL  

  The DelPartial command (Modify > Delete partial) erases a portion of 
a line, 2D polyline, circle, or arc. This command is useful for dividing an 
entity: the result is two independent entities, which can be edited or operated on 
separately.  

Whereas the Trim command cuts off the end of open entities, the DelPartial 
command cuts out their middles.   

2 Points 1 Point      

 
2Point 

The 2Point option is the default. It requires that you pick two points: 
> DELPARTIAL 
Select object (line, circle, arc, 2D-polyline): P1 
First point: P2 
Second point: P3 

The part is erased between points P1 and P2. The line is divided at this point; 
the portion of the line between the two points is deleted. 

When the entity is a circle, it becomes and arc. When a 2D polyline has a width 
greater than zero, it is cut at right angle to the polyline. 

1Point 
To separate or break an entity, choose the 1Point option. 

> DELPARTIAL 
Select entity (line, circle, arc, 2D-polyline): P1 
First point: 1P 
Break point: int 
of object: P2 

This option is useful for breaking an entity into two pieces, for example, at its 
intersection with another object. To do this: 

1. Select the 1Point option (or type 1P for short) at the “First point:” prompt.  
2. Select the break point. It may be wise to use the object snap options to 

increase the precision of the input. 

You achieve the same result when you type @ at the “Second point:” prompt. 
The @ symbol signifies the last point entered. 
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> DELPARTIAL 
Select entity (line, circle, arc, 2D-polyline): [pick] 
First point: int 
of object: P1 
Second point: @ 

In both cases, the entity will look the same as before -- until you select one part 
of the divided entity. 

Notes: You cannot break a circle with the 1Point option, since that would 
create an arc of 360 degrees.   

You can use the DelPartial command to shorten an entity. Here’s how: specify 
the first point on the entity where you want the new endpoint to be. Then pick 
the other point pass its endpoint. The entity is cut off at the point you picked on 
the object. 
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BREAK 
The Break command (Modify > Break) breaks objects at a point or at points 
you select, just like the DelPartial command. 

> BREAK 
Select entity (line, circle, arc, 2D-polyline): [pick] 
Second point (or F for first point): [pick] 

The Break command has been added for convenience of those familiar with 
other CAD programs. It is similar but not identical to the DelPartial command. 
The primary difference is that the Break command assumes that you might 
want to use the pick point when selecting the entity as the first point of the 
break. 

You can, however, respond to the “Second point:” prompt with the First option 
(or type F for short). This explicitly specifies both break points independent of 
the entity selection: 

> BREAK 
Select entity (line, circle, arc, 2D-polyline): [pick] 
Second point (or F for first point): F 
First point: [pick] 
Second point: [pick] 

You have the choice to break the entity into two pieces without erasing any part 
of it. To do this: specify the same point for both the first and the second points. 
Type @ at the request for the second point, which signifies the previous point 
entered. This is useful when you want to break an entity at the intersection with 
another entity: 

> BREAK 
Select entity (line, circle, arc, 2D-polyline): [pick] 
Second point (or F for first point): F 
First point: int 
of object: [pick] 
Second point: @ 
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REJOIN 

  The Rejoin command (Modify > Rejoin) unites separate line segments, 
which are aligned in the same direction. It also joins arc segments that share the 
same center and the radius. This function is useful for reuniting line and arc 
segments that have been divided by the DelPartial command.  

Select the command, then pick the entities to be rejoined:  

> REJOIN 
Select first entity (line, arc): P1 
Select second entity (line, arc): P2 

CHANGE 
The Change command (Modify > Change) edits the geometric character and 
the properties of many entities, including lines, circles, arcs, text, attributes, 
and part. The properties or geometry that can be changed depend on the entity.  

Note: To change the layer, color, or linetype properties, you may find it more 
useful to use the PropEdit Command (Edit > Modify Properties).  

> CHANGE 
Select entity (line, circle, arc, text, attribute definition, 
block insertion): P1 
Select entity (line, circle, arc, text, attribute definition, 
block insertion): [Enter] 
Modification point: P2 

Select the entity to be changed.  You may preview the change by selecting the 
Dragmode option from the options bar.  

Dragmode      

 
Since the properties changed depend on the entity selected, the following 
sections describe the changed by entity. 
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Line 
The Change command changes one end point of the line. You can move to a 
new position, while the length of the line remains the same. If the end point of a 
line is moved without using Dragmode, the point to be moved will be the point 
nearer the selection point. 

If Dragmode is activated, the point that lies nearer to the cursor position will 
be moved. By changing the cursor position the end point of the line to be 
moved can be changed. 

Circle 
The Change command alters the diameter (or radius) of a circle. Select the 
circle, then determine the new diameter by picking a point or typing an X, Y 
coordinate. 

> CHANGE 
Select entity (line, circle, arc, text, attribute definition, 
block insertion):  [pick a circle] 
Select entity (line, circle, arc, text, attribute definition, 
block insertion):  [Enter] 
Modification point: P2 

Arc 
The Change command alters the diameter (or radius) of an arc. Select the arc, 
then determine the new diameter by picking a point or typing an X,Y 
coordinate. 

> CHANGE 
Select entity (line, circle, arc, text, attribute definition, 
block insertion): : [pick an arc] 
Select entity (line, circle, arc, text, attribute definition, 
block insertion): [Enter] 
Modification point: P2 
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Text 
The Change command changes the following properties of a text entity: 

These text attributes, or parameters, may be changed. Existing values are 
displayed as parameters and can be taken over by pressing Enter. 

• Modification point: pick (or enter the coordinates) a new insertion point for 
the text. 

• Text style: enter the name of the new text style. 
• Text height: define the new height by typing a numeric value or by picking 

a new height. Dragmode is automatically activated during this option. 
• Rotation angle: change the rotation angle by picking a point or type a 

number. Dragmode is automatically activated during the change of this 
attribute. 

• Text: type different text, which replaced the entire selected text.  
 
> CHANGE 
Select entity (line, circle, arc, text, attribute definition, 
block insertion):  [pick text] 
Select entity (line, circle, arc, text, attribute definition, 
block insertion):  [Enter] 
Modification point: P2 
Text style <STANDARD> Normal 
Height <2>: 1 
Rotation angle <0>: 45 
Text <first floor>: 1st floor  

Attribute Definition 
The Change command changes the following properties of attributes (as for 
text): 

• Inserting point. 
• Text style. 
• Text height. 
• Rotation angle. 
 
As well as the these specific properties of attributes: 

• Name: determines the name of the attribute; enter a new name. 
• Request: enter a new line of text for the attribute prompt. 
• Parameter value: the constant or variable value of the attribute; enter a 

new value (a sequence of characters or numbers). 
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You find more information about attributes in “Parts and Attributes, XRefs, & 
Groups.” 

> CHANGE 
Select entity (line, circle, arc, text, attribute definition, 
block insertion):  P1 
Select entity (line, circle, arc, text, attribute definition, 
block insertion): [Enter] 
Modification point: P2 
Text style <STANDARD> Normal 
Height <2>: 1 
Rotation angle <0>: 45 
Text <first floor>: 1st floor  
Name <Att003>: [Enter] 
Request <Index No.>: current number 
Parameter value <1.01>: 2.01 

Part 
• The Change command allows you to change the insertion point and the 

rotation angle of a part. Dragmode is automatically activated during the 
change of this attribute. 
> CHANGE 
Select entity (Line, circle, arc, text, attribute  
 definition, part): P1 
Select entity (Line, circle, arc, text, attribute  
 definition, part): [Enter] 
Modification point: P2 
Rotation angle <0>: 90 
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POLYLINE EDITING  
 FelixCAD allows you to edit polylines by the 
following methods: 

• Chamfer: chamfers the polyline vertices. 
• Fillet: fillets the polyline vertices. 
• PolyEdit: edits the geometric properties of a 

polyline, such as its width. 
• VtxEdit: edits the vertices of the polyline. 

 
Modify Polyline   

 The PolyEdit command (Modify > Edit Polyline > Edit Entire 
Polyline) allows you to: 

• Open and close the polyline. 
• Convert lines and arcs into a polylines. 
• Join the polyline with other drawing entities, such as lines, arcs, and other 

polylines. 
• Change the width of the whole polyline. 
• Undo these changes. 
 

Transform to Polyline 
When you select a line or arc with the PolyEdit command, you are asked if you 
wish to transform it into a polyline: 
 

> polyedit 
Select a 2D polyline: [pick] 
Transform arc to polyline ?  

Yes No      

 
Select Yes or No from the option bar. If you answer No, the PolyEdit 
command prompts you to select another 2D polyline. 
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Open or Close 
After selecting the polyline, one of two option bars are displayed. This Open 
option is displayed if the polyline is closed: 

Open Join Width    

 
The Open option removes the polyline segment between the start and end 
points of the polyline. Then, since the polyline is now open, the Close option is 
displayed on the option bar. 

Close Join Width Back   

 
The Close option joins the start and end points of the polyline with a straight 
polyline segment. The width of this segment is equal to the ending width of the 
end point of the last drawn polyline. (The Back option, shown above, is 
displayed after one operation has been executed during this command). 

 

Open (left) and closed polyline 

> POLYEDIT 
Selection of a 2D-Polyline: P1 
Select option: Close 
Select option: [Enter] 
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Join 
The Join option joins a line, arc, or another polyline to the selected polyline. 
The prerequisite is that the polyline and entity to be joined must meet at the 
same end point; there cannot be a gap between the two. 

> POLYEDIT 
Select 2D-Polyline: P1 
Select option: Join 
Selection of an entity (line, arc, 2D-polyline): P2 
Selection of an entity (line, arc, 2D-polyline): [Enter] 

The width of the new polyline segment depends on the nature of the entity 
joined to the polyline. If a line or arc is joined to the polyline, the new polyline 
segment has the same width as the polyline segment’s end at which the line or 
the arc has been joined. 

If it is a polyline that was joined, the ending width of the polyline segment 
added will be the starting width of the parent segment. If the polyline to be 
joined is a polyline with a uniform width the ending width of the first selected 
polyline will be the new width of the segment being joined.  

Width 
The Width option changes the width of the entire polyline. Polylines with have 
different starting and ending width are made to a single, uniform width for all 
segments. 

> POLYEDIT 
Select a 2D-polyline: P1 
Select option: Width 
New width of the polyline <1.5000>: 2 
Select option: [Enter] 

Undo 
The Undo option undoes the last operation in this command. The PolyEdit 
command continues, and you see the “Select option:” prompt again. 

> polyedit 
Select a 2D polyline: [pick] 
Select option: Close 
Select option: u 
Select option: 
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Vertex Editing   

 The VtxEdit command (Modify > Edit Polyline > Vertex Editing) edits 
individual segments of a polyline. This command allows you to change the 
vertices of the polyline:    

• Insert a vertex. 
• Delete a vertex. 
• Move a vertex. 
• Change the width of a polyline segment. 

 
> vtxedit 
Select a 2D polyline: [pick] 
Next:  

Next Previous Insert Move Delete Width 
 

Next and Previous 
Select the polyline containing the vertex to be edited. When you select the 
polyline, the first vertex is highlighted with a large cyan (light blue) X marker.  

You select another vertex with the Next and Previous options. After selecting 
the vertex, select an editing option from the options bar: 

Insert 
The Insert option allows you to add a vertex, which also add another segment 
to the polyline. Select the option, then move the market to the position of the 
additional vertex. 

> VTXEDIT  
Select a 2D Polyline: P1 
Next: [Enter] 
Next: Insert 
New control point: P2 
Next: [Esc] 

The width of this new segment corresponds to the value of the width of the 
polyline at the bordering control points before the addition of the new segment. 

After inserting a segment, the VtxEdit command stays active. You may select 
another option or terminate the command by pressing Esc. 



Chapter 6   Modifying Objects 

 225 

Move 
The Move option relocates a vertex of the polyline to a new position. 

> VTXEDIT 
Select a 2D Polyline: P1 
Next: [Enter] 
Next: Move 
New Position: P2 
Next: [Esc] 

First, determine the vertex to be relocated, then define the new position of the 
chosen vertex. The vertex is moved to this position. Other segments of the 
polyline will remain unchanged. 

After moving a vertex, the VtxEdit command stays active. You may select 
another option or terminate the command by pressing Esc. 

Delete 
The Delete option erases a vertex from the polyline. 

> VTXEDIT 
Selection of a 2D Polyline: P1 
Next: [Enter] 
Next: Delete 
Next: [Esc] 

Move the marker to the vertex to be deleted, then select the Delete option from 
the options bar. 

The segment that has its starting point at the selected vertex will be deleted. 
The previous (in order of drawing) segment is lengthened to the next vertex.  

After deleting a vertex, the VtxEdit command stays active. You may select 
another option or terminate the command by pressing Esc. 
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Width 
The Width option changes the width of a single segment of a polyline. Move 
the marker to the vertex to be modified, then select the Width option from the 
options bar. Type a width or select the desired width of the polyline segment. 
The width of the selected segment will be changed according to the input. 

> VTXEDIT 
Select a 2D Polyline: P1 
Next: [Enter] 
Next: Width 
Starting width <0.50>: 1 
Ending width <1.00>: 2 
Next: [Esc] 

After changing the width of a segment, the VtxEdit command stays active. You 
may select another option or terminate the command by pressing Esc. 

Polyline to B-Spline 
The Spline command (Modify > Edit Polyline > Polyline to B-Spline)  fits a 
B-spline curve to a polyline. The curve is not forced to pass exactly through the 
polyline’s vertices (as does the PCurve command, described below) but 
produces a smoother curve fit. 

> SPLINE 
Select polyline to alter to B-spline: P1  
Number of segments for approximation (2 to 1024) <8>: 

8        

 
You turn the splined polyline back to its original form using the Spline 
command with the Decurve option (Modify > Edit Polyline > Decurve B-
Spline). 
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2-D Polyline to Curved Polyline 
The PCurve command (Modify > Edit Polyline > 2D-Polyline to Curved 
Polyline) fits a curve to the chosen polyline. The curve is forced to pass exactly 
through the polyline vertexes. The degree of fit can be made smoother with the 
number of steps and tension options. The tension is similar to pulling on the 
ends of a string constrained to pass through the polyline vertices. 

> PCURVE 
Select 2D-polyline to alter to curved polyline: P1  
Number of steps for interpolation points (0...6) <3>: Tension 
(0.0 ... 1.0) <0.5000>: 

You turn the curved polyline back to its original form using the Spline 
command with the Decurve option (Modify > Edit Polyline > Decurve 
Curved Polyline). 

Decurve        
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Text Objects 

 The commands described in this chapter are used for 
inserting text into drawings, as well as for changing 
text entities. Text provides labeling, creates legends, 
places descriptive notes, and other written elements in 
a drawing. The commands relating to text are found 
in the Detail menu.  

Properties of a Text Entity 
A text entity is defined by properties assigned during 
the creation of the text. Any of them may be changed 
after the creation of the original entity. The properties 
are:  

Note that some type fonts do not support all of these options. For instance, some 
fonts can be aligned vertically. On others, there is no change in aspect ratio 
permitted. 

True Type fonts always appear filled in your drawing and in your plot. 

To increase the speed and performance of True Type fonts, the Windows 
operating system draws some True Type text directly. Due to limitations in 
Windows, however, FelixCAD must draw True Type text that is transformed in 
certain ways; for instance, text that is inclined, upside-down, backward or has a 
width factor not equal to 1.0. 

Text that has been transformed might appear slightly more bold at the screen, 
especially at lower resolutions but this appearance does not affect the plotted 
output. 



Chapter 7   Text 

 230 

If a drawing has been opened that contains True Type fonts that are not 
recognized by Windows system, FelixCAD substitutes these fonts by the first 
found True Type font that is assigned to a font file. 

• Character string: represents the content of a text object. All characters, 
numbers, and special characters may be used for this string; 

• Font (or typeface): FelixCAD includes a set of fonts that can be used in 
creating text objects. Font files are marked by the extension 
.shx concerning AutoCAD’s own compiled shape fonts, 
.fsh concerning FelixCAD’s own compiled shape fonts;  
.ttf True Type fonts. 

• Text size: height of characters. 
• Insertion point: determines the position of the text in the drawing. The 

insertion point is defined by coordinate input or by selecting the point with 
the cursor. 

• Alignment (or justification): determines the horizontal and vertical position 
of the text relative to its insertion point. The character string can run right or 
left from the insertion point, or the insertion point may be centered on the 
text. The vertical alignment of the text objects may be above, center, 
baseline, or below. Any text object can be rotated during insertion. 

 
All of the parameters discussed above are set in the New Text Font dialog box. 

Fonts  
Fonts define the shapes of the text characters that make up each character set. 
In FelixCAD, you can use: 

FelixCAD’s own compiled shape (FSH) fonts, 
AutoCAD’s own compiled shape (SHX) fonts 
True Type (TTF) fonts. 

The procedures for managing and defining the properties of fonts are described 
in this section. Procedures are described for new fonts in the font selection list, 
editing and saving as font styles including the height, width factor and 
inclination angle, as well as alignment, of individual text fonts. 

The Fonts command (Detail > Fonts) allows you to load fonts from font files 
and customize the fonts to the requirements of the drawing. Customizing a font 
is called a text style. The Fonts command displays the Text Styles dialog box, 
which lets you select an existing style or create a new style.  
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Adding and Changing Text Styles 
Selecting an existing text style, making changes to it, or adding a new style are 
all done in the same way and are, therefore, discussed in this one section. 

Add a New Text Style 
To add a new type style to the drawing: 

1.   Use the Fonts command to open the Text Style dialog box.  
2.   Click New. Notice the New Text Style dialog box.  
3.   Define the parameters of the new text style and click OK.  
 

 

SHX fonts and FSH fonts are listed by the name of the file in which the fonts 
are stored. All installed True Type fonts, provided with your Windows system 
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are listed by font family name. So you can assign a font to a text style by 
selecting either a True Type typeface name and its font style (Standard ,Bold or 
Cursive,  for instance) .or a SHX respective FSH file. 

If the font file is located in another folder, click the … (find) button. The Open 
Font File dialog box opens. Select the font file from the other drive or folder.  

Changing Font Properties  
After the new font has been selected, its properties can be edited. Click the 
Modify button to display the New Text Style dialog box  

• Height (text size): expressed in drawing units. Entering a numeric value for 
Height gives the font a fixed height, which can no longer be changed when 
creating the text using this style. If you think that a change in the font height 
might be required, keep the height parameter set at 0 (the default).; you may 
change the font height later in the Text dialog box. 

• Width factor: controls the width of the characters in relation to the height. 
The default of 1.0 is normal width; a smaller value makes the text thinner; a 
larger value spreads out the text. This ratio is sometimes called the aspect 
ratio. .  

• Obliquing angle: defines the inclination of the characters in relation to the 
horizontal (X-axis). The default, 0, produces upright characters. Values up 
to 180 (degrees) result in an inclination to the right (forward), values above 
180 to an inclination to the left (backward). Practically, values between 0 
and 30 or between 180 and 210 are meaningful. 

• Backward: produces a mirror-image display of the text. 
• Vertical: produces characters aligned vertically. 
• Bottom Up: produces characters displayed upside down. 

 
Note: Some fonts do not support all of these options. For instance, some fonts 
can be aligned vertically, but others cannot. Other fonts do not permit a change 
to the width factor. 

It is possible to all combine these settings, although in some cases the 
combination of properties may interfere with each other. Fonts added or 
changed in this manner can now be used for creating or editing text objects. 
Defined fonts are saved with the drawing file and are available any time that 
the drawing is opened. 
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FONT CONVERSION TABLE 
A Fonts.Tab file in the \cfg directory allows you to create a font association 
table. During the Open command, FelixCAD reads this file. When FelixCAD 
cannot find a font file, it uses this list to substitute other fonts. The following is 
an example of the content of the Fonts.Tab file: 

[FONTTAB] 
complex=apcomplx 
romanc=apcomplx 
iso=apnorm 
helvetica=c:\felixcad\fonts\apswiss 

Currently [FONTTAB] is the only recognized section in the Fonts.Tab file. 
Each line in the [FONTTAB] section has the following syntax: 

source_font_filename=fcad_font_filename 

The source_font_filename must always be specified without filename 
extension, neither .fsh nor .shx.  

The fcad_font_filename must always be specified without filename extension, 
but can have a path specification.  

The program will search for an SHX or FSH file specified by 
apply_fcad_font_filename in the application directories. If that font file is 
found, it will be applied automatically; otherwise the program takes the 
alternative font file, registered in the felix4xx.ini file. 
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PLACING TEXT 

  The Text command (Detail > Text) allows you to add text to the drawing 
via the Text dialog box. Note that executing the command Qtext emulates the 
command line versus dialog box variant of text entry (as described in the 
FelixCAD for AutoCAD guide).: 

 

Text Input 
Text is entered into the edit box in the upper half of the dialog box. The cursor 
is positioned here upon the opening of the dialog box, so you may start 
immediately typing text. 

This dialog box offers the basic functions for editing text: the cursor keys, Page 
Up and Down, Home and End, and so on, work as you expect them to. 
Incorrectly entered text can be selected and deleted, just as with a word 
processor. 
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Insertion point 
There are two methods of defining the insertion point. The insertion point may 
be entered using (absolute) coordinates via edit boxes for X, Y, and Z.  

The second option is to define the insertion point interactively on the screen. 
Click the Interactive button to define the insertion point after you click OK. 
FelixCAD will prompt you “Insertion point:”. 

Options 
The Options section aids you in determining the height, the rotation, and the 
font (type style) of the text object.  

Height 
Entering a numeric value for Height gives the font a fixed height, which can no 
longer be changed when creating the text using this style. If you think that a 
change in the font height might be required, keep the height parameter set at 0 
(the default).; you may change the font height later in the Text dialog box. 

Angle 
Specify the insertion angle of the text. The default value is a rotation angle of 0 
degrees: the text object is inserted horizontally. Any positive or negative value 
between 0 and 360 is possible. Use this option to create text at right angles 
(Angle = 90) or to align the text to vertical and sloping objects. 

Font 
A drop-down list allows you to select a font (text style) for the text. The list of 
available fonts is displayed in this drop-down list. 
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Alignment 
The alignment of the text object is specified by using the options Align, Fit and 
Center. 

• Align: Text is aligned between two points, with proportionate text height. 
The Angle and Height options are ignored.  
After you click OK to exit the Text dialog box, FelixCAD prompts you for 
the “First point:” and “Second point:”. The two points define the rotation 
angle and the text height. 

• Fit: Text is fit between two points, at the specified height. The Angle option 
is ignored. 
After you click OK to exit the Text dialog box, FelixCAD prompts you for 
the “First point:” and “Second point:”. The two points define the rotation 
angle. 

• Center: Text is centered on the insertion point. 

Insertion Reference 
The Insertion Reference section specifies the position and the alignment of 
the text object in relation to the insertion point of the text object. During 
insertion of the text object, this reference point is coordinated with the insertion 
point. If the reference point is, for example, situated at the lower left corner of 
the text object, the text will run to the right. 

In total, there are twelve reference points available for your choice. They are 
represented by the initials of the locating corner (or center) of the text block. 

Vertical Alignment 
T (top): the insertion point is located at the top of the text. 
C (center): the insertion point is located at the center of the text. 
B (baseline): the insertion point is located at the baseline of the text. 
U (underneath): the insertion point is located at the bottom of the text. 

Horizontal Alignment 
L (left): the insertion point is located at the left of the text. 
C (center): the insertion point is located at the center of the text. 
R (right): the insertion point is located at the right of the text. 

UL, for example, represents the upper left corner of the text. Select the position 
for the reference point by clicking a radio button. 
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Special Text Characters 
Special characters are available for use with text entities. They are written 
in the text dialog box one way, yet appear on the screen and printed 
versions in the desired format. See table below. 

Special Character Text Written in Text 
Dialog Box 

Uses 

φ %%c Used in place of 
DIAMETER or 
DIA. 

°C 

°F 

%%d C 

%%d F 

Used to indicate 
temperature 

Overlined Text %%oOverlined 
Text%%o 

- 

Underlined Text %%uUnderlined 
Text%%u 

- 
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REFERENCE TEXT 
The RText command (Detail > Reference Text) allows you to enter new text 
that matches the style of existing text. Simply pick a text entity, then overwrite 
the string in the dialog box.  

> RTEXT 
Select reference text: P1 

 

Insertion point: P2 

Finally, specify the location of the new text entity in the drawing. The new text 
will have the same font, height, width factor, rotation angle and layer as 
displayed in the dialog: 
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MODIFY TEXT 

  The TextEdit  command (Detail > Modify Text) allows you to modify 
existing text in the drawing.  

Select a text entity in the drawing and FelixCAD displays the Text Edit dialog 
box. The dialog box is filled out with the parameters of the text. 

 

When the Interactive check box is on, you will be prompted to relocate the 
text when exiting the dialog. Otherwise, you may change the insertion point 
coordinates in the dialog box, if desired. 
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CORRECT TEXT 
The TCorrect command (Detail > Correct Text) allows you to edit text and 
attribute definitions. You may change the text as well as the font, size, etc.  

The command first prompts you to select the text or attribute definitions. Use 
the usual object select functions. Finish the object selection by Enter. 

 

Remain 
The upper half of the dialog box lists all text properties that can be modified. 
The check boxes next to Remain indicate whether the property is to be 
changed globally (off) or remain unchanged (on). For example, if you click the 
check box below the Height (to turn it off), you may enter a new value for the 
text height. All selected text lines are changed to this text height. 

Search String 
The lower half of the dialog box is a search function. Enter a string in the 
Search String edit box. FelixCAD will search for this text. Type the 
replacement string in Replace by. If this is left blank, FelixCAD erases the 
search string text.
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Parts and Attributes, 
Externally-Referenced Drawings, 
& Groups 

This chapter describes how to work with parts, attributes, and groups. Parts are 
known as blocks or cells in other CAD programs. Attributes are database-like 
text attached to parts. Groups are similar to named selection sets.  

While parts and groups sound similar, 
there are significant differences: 

• A part has an insertion point; a group 
does not. 

• A part can be inserted one or more 
times in the drawing; there is only one 
occurrence of the group.  

• When a part is redefined, all of its 
insertions are updated; groups are not 
redefined. 

• It is difficult to edit the entities 
making up a part; entities making up a 
group are easily edited. 
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THE ADVANTAGE OF PARTS 
Parts allow you to create a drawing using repetitive entities. These entities may 
contain a single entity, a group of entities, a partial drawing, or a complete 
drawing. These are inserted into a drawing as a single entity. 
 
Many times, you will find that existing parts, construction groups, or 
aggregates have only to be designed once. Repetitive use of these parts, or 
entities, allows you to create a drawing quickly. To define or insert parts, use 
the Parts menu.  

Properties of Parts 
A part is a complex object that consists of several drawing entities: 

• Basic entities, such as line, circle, and arc. 
• Drawing objects, such as hatch patterns and dimensions. 
• Complete drawings, whether in .flx, .dwg, or .dxf format. 
• Drawings already defined as parts. 

 
After a selection of entities is selected and defined as a part, it is saved by a 
name and treated as a single entity from then on. 

Editing, changing, and erasing a part always affects the part as a whole. The 
Explode command (Edit > Explode Complex Objects), dismantles (explodes) 
the part into its original components. 

A part is inserted in the drawing with the Insert command. During the 
command, you can specify the scale and rotation angle to fit the part to the 
current drawing. When the part is inserted into the drawing, all of its properties 
(layer, color, and linetype) are inserted with it. 

The part is inserted on the layer it was defined on. If the drawing does not 
contain that layer name, FelixCAD automatically creates the missing layer.  
The exception to this rule occurs when the part was created on layer “0” – in 
this case, the part is placed on the current layer. 
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Internal and External Parts 
Internal and external parts are treated differently with regard to storage location 
and their relationship to the drawing. 

Internal parts have been created and stored in the current drawing. They are 
internal to the drawing. These parts may be used in the current drawing, and 
are available for use in other drawings via the Drawing Explorer’s (Xplorer 
command) Block option. 

The PartExp command (Parts > Write Part File) exports the part to its own 
file on disk, in .flx, .dwg, or .dxf format. On their own, these parts are called 
external parts. Stored in separate drawing files, they are independent of the 
current drawing and can be used by other drawings and CAD programs.  

We recommend that your store external part in a library so that they can be 
easily accessed by all users at your firm. 

Note: AutoCAD users know these External Blocks as 'Wblocks'. 

Attribute Definitions 
A part can be given attributes, which are used to store non-graphical data, such 
as part number, price, or manufacturer name.  

Attributes can be displayed or be hidden from view. Attributes can be exported 
to a text file, then read by a database or spreadsheet for further processing, such 
as counting all the parts in the drawing.  
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CREATING PARTS 
A part is created in three steps: (1) select a group of entities; (2) name the part; 
and (3) select an insertion point for the part. 

Creating an Internal Part 

  The PartDef command (Parts > Define Part) creates an internal part. 
The command displays the Part Selection dialog box. 

 

Part Name 
The name of the part can have up to 31 characters long. In addition to letters 
and numbers, you may use the $, - , and _ characters; do not use any spaces in 
the name! 

Existing Parts 
If the drawing already contains parts, their names are listed in the Existing 
Parts list box. Do not use the name of an existing part, unless you want to 
redefine a part.  

If one of the parts is to be redefined, select the part name from the list. An alert 
box appear, warning that you are about to redefine that part. The message gives 
you the option of choosing a new name or redefining the part. Note: When you 
redefine a part, all insertions of that part are also redefined.  
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The radio buttons allows you to specify how to treat the selected entities after 
the part definition is completed. The three choices are: 

• Delete Defining Objects:  When the PartDef command completes, the 
entities you selected are erased from the drawing (default). 

• Maintain Objects: The entities you selected are not erased from the 
drawing. 

• Replace by Instance: The entities you selected are replaced by the newly 
defined part. 

Usually, after you create a part, the defining entities are not used anymore in 
the drawing. That’s because the purpose of the part is to be inserted in the 
drawing. If you want the defining objects to be removed from the drawing, 
select the Delete Defining Objects radio button (this is the default setting in 
the dialog box.) 

Note: You can restore the defining objects (after they are erased) with the 
Undelete command. 

To leave the defining objects in the current drawing as they are (for example, 
for further modification and subsequent definitions of similar parts with the 
same attribute definitions), select the Maintain Objects radio button. 

If you wish to leave a copy of the block at the current location in the drawing, 
select the Replace by Instance radio button. 

Insertion Point 
Click the OK button to dismiss the dialog box and the PartDef command 
continues in the text window: 

> partdef 
Displays dialog box 
Insertion base point: P1 
Select objects: [pick] 
 1  selected. 
Select objects: [pick] 
 1  selected. 
Select objects: [Enter] 
*** 2  selected. *** 

The part must have an insertion point. The insertion point is a reference that 
enables you to position the part properly during insertion. The insertion point 
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also serves as the basepoint for changing the scale and the rotation angle. You 
can pick anywhere for the insertion point – on or off the part – although users 
typically select the left lower corner, the center of the block, or some other 
discreet point of the geometry. It is a good idea to use object snap options 
functions to ensure precision.  

 

Select Objects 
Finally, you select the entities that will make up this part. The option bar 
furnishes the object selection options.  

An internal part has now been created. You may wish to experiment a bit by 
now attempting to place the part on a drawing with the Insert command.  

Creating an External Part * 

   The PartExp command (Parts > Write Part File) creates a part and 
saves it to a drawing file on disk. Defining an external part is very similar to 
defining an internal part.   

The command displays the Export Part dialog box, which allows you to 
specify the drive, folder, filename, and file format. You can save the part in five 
formats, all of which can be read back into a FelixCAD drawing: 

• FelixCAD drawing .flx 
• AutoCAD R12 drawing .dwg 
• AutoCAD R13 drawing .dwg 
• AutoCAD R14 drawing .dwg 
• DXF drawing .dxf 
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You would only use the AutoCAD formats if the part is to be used with 
compatible software, such as AutoCAD or AutoCAD LT. The DXF format is 
meant for use by other CAD packages. Click Save and FelixCAD displays the 
Export Parts dialog box. An external part can consist of:  

Select: a single entity or a selection set of entities; select the entities using the 
usual object selection methods. You are prompted for the insertion point. 
Part: an existing internal part; select the part name from the Existing Parts 
list. You are not prompted for an insertion point since the part already has its 
insertion point defined. 
All: the entire current drawing. You are not prompted for an insertion point 
since it is assumed to be at 0,0. The entities are not erased from the drawing.  

 

Difference From Save As 
The PartExp command can also be used to save the entire drawing. This is 
similar to the SaveAs command but with one primary difference: PartExp 
purges all unused block references and unused symbol table entries (layer, 
linetypes, text styles, etc.) from the drawing. This is an excellent way of ridding 
the drawing of unreferenced entries and frees it from unnecessary “ballast.” 
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INSERTING PARTS 
Once a part has been defined, you can is insert in the drawing as many times. 
You can think the Insert command as a more efficient form of the Copy 
command. Both commands make copies, but the Copy command makes copies 
of the entities, whereas Insert makes a reference to the block – resulting in a 
smaller drawing file.  
FelixCAD has four commands for inserting parts: 
• Insert command (Parts > Insert Part) displays dialog box. 
• QInsert command (Parts > Insert Quick) operates at the command 

prompt. 
• InsertQ command (Parts > Paste Internal Part 1:1) quickly inserts a part 

by assuming scale = 1 and rotation = 0. 
• Merge command (Parts > Merge External Part 1:1). 

Insert Part   

 The Insert command (Parts > Insert Part)  uses the Insert Part dialog 
box to allow you to specify how the part is inserted.  
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Part Name 
Type the name of the part in the text entry box. If you don’t know the name (or 
can’t be bothered typing), click either the External or Internal buttons. 

External 
The External button displays the Open file dialog box. This lets you select an 
external part. The preview window lets you see what the part looks like before 
you import it. Select any .flx, .dwg, or .dxf file and click Open. 

 

Internal  
The Internal button displays the Part Selection dialog box. This lets you 
select any block stored in the drawing. The preview window lets you see what 
the part looks like before you insert it. Select a block name and click OK.  
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Options 
Insertion At 
Define the Insertion Point by typing the X, Y, and Z coordinate values. If 
Interactive is turned on (the default), you will be prompted for the insertion 
point after you click OK. 

Scale Factor 
The Scale Factor allows you to specify the scale factor before the part is 
inserted. Remember that a scale factor greater than 1.0 increases the size of the 
part, and a factor less than 1.0 reduces the size of the part. If you type a 
negative number the part is mirrored upon insertion.  

If Interactive is turned on (the default is off), you will be prompted for the 
scale factor after you click OK. Dragmode is active during this operation, so 
you will have the benefit of seeing the scale factor result before confirming the 
size. 

Rotation 
The Rotation allows you to specify the rotation angle before the part is 
inserted. For counter-clockwise rotation, enter a positive value, for clockwise 
rotations, enter a negative value between 0 and 360 degrees. 

If Interactive is turned on (the default is off), you will be prompted for the 
rotation after you click OK. Dragmode is active during this operation, so you 
will have the benefit of seeing the rotation result before confirming the angle. 

Default 
The Default button reset all parameters back to the original values: 

• Insertion point: Interactive 
• Scale Factor: 1,1,1 
• Rotation: 0 

Exploded 
The Exploded button causes the part to be exploded into its component entities 
upon insertion. When exploded, the part no longer exists; instead, you get the 
individual entities that made up the part, which allows you to edit them.  
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Quick Insert 
The QInsert command (Parts > Quick Insert) is the command-line version of 
the Insert command. The command prompts you for the part name, insertion 
point, rotation angle, and scale factor in the text window. It does not have the 
explode and interactive options found in the Insert command’s dialog box. 

The QInsert command can be faster since it offers a reduced number of 
options. Also, the command is the best suited for macros and FLISP routines. 
There are, in fact, two versions of the QInsert command: 

1. Select Parts > Quick Insert from the menu. The Part Selection dialog box 
is automatically displayed. All remaining prompts are displayed in the text 
window. 

2. Type QInsert at the command prompt. All prompts are displayed in the 
text window. You can display the Part Selection dialog box by typing ? at 
the “Partname:” prompt. 
> QINSERT 
Partname <part01>: [type part name or press ?] 
Insertion point: 3,3 
X factor <=1>/Corner/XYZ: [Enter] 
Rotation angle <0>: [Enter] 

Partname 
Type the name of the part. For external parts, include the drive and path name, 
as in drive:\folder1\folder2\partname.ext. If you don’t know the name of the 
part, press ? to display the Part Selection dialog box. 

Insertion point 
Enter X, Y coordinates for the insertion point, or pick the point with the cursor. 
The part will be placed using the part’s previously defined insertion point 
(during the PartDef or PartExp commands). 

X Factor 
The “X Factor” prompt is asking you for the scale factor, which you can 
specify in several ways.  

“X factor” asks for the scale factor in the X direction. After entering the scale 
factor, the command prompts you “Y Factor.” Enter the value. In both cases, 
you can press Enter to keep the X factor the same as before, and make the Y 
factor the same as the X factor. 
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Remember that a scale factor greater than 1 will enlarge, less than 1 will 
reduce. A negative scale factor mirrors the part upon insertion. FelixCAD 
provides several alternatives to specifying the scale factor, as seen on the 
option bar: 

X=Y=Z=1 Corner XYZ    

 
X=Y=Z=1 
Th X=Y=Z=1 option sets the scaling factor to 1.0 for all three coordinates. The 
X, Y, and Z scale factors equal 1. This inserts the part at its original size.. 

Corner 
The Corner option lets you pick two points in the drawing to defines the scale. 
Indicate the opposite corners of the rectangular window within which the part 
is to be scaled. Dragmode shows both the window and a preview of the part as 
you specify the two corners.  

XYZ 
The XYZ option lets you specify a different scale factor for each of the three 
coordinates. This enables you to input different scaling factors for parts. The 
scaling factor for the X, Y, and Z-axis are each requested. 

Rotation Angle 
The “Rotation angle:” prompt asks for the angle to rotate the part. The default 
is 0.0. Remember that a counter-clockwise rotation requires a positive value, a 
clockwise rotation requires a negative value between 0 and 360 degrees.  

This angle can also be specified using the cursor to pick the value. Dragmode 
shows a preview of the angle as the cursor moves. 
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PASTE INTERNAL PART 1:1  
The InsertQ command (Parts > Paste Internal Part 1:1) is useful for quickly 
inserting an internal part. The command assumes that the scale factor is 1 and 
the rotation angle is 0. 

> INSERTQ 
Displays Part Selection dialog box. 
Insertion point: P1 

The Part Selection dialog box lets you select an internal or external part. 

At the “Insertion point:”, enter the X, Y coordinates or pick a point in the 
drawing. If you want to change the scale factor or rotation angle, select from 
the option bar:  

Factor Rotation     

 
See the Quick Insert command for a description of these options. 

MERGE EXTERNAL PART 1:1  
The Merge command (Parts > Merge External Part 1:1) is useful for quickly 
inserting an external part. The command assumes that the scale factor is 1 and 
the rotation angle is 0. 

> MERGE 
Displays Part Selection dialog box. 
Insertion point: P1 

The Part Selection dialog box lets you select an internal or external part. 

At the “Insertion point:”, enter the X, Y coordinates or pick a point in the 
drawing. If you want to change the scale factor or rotation angle, select from 
the option bar:  

Factor Rotation     

 
See the Quick Insert command for a description of these options. 
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DINSERT COMMAND 
The DInsert command (short for “discreet insertion”)  incorporates an external 
block into the drawing without creating an instance of the block in the drawing. 
The main of this command is to:  

• Preload parts for later use. 
• Load table definitions defined in a template drawing (layers, linetypes, text 

styles, dimension styles, etc.) 
 

This command is provided for use in macros, FLISP functions, and other 
programming interfaces.  

> dinsert 
Part name: [type external part name] 

The command only requests the filename of the external part. The ? option is 
not available.  
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EXPLODE PARTS  

   The Xplode command (Edit > Explode Complex Objects) allows you 
to explode complex objects, such as parts, into their constituent parts. Parts 
inserted in the drawing constitute a single object. It is not possible to edit any 
of the entities that make up the part. If you need to edit one of the entities 
comprising the part, then the part must be exploded. In addition to exploding 
parts, this command is used to explode polylines, hatching, and dimensions. 

There are, in fact, two versions of the Explode command:  

1. Select Edit > Explode Complex Objects from the menu. The Explode 
Complex Objects dialog box is displayed.  
> xplode 
The Explode Complex Objects dialog box appears. 
Select objects: P1 
 1  selected. 
Select objects: [Enter] 
*** 1  selected. *** 

 
This dialog box allows you to select all objects in the drawing,  

then have only all parts (and/or polylines, etc) exploded. 

2. Type Xplode at the command prompt. No dialog box is displayed. 
> xplode 
Select objects: P1 
 1  selected. 
Select objects: [Enter] 
*** 1  selected. *** 

After selecting the object(s) to explode, press Enter and the parts (or polylines 
or hatches or dimensions) are exploded. You may now choose any of the 
entities for editing.  

Warning: If attributes are attached to the part, they are lost with the explosion. 
The attribute data is converted to the attribute name, as a text entity. 
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THE PART LIBRARY 

  The Library command (Part > Part/Symbol Library) lets you to 
manage parts and drawing files, such as project drawings, template drawings, 
and symbol files.  A library is defined by a .plb file. The drawing files are 
assembled in the same folder (sub-directory) as the part library file is located. 
By default, this is in the \partlib folder but you can use any folder for storing 
the part library. 

Selecting a Part Library 
The Library command displays the Set Current Part Library / Symbol 
Library file dialog box. Select a part library (.plb) file.  

Or enter the PartLib command, which prompts you for the name of a part 
library at the command prompt. This command is meant for use with macros 
and FLISP functions. Enter the name of a .plb file, such as: 

> partlib 
File name: c:\felixcad\partlib\partlibdrawing.plb 

Once a part library has been chosen, the Library command continues to use 
that same library. Use the SetLib (Part > Set Current Library) to change the 
part library. 
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The command displays the dialog box, with a preview image of each part in the 
library. This lets you visually select the part. 

   
The Part Library dialog box in Quick Mode (left) and Extended mode (right). 

 
The dialog box has two display modes:  

• Quick Mode: nine parts at a time are displayed by preview images, with the 
selected part’s name at the bottom. 

• Extended: three parts are displayed at a time, together with the parts’ 
information. 

 
Set Up and Management 

The PLbSetup command (Parts > Part Library Setup) allows you to set up a 
new part library, specify the user interface of the part library dialog box, and 
modify the content of existing part libraries. The command displays the Part 
Library Setup dialog box that:  

• Selects the drawing files to be included in a library. 
• Sets the preferences for part insertions. 
• Sets the parameters for the layout and options of the part library dialog box. 
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The .plb files store the parameters for each part library. Note that the .plb file 
stores only the parameters that define the library; it does not store the part or 
drawing files. The Part Library Setup dialog box does all the work creating 
the .plb file; you don’t need to know the structure or syntax of the part library 
file. 

 

 
Specifying the Drawing Files  

The Part Library Setup dialog box allows you to select the .flx drawing files 
for the library. You are limited to selecting drawing files from a single folder 
(sub-directory). On the other hand, you can have more than one library file in a 
folder.  

Note the part library setup only allows addition or removal of .FLX file 
formats. If you wish to create a part library from existing .DWG or .DXF files, 
covert the files to .FLX format using the batch processing function of 
FelixCAD (see BATPROC command). 

To add drawings to the library, highlight the filenames in Files list, then click 
to the > button to add them to the Library list. The >> buttons adds all files to 
the library.  

The < button removes selected files from Library list, while the << button 
removes all part files. 

When a single file is selected in either list box, the preview window displays an 
image of the drawing.  
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Options 
The Options button displays the Part Library: Dialog Layout Options dialog 
box, which lets you select the user interface options displayed by the Part 
Library dialog box. 

 
 

Title 
The Title edit box requires you to provide a name for the part library dialog 
box. 

Buttons 
The Buttons area lets you decide which buttons you want displayed by the Part 
Library dialog box: 

Open: displays the Open button, which allows you to open the drawing for 
editing. 

Insert: displays the Insert button, which allows you to insert the drawing as a 
part. 

Explode: displays the Explode checkbox, which allows you to explode the 
block upon insertion. 
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Info: displays the Information button, which allows you to view information 
attached to the part. 

Sort By 
The Sort by area determines whether the Part Library dialog box sorts part 
files alphabetically by name (used for part libraries) or by date (used for project 
libraries). 

Preview List Style 
The Preview List Style area determines whether the Part Library dialog box 
should starts up with the single column (Extended) or multi-column (Quick 
Mode) format of displaying the part previews. 

Other Options 
The Set “Explode” mode as default checkbox determines whether the 
Explode checkbox is turned on as the default.  

The Allow Drawing Info Editing check box determines whether you are 
allowed to edit the drawing file information. 

The Enable preview list style switch check box determines whether the Part 
Library dialog box displays the Quick Mode and Extended buttons. 

The Use default info tags check box determines whether the default 
information tags (Project, Name, Drawing No., Draftsman, and Notes) or the 
user-defined info tags are used when drawing information is displayed (see the 
next item). 
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Modify 
The Modify button displays the Part Library: Drawing Info Tags dialog box. 
It allows you specify custom tags for the information fields used by the part. 
Here you can enter information like the manufacturer name, price, and so on. 

 
 
You can change the rotation angle and scale factor of more than one part at a 
time, as follows: 

1. Select one, more than one, or all files in the Library list. 
2. Click the Modify button.  
3. Click Insert parameters activated to turn it on (check mark shows). 
4. Change the value of the rotation angle and/or scale factor. 
5. Click the Apply button.  

The select parts now have the same rotation angle and scale factor. 



Chapter 8   Parts, Attributes, Externally Referenced Drawings, and Groups 

 262 

ATTRIBUTES 
You can attach attributes to parts. Attributes help create more meaningful 
drawings. They aid in materials calculations, creating bills of material, and 
other database-like functions. 

Attributes are text objects that are joined to parts. The attribute text may be 
constant or variable, visible or hidden, a single or multiple attributes.  

An attribute consists three components: 

Name: identifies the attribute. When a part contains more then one attribute, 
the name helps you identify a specific attribute.  

Request: the prompt text, which is displayed when the part is inserted. The 
request reminds the user of the type of data that should be entered. 

Value: the default value of the attribute. The user can accept the value or type 
in another value – except when the attribute has been defined as constant. The 
value can be visible in the drawing, or invisible. 

When an attribute is created, you must specify the following parameters (which 
can be edited later): 

• Insertion point. 
• Font options, such as font name, height, angle, and reference point. 
• Visible or hidden. 
• Constant or variable. 

You may create an attribute and place it in the drawing all by itself. In that 
case, the attribute definition represents an isolated text object. 

More commonly, attributes are linked to parts. In this case, you define the 
attribute before defining the part. In most cases, you place the attribute near or 
on the entities. When you select the entities that make up the part, you also 
select the attribute(s).  

Note that the order in which the attributes are picked will determine the order 
in which they appear when inserting or modifying a part. This is useful in 
creating drawing borders and other families of parts.  
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Define Attribute   

  The AttDef command (Parts > Define Attribute) creates a new attribute 
definition. The command displays the dialog box: 

 

Attribute  
Name 
Provide a name for the attribute. Use as descriptive a name as possible. The 
name can be as long as 31 characters, and may include special characters _ 
(underline) and $ (dollar). In the dialog box above, the name of the attribute is 
“STANDARD”. 

Request 
Type the text of a prompt, which is displayed when the part is inserted. The 
request reminds the user of the type of data that should be entered. (The request 
is not displayed when the attribute is defined as a constant attribute.) In the 
dialog box above, the request is “ANSI Standard:”. 
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Value 
Enter the default value of the attribute. The value can be up to 256 character 
long, including blanks and special characters. The user can accept the value or 
type in another value – except when the attribute has been defined as constant. 
The value is not displayed when the attribute is defined as an invisible attribute.  

Insertion Point 
The insertion point may be defined in either of two ways. One method is to 
type the coordinate values in the X, Y, and Z boxes. The attribute will be 
inserted at that X, Y, Z coordinate.  

The second method is to click the Interactive checkbox to turn it on. This lets 
you define the insertion point via the cursor, after you click the OK button. The 
advantage to the interactive definition is that Dragmode is active, offering you 
a preview of the insertion. 

Options 
The text options define the height, rotation angle, and the font (text style) of the 
attribute text. 

Height 
The height of the text is specified by the Height field. Type the text height in 
drawing units (not in text points) or type 0 (zero) to specify the text height 
later, after you click the OK button. 

Angle 
The Angle field specifies the angle of the attribute text. For an counter-
clockwise rotation enter a positive value, for a clockwise rotation enter a 
negative value, between 0 and 360 degrees. 

Font 
The Font list box lets you select a text style for the attribute text. The style 
must be previously defined by the Font command.  
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Reference Point 
The Reference Point area determines the position and alignment of the 
attribute text in relation to the insertion point. For example, if the reference 
point is TL (top left corner of the text), then the attribute text will run from the 
insertion point to the right, and hanging down from the insertion point. 

There are twelve reference points available. The characters represent the 
initials of the position on the text object. BL, for example, represents Baseline 
Left; UR represents Upper Right. Centered positions are available, as well. 

Alignment 
Align 
When the Align option is active, the Insertion Point, Height, Angle, and 
Reference Point options are grayed out. That’s because the Align option will 
prompt you to pick two points on the drawing; the attribute text is placed 
between the two points. The first point is interpreted as the insertion point; the 
second point sets the angle and the scale factor, which determines the text 
height. 

Fit 
The Fit option also places the attribute test between two points, like the Align 
option. The sole difference is that the Height field remains available. Upon 
insertion, the text height remains fixed, but the text string is expanded or 
compressed as required to fit.   

Center 
The Center option centers the attribute text, vertically and horizontally. Text 
height and rotation angle may be specified as usual. 

Flags 
Invisible 
When Invisible is on, the attribute text is not displayed in the drawing. This is 
useful, since attribute text tends to clutter the drawing. You can change the 
visibility later with the DrawMode command. 
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Constant 
When Constant is on, the attribute’s value cannot be changed. When off, the 
user is prompted by the Request. You can change the value later with the 
AttXEdit command. 

Preselect 
The Preselect option causes the attribute to accept its default value, 
automatically. When Preselect is active, you are not prompted for an attribute 
value (like with the Constant option), but you can still edit the value later with 
the AttValue command.   

Note: To create more than one attribute for a part, simply repeat these steps 
until all attributes are inserted in the drawing near each other. 

Working with Attributes 
Once the attribute is defined, you include it with a part. Then, when the part is 
inserted in the drawing, you need to provide values for the attributes. 

Including Attributes with Parts 
To save a part with attributes, follow the instructions earlier in this chapter for 
creating parts. Here are the steps you need to go through: 

1. Draw the entities that will go to make the part. 

2. Define the attribute(s) with the AttDef command. Insert the attribute(s) 
near the entities. 

3. Start the PartDef command and define the part.  

4. When prompted, select the attributes and the entities making up the part. 

The part, including the selected attributes, is now saved in the drawing.  

A part with attributes can also be saved externally. Follow the same procedure 
with the PartExp command.  

Inserting Parts with Attributes 
When you insert a part that  includes attributes, the procedure is the same as for 
parts without attributes. The Insert command has just one added step: type the 
value of the attribute. (This step only occurs when the attribute does not have 
the constant definition.) I 
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Press Enter to accept the default values, or type another value. If the part 
contains several variable attributes, you are prompted to keep providing values 
for all attributes. Finally, the part is inserted in the specified position. 

Editing Attributes 
There are two ways to edit attributes inserted in the drawing. You may edit: 

• The values of the attributes to change the text; use the AttXEdit command. 

• The properties of the attributes, such as their visibility or their name; use the 
AttEdit command. 

Edit Part Attributes   

 If only the value(s) of the attribute are to be changed (whether constant or 
variable), use the AttXEdit command (Part > Edit Part Attributes).  

> attxedit 
Select part: [pick] 

 The following dialog box appears: 

 

The top line displays the name of the attribute.  

The Name Value list displays the request wording under Name, and the 
current value under Value.  
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Select the attribute value to change. Edit the value in the text entry box at the 
bottom of the dialog box. Make your changes and click OK. 
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Modify Attributes   

 To edit all properties of an attribute (with the exception of constant 
values), use the AttEdit command (Parts > Modify Attributes).  

> attedit 
Select part: [pick] 

Select only one part. If the part does not contain attributes, you are prompted to 
select another part. After the correct part is selected, the dialog box appears: 

 
The editing process is identical to the procedure for creating an attribute with 
the AttDef command, except that the attribute name is displayed (at the top of 
the dialog box) and cannot be changed. The following buttons are new to this 
dialog box: 

 
When a part contains more than one attribute, the dialog box displays only one 
at a time. The << and >> display the previous and next attributes. 

The Layer and Color buttons allow you to change the layer that the attribute 
resides on, and the color of the attribute text.  
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Attribute Utilities 
FelixCAD offers several commands for modifying the text of attributes. . These 
utilities are found in the Modify Attribute Text submenu on the Parts menu. 

Edit Attribute Text Value 
The AttValue command (Parts > Modify Attribute Text > Edit Attribute 
Text Value)  allows you to select a single attribute of a part and change its 
value at the command line. This command is useful for macros and FLISP 
routines. 

> ATTVALUE 
Select attribute of part: P1 
New value for attribute <47>: 48 

Move Attribute Text  
The AttMove command (Parts > Modify Attribute Text > Move Attribute 
Text) allows you to change the position of the text.  

> ATTMOVE 
Select attribute of part: P1 
Target point: P2 

Rotate Attribute Text  
The AtTRot command (Parts > Modify Attribute Text > Rotate Attribute 
Text) allows you to select a single attribute and change the rotation angle of the 
text: 

> ATTROT 
Select attribute of part: P1 
New angle <0>: 90 
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Attributes Display Modes 
The DrawMode command (Draw > Drawing Modes) changes the display of 
attributes, to make them all visible (even if defined invisible) or make them all 
invisible. Notice the Attribute Display Mode section of the dialog box: 

 

The following settings are available: 

Display as defined: All attributes are displayed according to their definition – 
attributes defined as invisible are not displayed. 
All invisible: all attributes are made invisible. 
Display all: all attributes are made visible, even if defined as invisible. 

Select the display option by clicking the radio button. 
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 EXTERNALLY REFERENCED DRAWINGS 
FelixCAD’s externally referenced drawing (or “xref” for short) feature lets you 
see other drawings in the current drawing. The xref drawing can be viewed but 
cannot be edited. Xrefs are useful for: 

• Creating an assembly drawing from different files. 
• Inserting detail drawings. 
• Display a standard title block drawing. 
• Temporarily reference another drawing in the current drawing. 
 
Often, the biggest benefit of using externally referenced drawings is within a 
project. A workgroup creates several drawings and shares details over a 
network. For example, others can reference the electrical drafter’s drawings. 

Another advantage of xrefs is that the external drawing is linked to the current 
drawing, which is more efficient than inserting an entire drawing. In several 
situations, the use of externally referenced drawings is more convenient than 
inserting external parts into the drawing.  

Understanding Dependent Symbols 
When an xref is attached to the current drawing, its symbol tables are loaded 
into the current drawing: layers, linetypes, text styles, dimension styles, and 
block definitions. However, the xref symbols are kept separate via the 
following naming scheme:  

Logical_Xref_Name | Dependent_Symbol_Name 

Notice the vertical bar separating the xref drawing name and the symbol name. 
Here are some examples of layer names, assuming the xref drawing’s name is 
Shaft.Flx: 

SHAFT|CONSTRUCTION 
SHAFT|DETAILS 
SHAFT|DIMENSION 

The name prefix makes it easy to distinguish the dependent layers from the 
layers originally defined in the current drawing. 

When the symbol tables derive from an xref drawing, they are called dependent 
because they depend on the existence of drawing other than the current 
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drawing. Other dependent symbol table entries, like linetypes and blocks, carry 
the same naming convention. 

You cannot redefine nor rename dependent symbols. Dependent blocks cannot 
be inserted; a dependent layer cannot be made the current layer. 

But the dependent symbol conventions allow you to control the visibility, the 
colors, and the linetypes of externally referenced drawings. The Layer dialog 
box displays the names of the dependent layers and you can apply the On/Off, 
Thaw/Freeze, Linetype, and Color options to them.  

Note: To keep the visibility and displayed settings over subsequent sessions, 
make sure to set the system variable VisRetain to 1 (short for “retain 
visibility”). By default, VisRetain is set to a value of 0, which means that 
visibility and display changes made to the dependent layers are not maintained 
when you leave the current drawing. 

XLink Command 
The XLink command allows you to link one or more external drawings to the 
current drawing. A linked (or xref) drawing is treated very similar to a part 
(block) but there is a fundamental difference: an xref does not become a 
permanent part of the current drawing.  

The XLink command (Parts > External References) displays the dialog box. 
Initially, the list box is empty. Click the Attach button to select another drawing 
file to attach. You may select .flx, .dwg, and .dxf files. 

Once one or more drawings are attached, the dialog box displays the following 
information: 

• The logical name assigned to the xref. The logical name is a way of 
identifying drawings that have a filename longer than 31 characters 
(Windows allows filenames up to 255 characters long). 

• The drive, path, filename, and extension of the referenced drawing. 
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Attach 

The Attach option allows you to insert an external drawing as an xref to the 
current drawing. It displays this dialog box: 
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Reference File and Logical Name 
Type the name of the drawing in the File Name field, or click the … button to 
select the drawing from a file dialog box. 

You must type a logical name in the Xref Name field. This can be the same as 
the filename, if it is eight or fewer characters. The logical name must be short 
since it is used at the prefix for the names of dependant symbol names (layer 
names, linetypes, etc.). 

Options  
The other options of the dialog box let you specify preferences for the insertion 
and are identical to those found in the dialog box of the Insert command: 
insertion point, scale factor, and rotation angle, as described earlier in this 
chapter. 

Click OK and the drawing attached. If any of the Interactive check boxes are 
on, you will be prompted for the insertion point, scale factor, and/or rotation 
angle. 

Reload 
The Reload button updates an externally referenced drawing during a current 
drawing session. The reload reflects any modifications made to the external 
file. 

Note: When you attach an xref, it is displayed in its current state. When 
working on a project in a workgroup over a network, it may be necessary to 
update one or more external references from time to time. That’s because 
another person may be editing the drawing at the same time you are using it as 
an xref. After this person saves their work, you need to reload the xref to ensure 
that you are seeing the latest version just saved.  

To reload an xref, select the drawing from the list box and click the Reload 
button. 



Chapter 8   Parts, Attributes, Externally Referenced Drawings, and Groups 

 276 

Path 
Sometimes an externally referenced drawing is moved to another folder (sub-
directory) or is renamed. The Path button allows you to re-establish the link to 
the referenced drawing, to reload a renamed referenced file, or to replace an 
referenced drawing by another file. 

To edit or relocate the path to a previously linked reference drawing, select the 
external reference to be relocated from the list box and click the Path button. 

From now on, the link to the referenced file will be maintained as specified and 
the data of the referenced file will be updated from that source. 

Bind 
In some situations it may be useful to make the externally referenced drawing a 
permanent part of your drawing. For example, you need to send the drawing to 
the client, or the drawing has been finalized and is going to be archived. 
Binding the referenced drawing to the current drawing has the advantage that 
there is no need to gather an assembly of drawings within an archive or mail. 

The Bind button inserts an externally referenced drawing into the current 
drawing. Once you bind an xref, the link is broken; you no longer see any 
modifications made in the original referenced file.  

Bind also incorporates the layers, linetype definitions, text styles, and 
dimension styles into the current drawing. Recall that an xref used the vertical 
bar ( | ) to separate the logical name from the symbol name. With binding, the 
vertical bar is replaced by three characters, $n$, where n is a number that 
increments from 0. For example, the layer name HOUSE|BASEMENT changes 
to HOUSE$0$BASEMENT. The n can range from 0 to 9 as required. 

To bind one or more external references to the current drawing, select an xref 
drawing in the list box click the Bind button. 
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Detach  
When you no longer need an xref drawing, click the Detach button. This also 
removes all dependent layer, linetype, and block references as well. 

 

Note: Although you can erase an externally referenced drawing with the Delete 
command, we recommended you use the Detach, since this also removes the 
block definition from the drawing database. 

Open 
FelixCAD’s Multiple Document Interface allows you to display up to four 
drawings at a time. The XLink’s command’s Open button allows you to 
simultaneously open an externally referenced drawing for editing. This allows 
you to modify the xref, for example, if you have detected discrepancies that 
need to be fixed. 

To open a referenced drawing in another drawing window (viewport), select the 
external reference you want to open from the list box and click to the Open 
button. 

Once you have modified an xref, save the drawing and close it. To display the 
revised external reference in the master drawing, use the XLink command with 
the Reload option. 

Insert 
The Insert button allows you to insert a copy of the xref into the current 
drawing like a part (block). You define the insertion point, the scale factor, and 
the rotation angle. 

The Insert option can serve to reinsert an external reference that has been 
deleted accidentally. 
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XInsert Command  
The XInsert command combines the XLink command with the Attach option 
in a single step. The command is provided for convenience of allowing you to 
attach an external drawing directly to the current drawing. 

 

GROUPING ENTITIES 
Drawing entities can be combined into groups. Groups allows you to 
manipulate all entities within the group in a single operation, such as with the 
Move, Rotate, Mirror, and Scale command. You can think of groups as being 
a named selection set. 

Single entities of a group may still be edited individually, for example to stretch 
one entity. Entities may be removed or added to a group at any time. An object 
may be a member of more than one group. Groups may be contained in other 
groups. Group definitions are stored in a distinct table of the drawing database. 
Groups are maintained in this fashion from one drawing session to the next. 

Parts and Groups 
A part (block) has its own insertion point; a group has none. A part can occur 
many times within the drawing; there is just one occurrence of the group. If a 
block is redefined, all of its instances are updated; groups cannot be treated like 
that.  

Like parts, groups can be copied, although you should use the Insert command 
with parts. A group copied from another group is a separate collection of 
entities. Parts and groups each have a unique name.  
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Note: If an entity (which is member of a group) is included in a part, the entity 
is deleted from the drawing and removed from the group at the time that the 
part is defined.  

GROUP COMMAND 
To group entities, or to manage and manipulate groups, use the Group 
command. The command has the following options: 
 

Create Explode Rename Add Remove Selectable List 

 

Create  
To create a group, first determine a unique name. The name is required for 
identifying the group later. To define a new group, follow these steps: 

1. Start the Group and select the Create option.  
2. Specify a unique group name to a maximum of 31 characters. 
3. If you want, type a description of the group, to a maximum of 64 characters. 
4. Decide whether the group should be selectable or not; the default is Yes. 
5. Select the drawing objects that should belong to the group. 
 
To create a group at the command prompt: 

> group 
Select option (Create, Explode, Rename, Add, Remove, 
Selectable, List): Create 
Group name: windows 
Description: All windows in the house floor plan 
Should the group be selectable (Yes/No) ? y 
Select objects: c 
First corner: P1 
Other corner: P2 
 18  selected. 
Select objects: [Enter] 
*** 18  selected. *** 

Exploding Groups  
Group definitions are removed by the Explode option of the Group command. 
When a group is dissolved, the entry in the group table is deleted in the drawing 
database. The original drawing entities will return to their previous state within 
the drawing. 
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To explode a group, start the Group command with the Explode option. At the 
“Group name:” prompt, type the name of the group to be exploded. 
Note: A single entity may belong to multiple groups, and groups may be parts 
of other groups. In these two cases, the Explode option does not allow you to 
pick an entity within those groups.  

This Explode option is not the same as the Explode command used with parts 
and hatching. 

Renaming Groups 
The name of a group may be changed by the Group command’s Rename 
option. This is often used when anonymous groups (which have names like *A1 
and *A2) are created by the Copy commands exist. FelixCAD automatically 
gives anonymous names to groups created by commands such as Copy, 
Mirror, and Array. 
To rename a group, start the Group command with the Rename option. At the 
“Current group name:” prompt, type the name of the group, such as *A0. At the 
“New group name:” prompt, enter a new name for the group, such as 
HouseWindows. 

Add and Remove Entities 
Two options of the Group command allow you to add and remove entities from 
a group. After a group name is specified, entities belonging to the group are 
highlighted. 

• To add entities to an existing group, pick the entities that are to be added 
(they are not highlighted). 

• To remove entities from an existing group, pick the highlighted entities that 
are to be removed 

 
Note: If all entities are deleted from a group, the group continues to exist as 
long as it has a name. 

Selectable 
When a group is set as selectable that means the group is active and will be 
treated as a group by editing commands. 
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Setting a group as unselectable means you are turning off the group definition 
temporarily so you can apply editing commands to individual entities. You 
switch between selectable and unselectable at any time. 

This option is useful when an entity is in multiple groups and selecting the 
entity would make it difficult to pick the correct group to work with. 

Working with Groups 
Editing commands treat all entities in a group as a single object. Commands 
like Move, Rotate, and Copy act on the entire group. When you select a single 
object at the “Select objects:” prompt, you select all  group entities. 

When you are prompted to select multiple objects, you may choose the Group 
object selection option from the option bar, and enter a group name. This 
selects all of the entities belonging to the group. Groups, therefore, can be 
treated as named selection sets. 

Other modify commands (such as Offset, Lengthen, Intersect, and Trim) 
request a single entity. Anytime you are prompted to select a single entity, the 
group does not matter. These commands modify the geometry of single entity, 
even though the entity belongs to a group. The modified entity remains a 
member of the group.  
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The following table summarizes the editing commands and describes how 
entities that are members of a group will be processed when using each 
command.

Command Comments 

DELETE  Selecting a single entity selects all entities of the group, 
unless you use the SIngle object selection mode.  
When a single entity of a group is deleted, the entity is 
removed from the group definition.  

MOVE 
ROTATE 
SCALE 
FLIP 

Selecting a single entity selects all entities of the group, 
unless you use the SIngle object selection mode.  

MIRROR 
COPY 
ARRAY 

Selecting a single entity selects all entities of the group, 
unless you use the SIngle object selection mode.   
FelixCAD gives anonymous names to copied groups, such as 
*A1 and *A2. 

STRETCH Entities belonging to a group selected with the Crossing or 
Cpolygon object selection modes are stretched. 

TRIM 
EXPAND 

The prompt to “Select cutting edges” or “Boundary edges” 
includes all entities of a group, unless you use the SIngle 
object selection mode.  

OFFSET 
FILLET 
CHAMFER 
LENGTHEN 
INTERSECT 

These commands always prompt you to select a single entity 
to be modified. The group is ignored. Single entities altered by 
these commands remain in the group.  
If new entities originate from these commands, they are not 
included in the group. 

DELPARTIAL 
REJOIN 

When an entity (line, circle, arc or 2D polyline) is broken into 
two or more entities by partial deletion, only one of the entities 
remains in the group.  
When an entity is rejoined, the newly created entity is no 
longer member of a group, even if one or more of the pieces 
were part of a group. 

PARTDEF 
HATCH 
HATCHEDIT 

 

Selecting a single entity selects all entities of the group, 
unless you use the SIngle object selection mode.  

This also applies to the HatchEdit command, when the user 
is prompted to “Select additional objects:” to be included to 
the set of entities for associative hatch editing. 

TEXTEDIT The text entity retains its association with its group after the 
TextEdit command modifies the text. 
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Dimensioning 

This chapter describes how to create dimensions with FelixCAD. Dimensioning 
is a crucial element of most technical drawings, so much so that without an 
exact and standardized method of dimensioning, a drawing may lose its 
practical value. 

For this reason, FelixCAD’s dimensioning commands enable fast, easy, precise, 
and standardized method of dimensioning. 

 

Associative Dimensioning 
Associative dimensioning means that when you change the size of any object, 
the associated dimension automatically updates itself. Associative 
dimensioning causes any dimensioning to be recalculated, and the new 
dimension displayed, as soon as an object has been modified.  

For associative dimensioning to work, it relies on the position and placement of 
measurement points.  

Measurement Points 
The basis of associative dimensioning in FelixCAD is the definition and 
insertion of measurement points (known as defpoints in other CAD software). 
To draw a dimension, FelixCAD registers the coordinates of these 
measurement points and calculates the corresponding distance or angle between 
the points. Using conversion variables, the measurement is scaled to represent a 
dimensional value, which is then inserted in to the drawing. 

FelixCAD automatically places measurement points when you place a 
dimension into the drawing. The small dots are placed at the end of the 
dimension’s extension line (see figure below). Measurement points are placed 
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on layer “DEFPOINTS”. (FelixCAD automatically creates this layer the first 
time you use a dimension command.) 

 
When you change an object (such as stretch it), make sure you include the ends 
of the dimension. 

DIMENSION ELEMENTS 

A dimension commonly consists of the following elements: 

Extension Line

Dimension Line Arrowhead

Measurement Point

Dimension Text

 

1. Dimensioning Text 
The dimension text is usually (but not always) the distance being measured.  

2. Dimension Line with Arrowheads 
Dimension lines connect the points of measurement, or the extension lines to 
those points of measurement. Typically, the dimension text is placed in or near 
the dimension line.  

Dimension lines usually end with arrowheads. These arrowheads can be 
replaced with an oblique or any other symbol acceptable to the drawing. 

3. Extension Lines  
Extension lines extend the point of measurement to the dimensioning lines. 



Chapter 9   Dimensioning 

 286 

For diameter or circumference dimensioning, extension lines start at the 
dimension value and point to the outer edge of the object. 

Alternative Measurement Units 
Alternative units of measurement can be displayed with the dimensioning text. 
This allows the dimension to show two different units of measurement. A 
common example is to show both metric and imperial values. 

Tolerances and Fit  
Tolerances and fit entries can be represented, a requirement in mechanical 
drafting. Appropriate values can be shown in the drawing, alongside the 
dimensioning text. 

Types of Dimensioning 
There are several types of dimension that you can use. Typically, the type of 
dimensioning is dictated by its position in the drawing. FelixCAD has 
accommodated nearly all positions imaginable. 

Linear Dimensions 
Linear dimensioning shows horizontal, vertical, and rotated distances. 
Horizontal and vertical dimensions are the most common in drawings; rotated 
dimensions are used to measure the “true” length of a sloped or angled object. 

Coordinate Dimensions 
Coordinate dimensions represents a distance between a specific point and its 
origin in the coordinate system. The measurement can be made on either the X 
or Y axis. It is often used in surveying and machining drawings. 

Diameter and Radius Dimensions, and Center Mark 
Diameter dimensions are used to measure the diameter of circular objects, such 
as holes and arcs. Radius (or radial) dimensions measure the radius of circular 
objects. The center dimension places several different types of center mark at 
the center of a circular object.  

Angle 
Angle dimensions measure the angle between two objects, or the angle inside a 
single object. 

Baseline and Continuous Dimensions 
Baseline dimensions continues a line are dimension; additional dimensions use 
the same starting point as the first dimension. 
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Continuous dimensions create a chain of dimensions. All dimensions in the 
“chain” are in one row, the first dimension in the row dictating the direction in 
which the chain will be organized (horizontal, vertical, aligned or rotated.) 

DEFINING DIMENSIONS  
You can start dimensioning with FelixCAD in your very first drawing. If your 
drafting discipline, however, has specific dimension standards, you set them 
with the Dimension Type dialog box. This dialog box lets you create a named 
dimension style, which stores all of your dimensioning preferences. 

The DimType  command (Dim > DimensionType) displays the Dimension 
Type dialog box. To create a new dimension style, simply type the name (such 
as ArchProj) in the Type Name text entry box. Then, make changes to the 
dimension parameters by click the buttons, such as General Settings and Line 
and Arrows. 

 

The buttons open additional dialog boxes, in which dimensioning parameters 
are defined. 
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General Settings 
The General Settings button displays the General Settings dialog box. 

Scale 
The Scale enlarges or reduces the size of all dimensioning elements (apart from 
the dimension value itself). It allows the dimensions to be scaled to suit the 
scale of the drawing. 

 

Linear factor 
The Linear factor converts the measured drawing units into a dimension 
figure. The default value is 1. Use this to convert metric to imperial. 

Precision 
The Precision defines the number of decimal places to displayed. See 
“Precision and Units Settings”. 

Dim Layer 
Dim Layer specifies the layer on which the dimensioning values are stored. 
Select the default layer, “DIM”, or enter a new layer name. A check mark 
indicates the layer name will be used automatically for dimensions. 
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Zero Suppression 
The Zero Suppression area specifies whether or not zeroes are displayed 
before or after decimal points, and whether zero feet and zero inches are 
displayed. 

Drag Mode 
The Drag Mode check box determines whether the dimension is ghosted when 
you drag it into place. 

Associative 
The Associative checkbox determines whether dimensions are placed as 
associative or non-associative dimensions. 

Lines and Arrows 
The Lines and Arrows button displays the Lines and Arrows dialog box, 
which controls lines and the nature of the arrowheads. 

 

Lines 
The Lines area determines the characteristics of the extension and dimension 
lines. 

Extension Lines 
The Extension Lines section defines the nature of extension lines. 
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Distance determines space between the object and the point at which the 
extension lines begin. A value of 0 means the lines start directly on the object 
itself. 

Extension dictates how far the extension lines should extend past the 
dimensioning line. 

The Invisible check boxes are used to suppress either the first and/or the 
second extension line.  

Dimension Lines 
The Dimension Lines area defines the spacing and character of the dimension 
lines. 

Increment sets the spacing between successive dimensioning lines that use the 
same extension lines. 

Extension allows you to enter the distance that the extension lines should run 
past the dimensioning lines. (This value is meant for use with the Slash option 
of the arrow type.) 

The Interior Lines and Always Interior Lines check boxes specify whether 
the dimensioning line is allowed to extend past the extension lines. 

Center Mark and Lines 
The Center Mark and Lines area determines the size of the cross mark, which 
indicates the center point of a curve. When zero, no center mark is drawn. 

The Lines check box determines whether extension strokes are added to the 
center mark. 

Arrows 
The Arrows area specifies the type of arrowhead to be used. 

Blocks 
The Size item determines the length of the arrow. The default length is 0.18 
inches. 

Block Name is active when the arrow style selected is User. Separate Blocks 
allows the use of different arrow blocks for each end of the dimension line.  



Chapter 9   Dimensioning 

 291 

Tolerance and Alternative 
The Tolerance and Alternative button displays the Tolerance and 
Alternative dialog box. 

 

Tolerance  
The Tolerance section specifies the tolerance (maximum and minimum values) 
to be displayed with the dimension text. Values for the positive or negative 
tolerance are entered in Values. The String fields allow you to type in a line of 
text that is displayed with the tolerance. 

Alternative Mode 
The Alternative Mode section control second, alternative dimensioning. When 
on, this mode allows dual dimensioning of metric and imperial values.  

The Factor field contains the conversion factor between the two units of 
measurement, such as 25.4 for metric conversion. 

The Decimals field specifies the number of decimal places to be displayed by 
the alternative dimensions. 

Alternative string should contain a description or title of the second unit of 
measurement. 
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DIMENSION TEXT 
The Dimension Text button displays the Dimension Text dialog box. This 
dialog box determine the position and look (size, style, spacing) of the 
dimension text. 

 

Text Position 
The Text Position area is used when you want to force dimension text to a 
specific location. 

Text Always Horizontal 
The Text Always Horizontal options forces dimension text to always be 
horizontal, no matter the angle of the dimension line. 

Vertical Text Position 
The Vertical Text Position options determine the vertical location of the 
dimension text with respect to the dimension line. 

Dim Text Style 
The Dim Text Style option select a text style for the dimension text. The text 
style must be already defined by the Font command. 
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Dim Text 
These fields define the size of the dimension text and the distance separating 
text lines. The Prefix <> Suffix field enables you to type in a character string 
that appears before or after the dimensioning text.  

Note: The < > metacharacter is a placeholder for the dimension text calculated 
by FelixCAD. For example, assuming the dimension is 12, Approx. <> ft. 
entered in this field produce the following dimension text:  

Approx. 12 ft. 

Colors 
The Colors button displays the Colors dialog box. It allows you to assign 
colors to: 

• Dimensioning lines. 
• Extension lines. 
• Dimension text, including the value, alternative dimensions, tolerances, 

limit values, and unit of measurement. 

Clicking the Color button displays the standard Colors dialog box. You may 
choose any of the 255 colors, as well as BYLAYER and BYBLOCK.  
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CREATING DIMENSIONS 
To create dimensions in your drawing, you can select dimension commands 
from: 

• The Dim menu. 
• The Dimensioning palette (toolbox). 
• Detail > Dimensions and the Create Dimensions palette. 
• Typing Dim-related commands, as listed below. 

Dim Command Meaning 

DimA3p Angle 3 point 

DimA4p Angle 4 point 

DimAli Aligned dimension 

DimBas Baseline 
dimensioning 

DimCent Center mark 

DimCon Continuous 
dimensioning 

DimDia Diameter dimension 

DimHor Horizontal 
dimension 

DimLin Linear dimension 
(Combination 
between DimHor 
and DimVer) 

DimOrd X or Y coordinate 
dimension 

DimRad Radius dimension 

DimRot Rotated dimension 

DimSer Serial dimensioning  

DimVer Vertical dimension 
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Horizontal Dimensioning 
Horizontal dimensioning is a form of linear dimensioning that measures the 
distance between two points parallel to the X-axis. 

> DIMHOR 
First Point: P1 
Second Point: P2 
Dimension line positioning: P3 
Dimension text <2.50>: [Enter] 

 

Once you have picked the two points of measurement, FelixCAD asks you to 
pick a position for the dimensioning line.  

The distance between the two points is measured along the X-axis and 
displayed.  

Press the Enter key to verify the calculated value and insert the dimension into 
the drawing. 

(As an alternative, you may dimension a selected object by choosing the Select 
option. You may dimension lines, polylines, circles, and arcs with the Select 
option. Pick the object with the cursor. The start and end points -- or the 
diameter -- of the object are dimensioned automatically.) 

> DIMHOR 
First Point: SELECT  
Select line, polyline, circle, arc: P1 
Dimension line positioning: P2 
Dimension text <2.5000>: [Enter] 
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Vertical Dimensioning 
Vertical dimensioning is a form of linear dimensioning that measures the 
distance between two points parallel to the Y-axis. 

> DIMVER 
1. Point: P1 
2. Point: P2 
Dimension line positioning: P3 
Dimension text <2.50>: [Enter] 

 

Once you have picked the two points of measurement, FelixCAD asks you to 
pick a position for the dimensioning line.  

The distance between the two points is measured along the Y-axis and 
displayed.  

Press the Enter key to verify the calculated value and insert the dimension into 
the drawing. 

(As an alternative, you may dimension a selected object by choosing the Select 
option. You may dimension lines, polylines, circles, and arcs with the Select 
option. Pick the object with the cursor. The start and end points -- or the 
diameter -- of the object are dimensioned automatically.) 

> DIMVER 
1st Point: SELECT  
select line, polyline, circle, arc: P1 
Dimension line positioning: P2 
Dimension text <2.50>: [Enter] 
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Linear Dimensioning 
The DIMLIN command creates horizontal or vertical dimensioning based on 
the position of the dimension line. This command is a combination of both the 
horizontal and vertical orthogonal modes. 

> DIMLIN 
First Point: P1 
Second Point: P2 
Dimension line positioning: P3 
Dimension text <2.50>: [Enter] 

Sample: Pick two points of measurement. FelixCAD asks you to pick a position 
for the dimensioning line. FelixCAD displays a preview of the dimension, 
based on the location of the dimensioning line. 

The distance between the two points is measured along the X-axis for 
horizontal and Y-axis for vertical dimensioning and displayed. Press the Enter 
key to verify the calculated value and insert the dimension into the drawing. 

(As an alternative, you may dimension a selected object by choosing the Select 
option. You may dimension lines, polylines, circles, and arcs with the Select 
option. Pick the object with the cursor. The start and end points -- or the 
diameter -- of the object are dimensioned automatically.) 

> DIMLIN 
First Point: SELECT  
Select line, polyline, circle, arc: P1 
Dimension line positioning: P2 
Dimension text <2.5000>: [Enter] 
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Aligned Dimensioning 
Aligned dimensioning measures the absolute distance between two points, 
regardless of the relative position of the axes. This makes it possible to 
determine the true length of lines and edges that are not precisely horizontal or 
vertical. 

> DIMALI 
1st Point: P1 
2nd Point: P2 
Dimension line positioning: P3 
Dimension text <2.50>: [Enter] 

 

Once you have picked the two points of measurement, FelixCAD asks you to 
pick a position for the dimensioning line.  

The distance between the two points is measured along the two points and 
displayed.  

Press the Enter key to verify the calculated value and insert the dimension into 
the drawing. 

(As an alternative, you may dimension a selected object by choosing the Select 
option. You may dimension lines, polylines, circles, and arcs with the Select 
option. Pick the object with the cursor. The start and end points -- or the 
diameter -- of the object are dimensioned automatically.) 

> DIMALI 
1st Point: SELECT 
select line, polyline, circle, arc: P1 
Dimension line positioning: P2 
Dimension text <2.5000>: [Enter] 
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Rotated Dimensioning 
Rotated dimensioning is another type of linear dimensioning that measures the 
distance between two points at a user-defined angle. This procedure is 
equivalent to looking at an object from a specific angle and establishing the 
visible length from a different viewpoint. 

When dimensioning the distance between two points at an angle, the distance 
calculated for the rotated dimension will always be smaller than the absolute 
dimension measurement. There is one exception: this method always measures 
the exact diameter of a circle. Only the position of the extension lines is 
affected when using rotated dimensioning. 

> DIMROT 
Angle of rotation <0>: 60 
First point: P1 
Second point: P2 
Dimension line positioning: P3 
Dimension text <2.5000>: [Enter] 

 

You are asked to define the angle at which the dimensioning is to appear. This 
angle is related to the axial alignment of the coordinate system. You can type a 
value or use the cursor to point. 
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The figure below shows the angle between the direction of the negative Y-axis 
and the first dimension line as seen in a clockwise direction. The apex of this 
angle is determined by the position of the first point of measurement. 

 

If you define the angle at which the dimensioning is to take place by selecting 
two separate points, then a perpendicular line will be drawn at 90° to the 
extension lines.  

 

After having determined the dimensioning angle, you are prompted to define 
two points of measurement.  
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Once the points of measurement are chosen, you are prompted to define the 
position for the dimensioning line. The distance between the two points is 
displayed at the designated angle orientation. Press the Enter key to accept the 
calculated value. 

(You may also select a specific dimensioning object function from the option 
bar by choosing the Select option. The start and end points of a line, polyline, 
or arc will be interpreted automatically and used for the measurement 
calculation.) 

> DIMROT 
Angle of rotation <0>: 60 
1st Point: SELECT 
Select line, polyline, circle or arc: P1 
Dimension line positioning: P2 
Dimension text <2.5000>: [Enter] 

Continued Dimensioning 
Continued dimensioning is a variation of linear dimensioning that continues an 
existing dimensioning: a second dimension is linked to an existing dimension, 
creating a dimensioning “chain.” (Continuing dimensions can only be created 
when a drawing already contains an existing linear dimension.) 

A continuing dimension always inherits the same properties as the existing 
dimensioning. For this reason, you can only connect dimensioning of the same 
type. For example, a new horizontal dimension can only be added to an existing 
horizontal dimension.  

 

> DIMCON 
Select a dimension: P1 
2nd Point: P2 
Dimension text <2.5000>: [Enter] 
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The command prompts you to select an existing dimension. When selecting the 
dimension, remember to make your selection as close as possible to the point at 
which the dimension is to be continued.  

The continued dimensioning is based on just one point of measurement. The 
starting point for the continued dimension is the end of the dimension closest to 
your pick point. Choose the second point by entering coordinates or by 
selecting with the cursor. We recommend you use object snaps. 

The command displays the calculated dimension. This value can either be 
altered, or confirmed with Enter. You are not asked to position the 
dimensioning line, since this is done automatically by FelixCAD. 

Serial Dimensioning 
Serial dimensioning is similar to continued dimensioning. Whereas only one 
continued dimension can be added to an existing dimension, serial 
dimensioning lets you link as many dimensions as required.  

One dimension must already exist to be used as a basis for the rest. Only 
dimensioning of the same type can be added, since the additional dimensioning 
will inherit the properties of the dimensioning used as the base. 
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You must select the dimensioning that is to act as the basis for the series, taking 
care to place the selection cursor as close as possible to the point at which the 
continuing dimension is to be linked.  

> DIMSER 
Select a dimension: P1 
Series <continuous> [Enter] 
2nd Point: P2 
Dimension text <2.5000>: [Enter] 
Series <continuous>: [Enter] 
2nd Point: P2 
Dimension text <2.5000>: [Enter] 
Series <continuous>: [Esc] 

The dimensioning is based on two points of measurement. The starting point 
for the series dimensioning will be the end point which lies closest to the 
selection point of the base dimension. 

In addition to the Select and End options, which are the same as for continued 
dimension, two other options may be made from the Series Dimensioning 
option bar: Continue and Baseline.  

Continue allows you to link one additional dimension and should be selected 
when creating serial dimensioning. This is the default option. 

Baseline allows you to create baseline dimensioning parallel to the existing 
linear dimensioning. (This is described in the next section.) 

Select the second point by typing in the coordinates or selecting with the 
cursor. Use object snap whenever possible. 

The program displays the calculated dimension. You may change this value or 
confirm it by pressing Enter. You are not asked to position the dimensioning 
line, since it is placed automatically in line with the existing dimensioning. 

The command repeats itself. Terminate the command by pressing the Esc key. 
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Baseline Dimensioning 
Baseline dimensioning adds a second dimension parallel to an existing 
dimensioning line. This allows you to read the cumulative dimension between 
two end points covered by a number of individual dimensions within a chain.  

Baseline Dimensioning assumes that another linear dimension already exists. 
The baseline dimension assumes the same properties as the existing dimension. 

 

DIMBAS 
Select a dimensioning line P1 
2nd Point: P2 
Dimensioning text <20.50>: [Enter] 

Select the starting point of the dimensioning chain, taking care to use the same 
direction as placed during the creation of the original dimension. 

Select the second point to be used for the baseline dimension. Enter the 
coordinates at the keyboard or pick a point with the cursor. Whenever possible, 
use object snap for accuracy.  

The command displays the calculated dimension. This value can either be 
altered, or confirmed with Enter. You are not asked to position the 
dimensioning line since the second dimension is drawn at a preset distance 
from existing dimensioning lines.  
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Ordinate Dimensioning 
Ordinate dimensioning is used to determine the X and Y coordinates of a point 
in the drawing.  

> DIMORD 
Coordinate point: X 
Coordinate point: P1 
Extension length: P2 
Dimensioning text <20.00>: [Enter] 

The X and Y options are displayed on the option bar. Selecting one option to 
specify whether you want the X or Y coordinate value placed. The X-value is 
the default and will be used if the Y option is not selected.  

You are prompted to select the point to be measured. Type in the coordinate 
values, or select with the cursor. If the point is a geometric point on an entity, 
use object snap.  

When the command prompts for “Extension length:”, indicate the extension 
line position. This can be positioned at any alignment and distance from the 
dimensioning line. To help, the command draws a line from the selected 
coordinates to the current cursor position. This illustrates the distance and 
alignment between the two positions. Select the position with the cursor. 

 

Example of coordinate dimensioning X-axis (top) and Y-axis (bottom) 

If the dimension is not placed horizontally or vertically in relation to the 
measurement point, then the extension line is drawn in orthographic mode, and 
not as an angled line. An example of this is shown in the above figure. 

The program displays the calculated coordinate. The value can be confirmed by 
pressing the Enter key, or amended as required. You may type in any alpha-
numeric sequence, thus enabling the point to be labeled as required. 
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If a 0,0 point is referenced on different views of the same part, care should be 
taken to ensure the same 0,0 point is referenced. This is not so much for the 
software (FelixCAD will allow ordinate dimensioning from different reference 
points) as it is for producing accurate part drawings for manufacture.  

Diameter Dimensioning 
Diameter dimensioning is used to indicate the diameter of circles, arcs, and 
other curves. Unlike the horizontal or vertical dimensioning, there is no 
dimension line. Instead, a single extension line shows the diameter of the 
curved object. The diameter symbol is Ø.  

> DIMDIA 
Select circle or arc: P1 
Dimensioning text <24.00>: [Enter] 
Extension length: P2 

The first prompt asks you to select a circle or an arc. You may also select a 
polyline that contains arcs. Select carefully with the cursor: the point you pick 
is where the extension line connects to the object.  

 

We recommend that you use the QUAdrant object snap to precisely select the 
90-degree points on the circle or arc. The CENter object snap selects the 
precise center of the curve. 

The command display the diameter is measured. Confirm by pressing the Enter 
key or edit the text, as required.  

The final prompt asks you to position of the extension line. Select a point at a 
reasonable distance from the object. The alignment of the extension line is 
fixed by the two earlier pick points and cannot be altered. The extension line is 
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drawn straight along an imaginary line that extends from the center of the 
object to the pick point. 

A cross mark (+) is placed at the center of the circle of arc, unless you turn off 
that feature with the DimType command.  

Radius Dimensioning 
Radius dimensioning is the same as diameter dimensioning, except that the 
radius is calculated.  

> DIMRAD 
Select circle or arc: P1 
Dimensioning text <24.00>: [Enter] 
Extension length: P2 

Center Mark 
The center mark is used with curves. It places a mark (+) at the center of a 
diameter or radius. 

> DIMCENT 
Select circle or arc: P1 

The command prompts you to select the circle or arc. You may also select a 
polyline arc.  

If a circle or arc is correctly selected, the center mark appears. If not correctly 
selected, you are asked to select the object again.  

The DimCen system variable allows you to change the size of the center mark. 

Angle Dimensioning 
FelixCAD contains commands for fast and accurate angular dimensioning. 
They are called DimA3P (short for angular 3-point) and DimA4P (angular 4-
point). 
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Angular 3P 
The DimA3P command uses three pick points: one at the apex, and one each 
on the legs of the angle. This command finds both the interior angle and the 
exterior angle.  

> DIMA3P 
Apex: end 
of: P1 
1st Point: P2 
2nd Point: P3 
Position measurement curve: P4 
Dimensioning text <60°>: [Enter] 

When prompted “Apex:” pick the vertex position. We recommend that you use 
INTersection object snap whenever possible. 

Pick a point on each leg of the angle. Specify the location of the dimension arc. 
The dynamic preview assists you in locating the best position. Note: The 
position you select determines whether the interior or exterior angle is 
dimensioned.  

 
After confirmation, the program will display the measured value. Confirm with 
the Enter key, or change as required. 

Angular 4P 
The DimA4P command is very similar to the DimA3P command, except that 
the Angular 4P dimension is based on four points of measurement. These 
points could be the end points of two lines, or the tangent of the end points of 
an arc. Either the interior or the exterior angle can be dimensioned.  

The first two prompts ask for the objects (lines, polylines, arcs, or circles.) 
DIMA4P 
Select line, polyline or arc: P1 
Select line, polyline or arc: P2 
Dimensioning text <60°>: [Enter] 
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MODIFYING DIMENSIONS 
FelixCAD contains commands that allow you to edit dimensions.  The 
commands are found in the Modify section of the Dim menu, as well as under 
Detail > Modify Dimensions.  

Modify Dimensions 
The Modify Dimension palette allows you to move the text on the dimension 
line in a number of ways, each illustrated by an icon. Another icon allows you 
to reach the Dimension detail dialog box, while another icon displays a detail 
editing palette from the main palette.  

Dim Command FUNCTION 

DimUpd  Update dimension. 

DimTRot  Rotate dimensioning text.  

DimTNew  Change dimension text.  

DimTMove  Move dimension text.  

DimTPos Undo repositioning.  

DimObl Modify dimension orientation.  

 
UPDATE DIMENSION 

After changing the dimensioning style, all new dimensions are created with the 
new criteria. The Update Dimension command updates all of the existing 
dimensions so that they comply with the new dimensioning style settings.  

> DIMUPD 
Select Dimension(s): Fence 
First Fence point: P1 
Endpoint of the line: P2 
Endpoint of the line: P3 
[Enter] 
Select Dimension(s): All 
2 Dimensions found 

or 
DIMUPD 
Select Dimensions(s): All 
Select Dimensions(s) [Enter] 
3 Dimensions found! 
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You may update individual, a selection set, or all dimensions contained in the 
drawing at a time. Select the dimensions to be updated, using one of the object 
selection functions found in the option bar. Confirm the selection process by 
pressing Enter.  

The selected dimensions are updated to conform to the new dimension style. 
The command displays the “x dimensions found” notice, telling you how many 
dimensions have been updated.  

CREATING A DIMENSIONING STYLE 
At the beginning of this chapter, we described how to create customized 
dimensions with the DimType command. The Dimension dialog box lets you 
define the size, text font and height, alignment and positioning of the dimension 
text, the look of the arrows and extension lines, as well as other parameters. 
These parameters are called a dimension style or “dimstyle” for short. 

The DimSave command saves the current dimension settings as a named 
dimensioning style. This lets you to store and recall a number of different 
styles. Architectural dimensioning, tolerance dimensioning, or country- and 
language-specific styles are reasons for being able to create, save, and load 
dimstyles. 

Note: dimensioning styles are only stored with the current drawing. To share 
dimstyles with other drawings, you should create the dimstyle in a template 
drawing. Templates are described in Chapter 1 “Getting Started: The Basics of 
Drawing.” 

Saving a DimStyle 
Select Detail > Modify Dimension from the menu. From the palette, select the 
icon representing the Dimension dialog box. Enter the proper settings and 
values from this dialog box. In the first field in this box, give the dimensioning 
template a descriptive name. 

Before entering the name of a dimensioning style, you may list the file names 
which have already been allocated by typing a question mark (?) in the input 
field and pressing Enter. 

Dimensioning style names may be up to 31 characters long, and may consist of 
any alphanumeric input except special symbols. No differentiation is made 
between upper and lower case characters. 
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Confirm the selected name to store the dimensioning style. 

You can list all of the names of all dimension styles, as follows: 

> DIMSAVE 
Name of the dimensioning style: List 
List of dimensioning styles <*>: ar* 
ARCHITECT01 
ARCHITECT02 

Listing the existing dimensioning styles completes the save dimensioning style 
command. Press Enter to restart the command and save the current 
dimensioning settings.  

> DIMSAVE 
Name of the dimensioning style: ARCHITECTURE03 

Restoring a Dimstyle 
The DimRest command allows you to restore a dimstyle.  

The command displays the names of the current dimensioning style. You are 
prompted to choose a dimensioning in the drawing, whose style will be set as 
the current dimstyle.  
 

> dimrest 
Set dimension type by reference dimension. 
Select object: [pick] 

 
Any dimensions were created prior to the definition of the new style can be 
updated with the DimUpd command so that they adhere to the new style 
settings.  
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Hatching 

This chapter discusses the process of hatching an area, a section of a drawing, 
and the cross sectioning of a part. Applying hatching or area fills using 
distinctive patterns increases the clarity and legibility of a drawing. Hatching 
(or cross-hatching) an object adds meaning to the drawing, and helps 
differentiate between materials, areas, or other unique attributes. Many 
disciplines specify norms and specifications that demand the correct use of 
specific hatch markings within a drawing. 

 

The Hatch and BHatch commands (Detail > Hatch and Detail > Boundary 
Hatch) enable you to use pre-defined hatch patterns to fill selected areas of the 
drawing. With the aid of the Cross Hatching dialog box, you select the hatch 
pattern from a list, and view a sample in the preview window. The preview 
function simplifies the creation of new patterns and makes it easy to alter 
existing ones. 

Experienced users can choose to bypass this option completely and use the 
keyboard to input the hatch pattern procedures directly. 
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Associative Character of Hatch Patterns 
A hatch pattern is described as having an associative character when it is 
positioned so that it adjusts to changes in location, size and design of the 
hatched area. 

To use the associative character, the hatch pattern must be attached to objects 
in the drawing. 

Hatch Pattern Definitions 
A hatch pattern is comprised of a pattern of line segments. FelixCAD includes 
a number of typical hatch patterns used by various disciplines. You may choose 
to use other hatch patterns for specialized circumstances.  

Hatch patterns are stored in files with the .pat file extension in the \applic 
folder. 

Hatch Pattern Elements 
Hatch lines 
A hatch pattern can contain a number of diverse line types, such as solid, 
dashed, and dotted:  

 

A variety of lines are used to in a hatch pattern 
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Line Spacing  
The spacing between the lines of a hatch pattern is measured in drawing units. 
The default line spacing is set to one (1.0) drawing unit. Changing the line 
spacing is possible to adjust a pre-defined hatch pattern to suit the proportions 
of any given drawing element.  

 

Hatch patterns with different line spacing. 

Hatching Angle 
The lines of a hatch pattern can be drawn at any angle. Standard hatch patterns 
are often drawn horizontal, vertical, or at 45 degrees, but may be drawn at any 
angle. 

The hatch angle of 0° defines a horizontal line. A positive angle value will 
cause the lines to slant in a counter-clockwise direction. A negative value will 
cause a slant in a clockwise direction. 

 

Hatch pattern drawn at a 0° angle (left) and one at a -45° angle (right) 
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HATCH COMMAND: ADDING HATCH MARKS TO AN OBJECT 

  Select Hatch from the Detail menu, or type the Hatch command at the 
prompt.  

The command prompts you to select an object. The Option Bar contains a list 
of object selection functions. Select the object(s), then terminate object 
selection process by pressing Enter. 

The Hatch command opens the Cross Hatching dialog box, which allows you 
to select a pre-defined hatch pattern, change its parameters, or to create your 
own pattern. In the center of the dialog box, the preview function lets you see 
the effect of your choices.  

 

Select the pattern and confirm your selection with OK. 

If you do not see the hatch pattern you need to use, click the Find button to 
select another hatch .pat file. 

To change the parameters of an existing hatch pattern, alter the Angle and scale 
Factor values, as required. Factor affects the spacing of the hatch lines, 
measured in drawing units. 
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To create a simple, user-defined hatch pattern, click the Standard or Cross 
buttons. This option displays a preview of a standard pattern consisting of 
continuous horizontal lines spaced at a distance of one drawing unit.  

You can change this pattern via the Angle and Factor parameters. The Cross 
button adds lines at right angles to the existing lines. 

The Associative button allows the hatch pattern to update automatically when 
the boundary of the hatch is changed. 

To apply the designed hatch pattern to your drawing, exit the dialog box with 
OK.  

Note: Hatching Open Areas 
You can hatch open areas (not fully closed) . The hatch pattern is only applied 
to the extent of the selected contour line area. The following diagram illustrates 
this procedure. 

 

MODIFY HATCHING  
You can change associative hatch patterns with the HpEdit command (Detail > 
Modify Hatching).   

> HPEDIT 
Select an associative hatch: [pick] 
Select additional elements? <N>: [Enter] 

The command then displays the Cross Hatching dialog box. You can make 
changes to the hatching parameters. 
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Inquiry and Information Programs 

The chapter describes commands that provide you with information about the 
properties of drawing objects, and about the current drawing parameters. 
FelixCAD provides commands for finding the area, circumference, coordinate 
identification, distance, and angles. These information commands are found in 
the Edit menu. The commands covered by this chapter are: 

Command Meaning 

’Id Identify X, Y, Z coordinates. 

’Dist Determine the distance and angle between 
two points. 

Area Report the area and circumference. 

Einfo Display entity information. 

Tables Summarize database table data.  
’ Indicates a transparent command. 

IDENTIFY COORDINATE 

  The Id command (Edit > Identify Coordinate) determines the X, Y, and 
Z coordinates of a point identified on the screen. (Id is short for “Identify.”) 
Since it is a transparent command. ’Id can be used in the middle of another 
command. 

> ‘ID 
Point: P1 
X: 1.27  Y: 4.45  Z: 0.0 

When prompted by the “Point:” prompt, pick the point with the cursor. We 
recommend you use an object snap if the point is geometrically significant, 
such as a corner point, the center of a circle, or the intersection of two lines.  
The X, Y, Z coordinates are displayed in the command line area, as shown in 
the example above. 
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DISTANCE / ANGLE 

  The Dist command (Edit > Distance/Angle) calculates the distance and 
angle between two points. (Dist is short for “Distance.”) Since it is a 
transparent command. ’Dist can be used in the middle of another command.  

The two points you pick may be arbitrary points, or they can be part of a 
drawing object. We recommend you use an object snap if the point is 
geometrically significant, such as a corner point, the center of a circle, or the 
intersection of two lines. 

> ‘DIST 
First point: P1 
Second point: P2 
Distance: 57.45 
Angle in the XY-plane: 45 | Angle from the XY-plane: 10 
Delta X: 40.00 | Delta Y: 40.00 | Delta Z: 10.00 

The command displays the following information: 

• Absolute distance; 
• Distance along the X, Y, and Z-axis. 
• Angle in the XY plane. 
• Angle from the XY-plane. 

 
The Distance is the absolute distance (shortest-line distance) between the two 
points. 

The Angle in the XY-plane measures the angle to the second point starting 
from the X axis. It always displays the lesser-valued angle, no matter what the 
rotation direction. 

The Angle from the XY-plane measures the angle between the first and the 
second point from the XY-plane to the Z-axis. It is assumed that the first point 
lies on the XY-plane. 

The Delta X, Delta Y and Delta Z report the distance between the two points 
in the direction of the respective axis of the coordinate system. All length 
values are given in drawing units. 
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AREA / CIRCUMFERENCE 

  The Area command (Edit > Area / Circumference) finds the area and 
the circumference of one or more drawing objects. For objects that do not have 
an area, the length is displayed instead of the circumference. The command 
also allows you to add and subtract areas from the total area. 

To determine the circumference and the area of one or more objects proceed as 
follows: 

> AREA 
First point: P1 
Next point: P2 
Next point: P3 
Next point: P4 
Next point: [Enter] 
Area: 0.75 | Length: 3.66 
First point: [Enter] 

1. Determining the circumference (or length) and the area of an object is done 
by defining points that describe the geometry of the object. The preferred 
method is to use object snap options to select objects and their boundaries, 
but you can also input the coordinates of the points. 

2. Press Enter at the “Next Point:” prompt to finish specifying the area. 
FelixCAD reports the area and the length. 

3. You can compute another area by selecting more points at the next “First 
point:” prompt, or you can finish the command by pressing Enter. 

 
Object AddArea SubArea   

 
Object Option 
Regular geometric areas (such as circles, arcs, polylines, and rectangles) may 
be selected via the Object option. 

Select the object and confirm the selection by picking OK. The values for the 
circumference and the area appear in the text window. 

> AREA 
First point: Object 
Selection of an entity (circle, arc, polyline): P1 
Area: 0.87 | Circumference: 3.3 
First point: Enter 
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You may continue computing the circumference and area of objects, or 
terminate the command by pressing Enter. 

Add and Subtract Areas 
The Area command allows you to add or subtract areas from the total area. 
Select the first area or pick the points that describe the area geometry. The 
calculated values will be displayed in the text window. 

Select the AddArea option to add an area, or SubArea to subtract an area from 
the total area. 

> AREA 
First point: Object 
Selection of an entity (circle, arc, polyline): P1 
Area: 0.87 | Circumference: 3.3 
First point: AddArea 
(ADD) First point: P1 
Next point: P2 
Next point: P3 
Next point: P4 
Next point: Enter 
Area: 0.75 | Length: 3.66 
Total area: 1.62 
 
(ADD) First point: SubArea 
(SUB) First point: P1 
Next point: P2 
Next point: P3 
Next point: P4 
Next point: Enter 
Area: 0.75 | Length: 3.66 | Total area: 0.87 
 
(SUB) First point: Enter 

The values (circumference or length and area) for the total area are displayed in 
the text window. 

The options bar displays only the options that are not active at the moment. For 
example, when the AddArea option is active, the options bar displays 

Object SubArea    

 
The value calculated for the area is stored in the Area system variable and can 
be retrieved via the FLISP expression (getvar “AREA”) at the command line. 



Chapter 11   Inquiry and Information Programs 

 321 

ENTITY INFO 

  The EInfo command (Edit > Entity Info) lists information about the 
data stored for the selected objects. The Clipboard button copies the data to 
the Clipboard. 

 



Chapter 11   Inquiry and Information Programs 

 322 

DRAWING DATABASE TABLES 

  The Tables command (Edit > Drawing Database Tables) displays 
information about the tables in the .flx file. Tables store information about: 

• Draw and display parameters. 
• Layer. 
• Line types. 
• Fonts (text styles) . 
• Part (block) definitions. 
• Referenced parts (blocks). 
• Dimensioning types. 
• Hatching parameters.  
• Named views. 
• User coordinate systems. 

 

 



Chapter 11   Inquiry and Information Programs 

 323 

Select a table name, then click the Selection Menu button. This displays a 
second dialog box, which lists details about the table you selected. 

 

The figure above shows sample output from the Layer table. The Selection 
Menu button takes you back to the first dialog box. 

The Copy to Clipboard button copies the displayed information to the 
Windows clipboard. 
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Export and Import 

One of the principle features of FelixCAD is its ability to interchange 
information with other CAD and Windows programs. 

FelixCAD allows you to export files in a variety of formats. This allows you to 
edit the drawings using other programs.  

Similarly, FelixCAD can import other drawing and graphical formats. This 
allows you to edit drawings created by other software packages. 

It is of prime importance that data be imported and exported without losing any 
attributes, text information, or any other part of the data, whether graphic or 
non-graphic. 

Import and export command are provided for:  

• Internal and external parts. 
• Attributes. 
• Text entities. 
 
Each of these is explained in this chapter.  

Note: Importing and Exporting a large number of drawings at one time is 
covered under the BATPROC command. 
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SAVE AS: DXF & DWG * 
There are several official and de facto standards for exchange drawings 
between CAD packages. Two of these file formats are known as .DXF 
(drawing interchange format) and .DWG (the AutoCAD native file format). 

If a FelixCAD drawing needs to be exported as a file with the .dwg or .dxf 
extension, it should saved using the SaveAs command (File > Save As).  

After entering the command, the common Windows file dialog box opens and 
allows you to specify the drive, path, sub-directory (or folder) and filename.  

Select the file format from the Save as type list: 

• AutoCAD R12 File (*.dwg)  
• AutoCAD R13 File (*.dwg) 
• AutoCAD R14 (supports 14.01) File (*.dwg) 
• DXF File (*.dxf) 

Match the version number (R12, R13 or R14) with the version of AutoCAD 
receiving the file. For AutoCAD LT, use R12 for LT R1 and R2; use R13 for 
LT 95; use R14 for LT 97 and 98. 

For other CAD programs, it is best to experiment. First, try the R14 option. If 
there are too many errors in the translated drawing, try R13 or R12 options. 

If the software program does not read .dwg files, then use the DXF option. 

OPEN: DXF & DWG 
If a drawing is to be imported in DWG or DXF format, use the Open command 
(File > Open). Then follow these steps:  

1. Select the import format from the Files of type list. 
2. Type the name of the file to be imported, or select the file from the  list, in 

the File name field. (If necessary, enter the exact path of the import file in 
Look In. Remember, if no path is entered, the current folder is used.) 

3. Confirm the selection clicking Open. FelixCAD may prompt you for the 
location of font files it cannot find on its own. 



Chapter 12   Export and Import 

 327 

WMF EXPORT * 
A drawing can be exported in the WMF (Windows metafile) format, which is a 
vector format used mainly to exchange graphics among Windows applications. 
WMF is preferable to BMP format. 

The WmfOut command (Edit > Copy Region to Windows Metafile) exports 
the drawing to a file or to the Windows Clipboard. The command presents the 
following options: 

Window 
Define a window by picking two points in the drawing. 

View 
The entire current view is exported as WMF. 

Extents 
The extents (entire) drawing is exported. 

Finally, you may choose whether the picture should be written into a file or 
copied to the Windows clipboard. 

Note: The objects remain in the clipboard until you copy something else to the 
Clipboard. In FelixCAD, this is done with the CopySelect, BmpOut, 
WmfOut, and other commands, as well as the Cut and Copy commands in 
other Windows applications. 

Exporting a drawing or a part of it as .bmp or .wmf lets you use the drawing in 
presentation programs that create slide shows, such as Microsoft PowerPoint, 
Corel Presentations, or Lotus Freelance Graphics. Such software packages 
allow you to add logos, textual descriptions, special effects, or other artwork to 
create professional slide shows. 
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BITMAP EXPORT * 
A drawing can be exported in the BMP (Windows bitmap) format, which is a 
raster format used mainly to exchange images among Windows applications.  

The BmpOut command (Edit > Copy Region to Bitmap) exports the drawing 
to a file or to the Windows Clipboard. The command presents the following 
options: 

Window 
Define a window by picking two points in the drawing. 

View 
The entire current view is exported as BMP. 

Extents 
The extents (entire) drawing is exported. 

Size 
You are asked to specify the width and height of the bitmap in pixels. Unless 
you have a good reason for changing this value, always accept the default. The 
range is from 10 to 2,000 pixels. 

Finally, you may choose whether the bitmap should be written into a file or 
copied to clipboard of Windows. 

Note: The objects remain in the clipboard until you copy something else to the 
Clipboard. In FelixCAD, this is done with the CopySelect, BmpOut, 
WmfOut, and other commands, as well as the Cut and Copy commands in 
other Windows applications. 

Exporting a drawing or a part of it as .bmp or .wmf lets you use the drawing in 
presentation programs that create slide shows, such as Microsoft PowerPoint, 
Corel Presentations, or Lotus Freelance Graphics. Such software packages 
allow you to add logos, textual descriptions, special effects, or other artwork to 
create professional slide shows. 
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CREATING AND VIEWING SLIDES 
The SldOut (or MSlide) command (Edit > Make Snapshot) lets you save a 
view of the current drawing as a slide. Creating a slide file is like capturing the 
screen of a drawing. You can view the slide later with the VSlide command.  

The extension of slide files is .sld. 

Slide files can be used as an alternative to WMF and BMP files (see the 
WmfOut and BmpOut commands earlier in this chapter). You use slide files 
in icon menus, which are called by the IconMenu command.  

You can collect slide files in image libraries. Image libraries have an extension 
.ilb. Images from image libraries (WMF, BMP, or slides) can be utilized in 
dialog boxes, which are called by an FLISP routine or another application. 
Detailed information on how to use icon menus and display images in dialog 
boxes is found in the Programmer’s Guide. 

Creating a Slide * 
To create a slide file, follow these steps: 

1. Display the view of the drawing that you want to save as a slide file. You 
may need to use the Zoom and Pan commands to precisely position the 
view. 

2. Type the SldOut command. 

3. In the Create File dialog box, specify the location and the name for the 
slide file, and click OK.  

Viewing a Slide 
To view a slide file, follow these steps:  

1. Type the VSlide command. 

2. In the View Slide dialog box, choose the slide you want to view. 

3. Click Open. The slide is then displayed on the screen 

4. Type Redraw to return to your drawing. 

Note: You cannot draw or edit a slide. 
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COPY TO CLIPBOARD 
The CopySelect command (Edit > Copy Selection to Clipboard) copies 
selected objects from the drawing and places them on the Windows Clipboard 
in FelixCAD formats.  

Note: Do not confuse this command with the Copy command found on the 
Modify menu, which make copies of objects in the current drawing. The 
objects selected with CopySelect remain in the Clipboard, ready to be placed in 
this and other FelixCAD drawings.  

Once in the Clipboard, you use the Paste command to paste the objects from 
the Clipboard into another FelixCAD drawing. You cannot paste the contents 
into another Windows application. 

To copy objects from one FelixCAD drawing to another: 

1.   Start the CopySelect command. 

2.   You are prompted for an insertion base point. Select a point or type X,Y 
coordinates. This point is used later during the paste process. We recommend 
that you use 0,0 as the insertion base point. The same coordinates should also 
be entered when you paste the information into the destination drawing. 

> COPYSELECT 
Insertion base point: P1 

3.  Select the objects to be copied to the clipboard. Finish the object selection 
by pressing Enter. 

Select objects: [pick] 
Select objects: [Enter] 

4.   Switch to the other FelixCAD drawing.  

5.   Use the Paste command to paste the object(s) into the drawing. The 
prompts are the same as for the Insert command. 
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PASTE FROM CLIPBOARD 
The Paste command (Edit > Paste Selection from Clipboard) copies objects 
from the Clipboard and inserts them in the current drawing. This command 
only pastes objects in FelixCAD format; it does not work when the Clipboard 
contains other data, such as text or a raster image. 

You copy objects from a drawing to the Clipboard with the CopySelect 
command (as described earlier in this chapter), then paste copies into other 
open drawings. (To copy objects within the current drawing, use the Copy 
command found in the Modify menu.) 

To paste objects from the clipboard into the drawing: 

1. Start the Paste command.  
2. Specify the insertion point. The objects appear in the drawing, highlighted 

and attached to the cursor. Drag the highlighted objects to position them in 
the drawing or type X,Y coordinates. We recommend 0,0. 
> PASTE 
Insertion point: P1 

3. Specify the scale factor for insertion, or press Enter to accept the default. 
Scale factor <1>: [Enter] 

4. Specify the rotation angle for insertion, or press Enter to accept the 
default. 
Rotation angle <0>: [Enter] 

When inserting the objects from the Clipboard you can also specify the scale 
factor and rotation angle before specifying the insertion point. Choose the 
corresponding option from the option bar when prompted for the insertion 
point: 

> PASTE 
Insertion point: Factor 
Scale factor <1>: .5 
Insertion point: Rotation 
Rotation angle <0>: 90 
Insertion point: [Enter] 
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PART FILES 
Parts (or blocks) are usually created and stored in a drawing. You can, 
however, export the parts to .flx files on disk. This lets you create a parts library 
that others in your firm can use. Commands related to parts are found on the 
Parts menu. 

Write Part File * 
The PartExp command (Parts > Write Part File) works identically to the 
PartDef command (discussed in “Parts and Attributes / Groups”) but is used to 
export parts.  

Both commands define entities of a drawing or to define the whole drawing as 
a part. The part names, the insertion point of the part, and the drawing entities 
are entered or selected. 

Import Part 
To import a part, select one of these options from the Part menu: 

Insert Quick 
Merge External Part 
Insert Part 

You find detailed information about the inserting of internal and external parts 
in Chapter 8 “Parts and Attributes / Groups.” 

Export Attributes    

  The AttExp command (Parts > Export Attributes Information) allows 
you to extract attributes for parts and entities, and save these in a text file. The 
file is formatted with the “comma delimited format” (CDF), which is easily 
read by spreadsheet and database programs for further processing. 
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To export attributes, follow these steps: 

1. Start the AttExp command.  
2. Select the objects whose attributes are to be exported. The usual object 

select functions in the Options Bar are available.  
3. Complete the object selection by pressing Enter or the right mouse button. 

Notice the Attribute Export dialog box. 

 
 

4. Those parts that contain attribute values are filtered from the entities 
selected by you. The number of the parts is displayed in the upper area. 
You can search the whole drawing for part by clicking the Find all parts 
button. 

5. Add the attributes to be exported by clicking the Add button. The 
Attributes list shows the attributes which have been selected for export: 
• N: numeric value. 
• C: character string. 
• 16 (or other number): length of the field input for the attribute. For 

numeric values, the number of the decimal digits is also displayed. 
 

To remove attributes from the list, select one or more lines in the list, and 
click Delete. 

6. Next, determine the field type in the Part Properties list. Click the 
Add/Modify button to specify the field length in characters and define the 
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number of the decimal digits for numeric fields. Note that the definition of 
the field type is valid for all selected attributes. 

7. In the Part Properties / Definitions dialog box, you can change the field 
and text delimiter. In a CDF file, commas usually separate the fields, and 
text is usually surrounded by quote marks. 

8. Determine the name of the output file. Click the … button to display the 
file dialog box.   

9. The Display button lets you preview the output. Here you can export the 
attribute data the Windows Clipboard. 

10. The Save Settings check box saves these settings for the next time you 
export attributes. 

11. The OK button exports the attributes to the CDF file. In some cases, you 
may get an error message. These errors are usually due to incorrect 
formatting. 
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Printing and Plotting Drawings & 
Using Layout Mode 

This chapter describes how to output a drawing to a printer or plotter.  

FelixCAD uses the Windows drivers to print or plot. Before FelixCAD can 
print or plot, you must ensure the correct printer or plotter drivers are installed. 
Under Windows, this is usually done automatically when you attach a new 
piece of hardware to the computer. 

The commands described in this chapter are: 

Command Meaning 

Psetup Printer/plotter setup. 

Print Print/plot the drawing. 

TLMode Toggle between model and paper space. 

Viewport Create and control viewports. 
 

So that circles and other curves are plotted at the highest quality, FelixCAD 
temporarily sets the circle resolution to 256 when the current value is lower. 
When higher than 256, FelixCAD uses the value as set in the CircleRes system 
variable. 

Note: For batch file printing and plotting, see the BATPROC command. 
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PRINTER Setup  
The PSetup command (File > Printer Setup) allows you to select the printer 
or plotter in the same that output devices are selected in other Windows 
applications. The PSetup command displays the Print Setup dialog box. 

 
You find detailed instructions regarding the options specific to the 
printer/plotter (as well as installing and connecting the printer or plotter) in the 
Windows User Manual or in the output device’s manual. Only the steps related 
to FelixCAD’s use of the printer/plotter are in this manual.   

Printer 
The Printer area of the Print Setup dialog box specifies the printer (or plotter) 
to be used. Output devices, which are available on your computer system, are 
displayed in the Name list. To see the complete list, click the arrow at the right 
edge. To change the printer, select a different printer name. 

Properties 
The Properties button opens another dialog box, which contain settings 
specific to the selected printer. You will find more information regarding 
options and installation possibilities in the device’s user manual. 

Paper Size 
The size of the paper, as well as the source of the paper, is controlled from the 
Paper area. Select the proper size and feed. 

Orientation 
Select either Portrait or Landscape for the desired paper orientation. 
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PRINT OR PLOT A DRAWING 
The Print command (File > Print) sends the drawing to the printer or plotter. 
First, though, select the extent of the drawing to be printed: 

View Extent Window NView  

 
These options allow you to determine the size and position of the area of the 
drawing to be printed. 

View  
The View option prints the currently visible view in the current window of the 
drawing. Before using this option, you should (1) select the window you want 
plotted; and (2) use the Zoom and Pan commands to position the view. 

Extent 
The Extent option prints all objects in the drawing are covered. Before using 
this option, you should regenerate the drawing with the Regen command. 

Window 
The Window option enables you to determine the print area by selecting a 
window in the drawing. Pick or enter the coordinates of two diagonal opposite 
corner points inside the drawing. 

Named View 
The NView option allows you select a previously saved view from the Named 
View dialog box. Before using this option, you must create named views with 
the View command. Named views are useful, since they are saved with the 
drawing for subsequent print output. 

 

Print Dialog Box  
After defining the size of the print, the Print dialog box appears. This dialog 
box allows you to specify parameters specific to FelixCAD, such as 
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configuration, units, orientation, margins, scale, and color. It also contains a 
preview window. 

The preview window assists you in seeing the effect of changing settings in 
layout and scaling.  

 

 
Printer Configuration  

The Printer Configuration areas lists the name of the printer, the paper size, 
and print resolution (in dpi). Click the Setup button to display the Print Setup 
dialog box (as seen earlier with the PSetup command), which lets you control 
the paper source, paper size, orientation, resolution, and the number of the 
copies. 

The Print Setup dialog box contains only the settings that your output device 
supports. 
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Margins 
The Margins area specifies the edges of the paper that cannot be printed. Enter 
the values for the Left, Right, Top, and Bottom margins. 

Note: All plotters/printers have what are termed as 'hard limits' or margins. 
These limits will not allow printing within certain distances of the paper edges, 
regardless of where the software margins are set. Refer to your printing device 
user guide for details. 

Scale 
Fit 
The Fit option fits the drawing to the margins. This results in a full picture of 
the object in the print area, but is usually not to any standard scale.  

When the Fit option is active, it is not possible to set the options for scaling. 

Scaled 
The Scaled option allows you to define the exact scale of the drawing. Note 
that scaling is only available when the Fit option is off. The setup of the plot 
scale is done in two steps: 

1. Define the size of a drawing unit. Select either mm or inch in the Units 
area. 

2. In the scale fields, enter the scale for mm on paper and Drawing Units.  
 
For example, you are preparing a surveying drawing where: 
• The plan units are mm. 
• The drawing units are meters. 
• The plot scale is 1:250.  
You enter 1 = 0.25 or 1 mm = 0.25 m.  
 
Another example: you are working with an architectural drawing where: 
• The units are imperial. 
• The plan scale is 1 inch = 20 feet. 
You enter 1 = 20.  
 
The print dialog box shown on a previous page shows this example. 

 
You see the effect of setting the scale in the preview window, after you select 
the check mark button to the right of the drawing units. 
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Centered 
The Centered option is related to the Fit option. Because the Fit option does 
not change the aspect ratio of the drawing to the paper, a full picture may only 
be output either to the length or width of the picture but not both.  

 

Position of the printed area before (left) and after (right) turning on Center option. 

Centered results in a centered placement of the print area on the paper in 
relation to the side that could not be fitted to the margins of the page. 

Note: The Centered option is only available when using the Fit to Margins 
option. 

Poster (Tiled) 
The number of pages that will be printed is shown immediately below the 
drawing preview window. Multiple pages will result when you have selected a 
drawing scale that results in a printout larger than the selected page size (minus 
the defined margins). 



Chapter 13   Printing and Plotting / Layout Mode 

 341 

Color, Width 
The Color, Width area is for defining the colors and line widths output to the 
printer. By assigning line widths, you improve the legibility of the drawing. To 
set up colors and line widths, click the Configure button, which displays the 
Configuration Colors / Line Widths dialog box. 

 

To set up line widths, you associate the line widths with color numbers. When 
you created the drawing, every object was assigned a color, or, more 
accurately, a color number (also called the color index). For detailed 
instructions on the definition of colors for layers or for objects, see “Layer and 
Object Properties”. For example, red is color #1. 

Any color can be given a line width in mm or inches. For example, you can 
assign a line width of 0.36mm to color red. This means that all objects colored 
red in the drawing will be plotted 0.36mm wide. The setting of line widths can 
be saved under a configuration name, and then reused by future printing 
operations. 

Use Line Width Settings 
The Use Thickness Settings check box determines whether line widths will be 
used during plotting. 

The Print Colors check box switches the color printing on or off. Of course, 
the output device must have the capability to print in color. Another 
consideration is how the printer/plotter draws colors. Some devices have 
palettes that override the program settings. In these cases, see if there is an 
option for control by 'Software' which will allow FelixCAD to assign the 
correct colors to each pen.  
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The Color / Print Color / Width list box allows you to coordinate colors with 
width, as follows: 

1. To assign a print color to a drawing color, click the Select button in the 
Printed Color area. In the Colors dialog box, select color sample or type its 
color index number. Click OK. 

2. To assign a line width to a drawing color, type a linewidth in the text entry 
box in the Linewidth area. Click the Change button and the width is 
updated. 

Configuration 
You can save the line widths and color configuration by entering a name in the 
Configuration area, then ensuring the Save Configuration check box is on. 

Fill Polygons 
The Fill Polygons check box forces FelixCAD to plot filled polygonal areas. If 
the box is not checked (the default), only the outlines of filled areas are output, 
which can lead to a faster plot. 
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Print Rotation and Offset 
Click the Rotation and Offset button to display the Print: Rotation and 
Offset dialog box. 

The Rotation area allows you to select a plot rotation in increments of 90 
degrees. The drawing is rotated on the sheet by 0, 90, 180, or 270 degrees. 
Rotation is applied clockwise. 

The Offset option moves the plot origin from the lower left corner (0,0) of the 
paper (the normal position) to another location on the paper. This lets you plot 
the drawing in a specific location on the page. Specify the x and y values in 
paper units (either mm or inch, as determined in the prior dialog box). 
 

 

The settings are reflected in the preview of the dialog box in the full-page 
preview 



Chapter 13   Printing and Plotting / Layout Mode 

 344 

LAYOUT MODE  
One of the primary advantages of working with CAD software is that any 
drawing plan can be created in real world units. Most drawings, however, 
eventually need to be printed on paper. Usually this means that the drawing 
needs to be plotted in a (usually) smaller scale.    

For some drawings, you may need to print a drawing that incorporates different 
scales for different parts of the drawing. Examples include:  

• Drawing title blocks. 
• Display different views and regions. 
• Create details of the model. 
• Lay out part lists, legends, annotations, and instructions on the drawing 

sheet. 
 

To serve to solve these tasks in a flexible manner, FelixCAD provides two 
modes to handle a drawing: model mode and layout mode. These modes are 
sometimes known as model space and paper space, or print space. 

The objects are drawn in model space. In paper space, you reproduce the 
model in different views and scales, and annotate the drawing with text. 
How you use layout mode is determined by user and company CAD 
standards. Generally there are two methods applied to their use: 

1) Keep the drawing boarders at 1:1 scale and scale down the views to 
fit or 

2) Make all views in layout mode at 1:1 scale and scale up the drawing 
boarder, text and dimensions to suit. 

It is recommended you choose one method only. 

Note: Layout mode is not always the easiest way of finishing a drawing. If you 
create a pure 2D drawing, often it is easier to insert (on separate layers) title 
blocks, part lists, and details in model space, which are scaled to a larger factor 
to fit to a certain paper size. Some drawings are created easier at true scale. 

When using layout mode, remember that this feature is provided to arrange and 
lay out a job for presentation and paper output.  
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Toggle between Model Mode and Layout Mode 
To switch from model mode to layout mode and vice versa, type the TlMode 
command (File > Layout Mode / Model Space).  

When you switch from model to paper mode the first time, the layout window 
is empty, which represents a blank drawing sheet. A single window replaces the 
tiled viewports of the current drawing (displaying the model in different views). 
The title bar of this window shows the caption [Layout: and the drawing name. 

 

This print space is not blank if your template drawing already contains paper 
space objects (in this case paper space usually contains a company title block). 

The layout mode performs two operations: 

1. Determines the sheet size for printing, particularly by insertion of a title 
block. 

2. Allows the creation of viewports that display individual views of the model. 
 
You can draw in paper space just as you do in model space. All the drawing 
and editing commands are available. Since paper space is designated to lay out 
drawing output, a number of 3D commands are disabled, including: 3DView, 
PlanView, Render, Hide, FHide, Light, LightEdit, SetViewDir, WOpen, 
and QWOpen.  

As described in the following sections, paper space allows you to arrange 
individual 3D views of the model by creating and modifying viewports. 
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Viewport  * 
The Viewport command creates rectangular areas, called viewports, which dis-
play the model in print space. The command controls the view direction and 
display portion of the model in those viewports. The options of this command 
are: 

New ON OFF Layer View   

 
New  
After switching to layout mode for the first time, the first step is to create one 
or more viewports to display one or more views of your model.  

The New option creates these viewports. After specifying two corners of the 
viewport, the entire model is displayed in its current extents and in plan view.  

> VIEWPORT 
First corner: 10,10 
Opposite corner: @45,25 

The second step is to determine the correct zoom ratio to allow the contents of 
this viewport to be displayed at the correct scale when printed on paper. This 
scale is directly related to the size of the title block and the plot scale used to 
plot this drawing. This topic is discussed in greater detail later in this chapter.  
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Modifying the Viewports 
A viewport is more than just another window. It is a drawing entity in its own 
right. It is represented by a rectangle and acts as a container of a certain view of 
the construction. Theoretically, any number of viewports may be created in 
model space. 

You can use editing commands on viewport entities because they are treated as 
drawing objects. You can move a viewport to another position with the Move 
command. You can change the size of a viewport with the Stretch command 
(the view in the viewport is not scaled with the viewport). When you change 
the size of a viewport with the Scale command, the view inside the viewport is 
scaled by the same factor. You can erase viewports from the drawing with the 
Delete command. Viewports may be copied with the Copy command. The 
Rotate, Array, Flip, and Mirror commands also modify the viewport with the 
limitation that the edges of the viewport’s rectangle remain parallel to the X- 
and Y-axis of the paper space. Also, these commands do not rotate or mirror 
the view in the viewport. 

You can use object snap modes and coordinate filters for editing viewports and 
when drawing in paper space. You can only manipulate viewports while in 
paper space.  

Turn Viewports Off and On 
The Viewport command’s On and Off options control the visibility of the 
contents displayed in the viewport. The Off option turns off the visibility of the 
viewport objects: select the viewport frame or pick to an object inside the 
frame. To redisplay the model within a deactivated viewport, choose the On 
option and pick to an edge of the viewport’s rectangle. 

The visibility of the viewport frames themselves is controlled through layers. 
Like any other entity, viewports are located on a layer. We recommended that 
you place viewports on one or two specific layers, such as 
“LM_VIEWPORT_ON” and “LM_VIEWPORT_OFF.” Now you can control 
the visibility of the frames of viewports by turning off or freezing a 
corresponding layer containing viewports. 
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Layer Control of Viewport Contents 
The Viewport command’s Layer option freezes and thaws the layers of the 
contents of viewports. For example, you could use this option to display 3D 
views in certain viewports. Only those objects are visible that are on layers 
with the prefix “3D_*”. Other viewports only display layers containing detailed 
2D objects, which have been placed on layers with the prefix “2D_*”, 
“DETAIL_*”, and “DIM_*”. 

After selecting the Layer option, the Viewport Layer dialog box is displayed. 

 

The Drawing Layer list box contains the names of all layers defined in the 
current drawing. The Frozen Viewport Layer list box contains those layers 
not to be displayed in the currently selected viewport.  

You change the layer visibility by selecting one or more layer names in one  
list, then click the > or < button.  

To freeze or thaw an entire group of layers, you can specify strings with wild 
cards, such as 2D_*, and then click the Filter button. This highlights all layers 
that start with 2D_, as shown in the figure above.  
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View Control in Viewports 
The Viewport command’s View option enlarges a viewport to fit the entire 
window. It also allows you to change the zoom level, 3D viewpoint, and so on. 

> VIEWPORT 
First corner: View 
Select viewport: [pick]  
Switch to viewport view ... 
Viewport control:  

When calling the option View the prompt “Viewport control:” is 
displayed. The following options are at your disposal. 

Zoom Pan Ratio NView 3DView Viewpoint 

 
Zoom 

The Zoom option displays the prompt, “Zoom Scale factor: ”. Once a scaled 
relationship between model and paper space has been established, you should 
manipulate the view within the viewport only via scaled zooming (usually by 
specifying whole numbers) to maintain the scale.  

During the Zoom option, the option bar contains other zoom options: Window, 
Extents, 0.9, 0.1, and Previous. 

Pan 
The Pan option moves the visible portion within a viewport. Two points 
specify the pan direction. The scale of the model is not changed. 

You can also use the pan functions from the control panel: Pan Left, Pan Right, 
Pan Up, Pan Down.  

Viewport control: ’PANLEFT 
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Ratio 
The Ratio option is related to the Zoom command. It allows you to specify the 
scale ration between paper and model space, much like during the Print 
command: 

Viewport control: Ratio 
Info: Height of Viewport: 4.28; Height of model 
representation: 484.95 
Paper Space Units <1>: 1 
Model Space Units <113.33>: 2 

NView 
The NView option display a view that had been saved earlier as a named view 
with the View command in model space. The View option opens a dialog box 
similar to the one displayed by the View command in model space (see Chapter 
3). 

The Show button is useful for save and retrieving named views. This option 
previews the selected view in the drawing before confirmation. 

You can improve your effectiveness of working in layout mode by establishing 
named views in model mode, then use them in the viewports of the paper space. 
This is especially useful when a scaled relationship must be maintained 
between model and print space. (See the Techniques and Tips for Layout Mode 
section later in this chapter for more hints and recommendations.)  

Note:  
When you use the View command in layout mode (not the View option of the 
Viewport command), you can create named views within paper space.  

3DView 
Naturally, you can display the model from different viewpoints in space. The 
3DView option allows you to set individual 3D views for each viewport. You 
can also select a predefined view, such as plan view, front view, or an isometric 
view.  
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The 3DView option displays the same dialog box as invoked by the 3DView 
command in model space (see Chapter 3). 

Note:  
Using the 3DView option zooms the content of the viewport to the model space 
drawing extents. To achieve a scaled relation between paper space and model 
space for isometric or other individual 3D views of the model, we 
recommended that you use named views prepared in model space. 

Transparent Commands 
As mentioned earlier, you can use the transparent commands ’PanLeft, 
’PanRight, ’PanUp, and ’PanDown from the control panel. In fact, you can 
use all transparent commands in layout mode.  

A useful example is the transparent command ’SetViewDir to set a standard 
isometric 3D view within a viewport.  

The transparent command ’Dist allows you to measure the distance between 
two points. 

Tips and Techniques for Layout Mode * 
Create your construction (in model space) in real world units (at scale 1:1). 

Use separate layers for dimensions, hatching, text, etc.  

When managing layers, keep in mind that you might want to have different 
logical views of your model for use later when presenting or plotting your 
drawing with the aid of layout mode. 

At a certain stage of the drawing process, you will find the need to print out the 
drawing to present it to your client or to forward it to the manufacturer. In this 
situation, layout mode can help in many cases: 

1. Switch from model space to paper space with the TlMode command. Notice 
that the title bar now reads Layout: followed by the drawing name. 
 

2. Set the limits to equal to the paper size used for printing, such A-size or ISO 
A0.  
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3. Create a layer for the title block (unless you won’t be needing a title block). 
Make the layer current and insert the title block in paper space at the origin 
(0,0). As an alternative, you can draw a rectangle with the paper size your 
printer uses when printing. 
 

4. Create a layer for the viewports. Make this layer current before you create 
new viewports with the Viewport command. Make sure to use this layer for 
viewports only. We recommended you activate the snap mode with 
applicable units (inch, millimeter, and centimeter) when creating viewports. 
 

5. Once the viewport has been established, set up the scale between model and 
its representation on the drawing sheet. This step sometimes causes 
headaches. Set up the scale for displaying the model by: 
 
a. Position a rectangle on a temporary layer in model space that matches the 
viewport window in paper space at a specific scale. 
 
b. Create named views in model space (with the View command), which can 
be retrieved within the paper space viewports in with the Viewport 
command’s View option. 
 

6. With the scale set up, be sure to avoid uncontrolled zooms in the viewport. 
Confine yourself to the Pan commands and to the ZoomFac command 
(specifying whole numbers). 
 

7. To modify the height or length of a viewport, we recommend that you use 
the Stretch command. The model displayed in the viewport is not scaled 
with this command. It maintains the scaled relation between model space 
and paper space.  
 

 
Keep in mind the Golden Rule: 

• Drawing entities you create in model space can only be edited in model 
space. 

• Drawing objects you create or insert in paper space can only be modified in 
paper space. 
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Visualization: Hidden Lines and Rendering 

Three-dimensional models are created in FelixCAD as a wireframe drawing. 
With the 3DView command, you can view the 3D geometry in predefined 
isometric views, as well as from any 3D view direction. When opening 
additional windows of the current drawing, you can specify independent 3D 
view directions for the new viewport. 

With most view commands, FelixCAD displays all lines that make up the 
wireframe model. To display a more realistic image of your 3D model, you can 
have FelixCAD remove the lines that are hidden from your view (called 
“hidden line removal”), and to creating full-color renderings the 3D model.  

This chapter describes the visualization commands, which are found in the 
View menu: 

Visualization Command Meaning 

Hide Create a new hidden-line drawing in a 
separate window. 

Fhide Perform a fast hidden-line removal. 

Render Render the 3D drawing. 

Rconfig Specify parameters for renderings. 

Light Insert a light to illuminate the rendering. 

LightEdit Edit the light parameters. 

Arender Create an animated rendering. 
 
The FHide and Render commands are based on the OpenGL graphics system 
from Microsoft, which provides high-performance hidden-line removal and 
rendering. 
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HIDDEN LINE DRAWING * 
The Hide command (View > Hidden Lines > Hidden Line Drawing) creates 
a separate .flx drawing file containing the current view with the hidden lines 
removed.  

As an option, lines and edges that are computed as hidden are placed on a 
system-generated layer named “HideLayer” (see figure below). You can turn on 
or off this layer, assign them a dashed linetype or another color. In addition, 
you can remove lines from that special layer and retain those you want to keep 
for demonstration purposes.  

Note that the “3D” hidden-line view is actually a flattened 2D drawing. 

 

3D drawing, showing all lines. Hidden lines on layer HideLayer. Hidden lines removed by Hide. 
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FAST HIDE 
The FHide command (View > Hidden Lines > Fast Hide) creates a hidden 
line view in the current drawing. (This is in contrast to the Hide command, 
which outputs the hidden lines to a new drawing.) This FHide command 
provides you a visual impression of the 3D model from the current viewpoint.  

You can continue to draw in hidden-line display mode, even using object snap 
functions. The hidden-line representation is maintained until a Redraw, Regen, 
Zoom, or Pan command refreshes the drawing window.  

The FHide command is based on the OpenGL system from Microsoft, which 
allows high performance hidden-line removal. 
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RENDER * 
The Render command (View > Render > Render) creates an image of your 
3D drawing, called a rendering. The rendering is a realistic illustration of the 
model. To increase the realism, the rendering can be made to perform smooth 
shading and evaluate the lights set into the drawing.  

You use rendering to visualize and present your 3D geometry, as it would 
appear as if it has been constructed or built. Note that FelixCAD also includes 
an animated rendering function as detailed below this render description.. 

To render the current viewport of a drawing, start the Render command. The 
command prompts you to select where the rendered view should be output to. 

Screen File Clipboard    

• Screen: the rendering is output to the current viewport. 
• File: the rendering is saved to a .bmp (Windows bitmap) file on disk.  
 

 
• Clipboard:  the rendering is copied to the Windows Clipboard in bitmap 

format; it can be pasted into another Windows application with the Ctrl+V 
(Edit > Paste) command. 
 

The rendering is based on the preferences set with the RConfig command. The 
Light command allows you to place lights in the drawing and define their type 
and settings. The LightEdit command is used to modify the settings of light 
sources. 
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RENDER PARAMETERS  
The RConfig command (View > Render > Render Parameters) displays the 
Render Settings dialog box, which lets you control the quality of rendering. 

 
The Defaults button resets the preferences to default values (as shown in the 
illustration above). This is convenient, because a number of settings can 
influence the performance of render computations dramatically.  

The Output to Screen option controls whether the rendered polygons are 
output on the screen (to the front buffer) during computations or are written 
into a display buffer before presenting the rendered image. If this option is not 
checked, the rendered image is not displayed before the entire rendered image 
is computed. 

The Use defined Lights option allows you to activate or deactivate the use of 
light sources. When disabled, the program generates a simple shading of the 3D 
model; otherwise, the inserted lights are used for the rendering. 

The three other options allow expert users who are familiar with advanced 
rendering techniques to save time when careful drawing methods have been 
used during the creation of a 3D model:  

• Polygon Orientation CCW  
• Two-sided Lightning 
• Backface Culling 
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It is recommended to use the default values if you are not familiar with these 
terms.  

The Smooth Colors in Polygons option specifies whether smoothing colors 
are computed upon individual polygon surfaces. Applying an adequate light 
environment allows smooth coloring on individual surfaces. 

The Anti-Aliasing option allows you to control the process of smoothing 
jagged edges caused by aliasing. Aliasing describes certain display effects, like 
the staircase effect seen on diagonal lines displayed in a drawing. Anti-aliasing 
reduces those artifacts. Turn on anti-aliasing for high-quality rendered images.  

To improve the rendering significantly you can choose between 2, 3, 4 or 8 
passes with the anti-aliasing algorithm. Because multiple passes dramatically 
increase the rendering time, anti-aliasing should be applied only for high-
quality image output (usually when rendering to a file). 

 
ANIMATED RENDERING  

The Arender command (View > Animated Rendering) displays a rendering 
of the current drawing in a separate pop-up window.  
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You can rotate the rendering by situating your pointer inside the Arender 
window, and holding down the left mouse button. While the mouse button is 
depressed, the icon will change to a small hand, allowing you to rotate the 
image about the screen. 

Zooming and panning for Arender is accomplished by holding down the right 
mouse button. While depressed, you can slide the pointer up or down to zoom 
and pan the image. 

To auto-rotate (spin) the rendering image, right 
click on the blue command line area and toggle 
the auto-rotate setting.  

LIGHTS * 
The Light command (View > Render > Insert Light) allows you to insert 
lights in the drawing. The lighting environment in a 3D model is set up with 
one of more light sources. When no lights are explicitly present, FelixCAD 
assume ambient light for the light source. 

Light Types  
The render program recognizes four types of light sources: 

• Ambient light.  
• Linear light. 
• Point light. 
• Spot light. 
 
An ambient light is not really a light source. It is an overall light source that 
occurs everywhere equally in the scene. The intensity value of ambient light 
defines an overall value of lightness for the total 3D model. The value increases 
or decreases the lightness of a rendering. 

A linear light radiates light along a line, similar to a fluorescent lamp. It has a 
position, intensity, and a color. It is used to simulate sunlight in the model. 

A point light radiates light in all directions. This is similar to a light bulb or an 
incandescent lamp. It has a position, intensity, and a color. 

A spotlight radiates in a specific direction. It is similar to a stage spotlight. It 
has a position, an intensity, a color, a direction, and a cone angle. 
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Inserting Light Sources 
Ambient light is available in all renderings, but the other sources must be 
placed explicitly in the 3D model. The Light command insert light sources into 
the drawing. 

Although you can insert as many light sources as you want, you can have only 
eight light sources turned on.  

The Light command displays the Light Sources dialog box, which allows you 
to you to define parameters for the light, among them the color and the intensity 
of the light source. 

Lights sources are represented in the drawing as block objects. A light insertion 
is always placed on a layer with the name “RENDER_LIGHTS.”  

Editing Light Parameters  
You modify the settings of an inserted light source later with the LightEdit 
command (View > Render > Edit Light Parameters). This command requests 
you to select a light, represented by a block insertion. Then the Light Sources 
dialog box opens, in which you can alter the current preferences for the chosen 
light.  

Relocating and Removing Light Sources  
To change the location of a light or the lights direction, use the standard modify 
commands Move and Rotate.  

To remove a light source from the drawing, use the Delete command. 
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Light Sources in Detail 
The Light Preferences dialog box is used for all four types of light sources. 
Depending on the light type, some areas of the dialog box may be grayed out 
because those parameters do not apply to the specified light type. The 
following figure shows the properties and intensity values of a point light.  

 

Ambient Light 
Ambient light is not really a light but defines an overall value of lightness for 
the total 3D model. Ambient light surrounds the entire model to be rendered. It 
increases or decreases the lightness of a rendering. With ambient light you can 
avoid the problem of having the entire model rendered too darkly. 

Ambient light has no direction, which means that all surface polygons in the 
drawing are illuminated uniformly by this type of light (independent of the 
view direction). In other words, you can understand it as background lightness.  

Ambient light is not represented by an light block insertion in the drawing, like 
the other light types. For that reason it is not covered by the LIGHT command. 
To modify the value for the intensity of ambient light use the LightEdit 
command with the Ambient option (View > Render > Ambient Light) to 
increase or decrease the lightness of a rendering.  
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The default value for the intensity of ambient light in a new drawing is 20 
percent. Increasing the intensity of ambient light tends to saturate the image and 
give it a washed-out appearance. 

The default color of ambient light is white. 

Ambient light may also be turned off to simulate absolute darkness. This 
corresponds to an intensity of 0%. Only other light sources in the drawing will 
then make drawing objects visible. Turning ambient light off can be utilized to 
generate special effects when rendering the model.  

    
Ambient light turned off. 

 
Distant Light 

Distant light (also called linear or parallel light) radiates light along a line, 
similar to a fluorescent light bulb. In other words, parallel light emits uniform 
parallel light rays in one direction only.  

Commonly, a distant light is used to model sunlight. It has a position, intensity, 
and a color. The intensity of the light, however, does not diminish with 
distance. 

Light rays extend infinitely on either side of the insertion point of this type of 
light source. 
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Point Light  
A point light radiates light rays in all directions from a single point, its 
insertion point in the model. This is similar to an incandescent light bulb. It has 
a position, intensity, and a color. The intensity of a point light diminishes with 
distance.  

You set the manner by which the light attenuates with distance (none, linear, or 
square) and the factor for distance falloff in the Light Attenuation section of 
the dialog box in.  

Spot Light  
Spotlights have light rays emanating in a specific direction. This type of light 
source in a model is similar to a stage spotlight. It has a position, intensity, and 
a color. In addition, the spotlight has a direction and a cone angle. 

You determine the light attenuation (falloff with distance) for spotlights. To 
determine the direction of a spotlight, you are requested to specify the location 
point of the light source and the target point of the spotlight when inserting it 
into the drawing.  

Common Light Settings  
Light source insertions have some settings in common, and some setting 
specific to specific light types. This section describes the in-common settings. 

 

In the Light Name text edit box, you specify a name of a new light source or 
alter the name of an existing named light insertion. Give each light a unique 
name. You refer to the light name with the LightEdit command. 

The setting of Light On determines if the light is evaluated during rendering. 
Turning off a light means that the render program does not use the light to 
illuminate the model. The light settings are retained when turning the light 
status back on. 

Clicking the Color button display the standard Windows Color dialog box, 
allowing you to define a color for the current light source. The default color for 
a new light source is white. Note that dark colors affect the light’s brightness. 



Chapter 14  Visualization: Hidden Lines and Rendering 

 364 

Intensity Components of Emitted Light  
This section of the Light Preferences dialog box allows you to set the intensity 
of the emitted light. Three components of emitted light are specified in this 
section: ambient light factor, diffuse light factor, and specular light factor.  

 

The Ambient Light component is the light that has been scattered so much by 
the environment that its direction is impossible to determine. The light seems to 
come from all directions.  

Diffuse Light comes from one direction. It is brighter if it comes squarely 
down on a surface than if it barely glances off the surface. Once it hits a 
surface, however, it is scattered equally in all directions, so it appears equally 
bright, no matter where the eye is located. Any light coming from a particular 
position or direction probably has a diffuse component. 

Specular Light comes from a particular direction. It tends to bounce off the 
surface in a preferred direction. You can think of specularity as shininess. 

Light Attenuation  
The Light Attenuation section lets you specify distance falloff for point lights 
and spotlights.  

 

First, you determine the manner the light attenuates with distance:  

None: no attenuation is applied for the point light or spot light.   

Linear: linear falloff is applied, which is commonly used for rendering. The 
brightness of the light decreases in inverse proportion to the distance from the 
source. 
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Quadratic: square falloff is more realistic, but takes more rendering time. The 
brightness caused by the light source decreases in inverse proportion to the 
square of the distance. 

Second, if you have chosen linear or square falloff, you can specify an 
Attenuation Factor in the edit box. The default value is 1. Light attenuation at 
a certain location in the model will be: 

• Linear falloff: the inverse of the product of distance and attenuation factor; 
• Square falloff: the inverse of the product of square of the distance and 

attenuation factor. 
 

Specific Spotlight Settings  
The Spot Settings parameters are set only for spotlights: 

 

The Cutoff Angle value specifies the angle for the light cone. That is the angle 
between the line from the location point to the target point (determined during 
insertion) and the cone edge. Valid values lie in the range of 0 through 90. 

The Sharpness value (or spot exponent) determines the attenuation of light 
sharpness from the spotlight’s target line to the edge of the spotlight cone. 
Valid values lie between 0 and 128:  

• Minimum value, 0: a sharp accentuated light cone.  
• Any other value: the brightness is highest at the target line of the spotlight 

and decreases to the edge of the cone (by the exponent specified).  
Maximum value, 128: the smoothest integration of a spotlight into the 
environment.  
 



Chapter 14  Visualization: Hidden Lines and Rendering 

 366 



Chapter 15 Raster Images: Using and Editing  

 367 

Raster Images: Using and Editing 

RASTER PALETTE 

 

 

The View > Raster menu item opens the Raster palette 
(toolbox)  with most of the commands available on it.  

All raster editing and manipulation commands are available for 
RLC (large scanner) format. Only some of the editing 
commands are available for TIF and BMP files as noted in the 
following pages.  

There are conversion programs on the market that may assist 
you in changing from another format to one of these supported 
formats. FelixCAD 4.01 includes a converter for RLC<>BMP 
(monochrome only). 

Note: it is necessary to ensure your windows system is setup to 
view ALL file types otherwise you will not be able to view/locate 
it 

Note: Because inserted raster images do not become integrated in the 
drawing file, it is important to not delete or move the original raster image 
file so the link between the two remains intact.  
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LOAD RASTER FILE (RLOAD) 

  This palette button inserts a scanned or raster image from a file into the 
current drawing. New for FelixCAD 4.01 and higher is the addition of color.tif 
and .bmp file formats. These two formats have been added to the existing .rlc 
format from previous releases.  

The Load Raster File button displays the Select File dialog box to allow you to 
select the raster image you wish to insert into the drawing. Pick the raster file 
type (RLC, TIF, or BMP) from the Files of Type pick list. FelixCAD is 
currently limited to two raster images at one time. 

 

Once you select an image, the following dialog box ask you where to insert the 
image, the scale factor, the color of the image, the DPI (dots per inch), and the 
rotation factor. 
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Once you have entered the information, the raster image appears on the screen. 
You may need to zoom to the extents of the image using the zoom tools on the 
control panel to see the complete image.  

 

 
REMOVE RASTER (RUNLOAD) 

 This Remove Raster button removes the selected image from the drawing. 
If 2 images are currently loaded, the system will prompt for which image to 
delete. 
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PROPERTY SETTINGS OF RASTER FILE (RPROP) 

 The Property Settings of Raster File button brings the following dialog 
box and allows you to change any of the fields. The changes are only done to 
the current image and do not affect the original stored on your computer. 

 

Insertion point: location of the image’s lower-left corner. 

Scale [1:n]: Sets the scale factor to make the raster image larger or smaller.  

DPI: dots per inch, affects the size of the image. 

Rotation: orients the image in reference to the drawing. Positive rotation is 
counterclockwise, negative rotation is clockwise. 

Color: Sets the color the entire image takes on:  

Number Color 
1 Dark red 
2 Green 
3 Gold 
4 Dark blue 
5 Purple 
6 Turquoise 
7 Light gray 
8 Light green 
9 Light blue 
10 Light yellow 
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SAVE RASTER (RSAVE) 

 The Save Raster button allows you to save all of the changes to the image, 
done by the Property Settings Raster File button, back to your hard drive. 

These changes are permanent, so be careful and make sure you have a back up 
of the original raster image before saving the changes.  

TOGGLE RASTER FRAME ON/OFF (RBORDER) 

 The Toggle Raster Frame On/Off button toggles the rectangular frame 
border around the image. The frame is turned off or on. The frames of all raster 
images are affected at the same time. When on, the frame shows the outer edge 
of the image and is in the same color as the image. 

MOVE RASTER (RMOVE)  

 The Move Raster button moves an image in the drawing, as the name 
suggests. If you have more than one raster image in the drawing, you are asked 
to select the one to be moved: 

select raster /<point>/?/Last/#n [#0]:  

The options have the following meaning: 

• <point>: you select the raster image with the cursor. 
• Last: select the last image selected. 
• #0: Type the id number of the image; the first image is #0. 
• ?: displays all numbers to choose from.  

You are then asked for a Base point and a Destination point, just like the 
standard Move command. 
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ROTATE RASTER (RROTATE) 

 The Rotate Raster button lets you rotate RLC and TIF raster images (does 
not support BMP images) to match your vector drawing. The prompt is as 
follows: 

select raster /<point>/?/Last/#n [#0]: 

This allows you to select the correct raster image to rotate, using the same 
options as for the Move Raster command. Next, you are prompted: 

Rotation angle:  

This is the amount of rotation: clockwise is a negative rotation and clockwise is 
a positive rotation. 

MIRROR RASTER 
The Mirror Raster button (RLC only) allows you to mirror image RLC files 
only. You first select the image on screen: 

select raster /<point>/?/Last/#n [#0]:  

After selecting the image, you are asked; 

mirror axis: 

Two options appear on the options bar: Horizontal and Vertical. Pick the one 
you wish to use. After a few seconds, the raster image is rotated and FelixCAD 
displays the Properties dialog box. This lets you specify the properties of the 
mirrored copy. 

The original image is not removed. The mirrored image is displayed according 
to the image properties. 
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RMONT 

 The RMont command (RLC only) lets you copy a portion of, or the whole, 
raster image. You are prompted to place a window around the portion to be 
copied. This is similar to the Zoom Window command. You are prompted for 
the First Corner and then the Second Corner.  

After picking the area to copy, you are asked to confirm the properties of the 
new image. The changes are only for this drawing session, unless you save the 
property changes.  

RCUT 

 The RCut command (RLC only) lets you remove a portion of the raster 
image. You must first draw a closed polyline around the area to be clipped. The 
polyline must be a series of straight-line segments; arcs will be treated as if the 
chord of the arc was the boundary. You must close the polyline.  

You will be prompted to pick the raster image to clip, just as in the move image 
and rotate image commands. 

select raster /<point>/?/Last/#n [#0]:  

Then you are asked to pick the polyline to use for the clipping. Finally, the 
command asks: 

save properties for ‘C:\Image.rlc ?’:  

If you answer no, then the image is simply clipped and that portion falling 
within the polyline boundary is removed from the screen and the properties 
remain unchanged. If you answer yes, the following is displayed; 

properties saved for ‘C:\Image.rlc’. 

and then the image is cut or clipped inside of the polyline and the properties are 
saved for the original raster image. 



Chapter 15 Raster Images: Using and Editing  

 374 

RVECTORS 

 The RVectors command (RLC only) edits the transformation vectors 
required to adjust the raster image to match the vector drawing. The vectors 
you define will be drawn on the layer “RASTER.” You can actually draw the 
vectors before starting this command and it will detect them for you. 

 

Old 
Old is the current starting location of the currently selected transformation 
vector. You can type a new location if you wish or use the < button to visually 
pick a location on the screen. 

New 
New is the current ending location of the currently selected transformation 
vector. You can type in a new location if you wish or use the < button to 
visually pick a location on the screen. 

Select  
The Select button will let you select which vector you are currently editing. 
You pick the vector on screen. 

New  
The New button create a new vector from the coordinates displayed in the Old 
and New fields. It duplicates a vector if you pick this button while old values 
are in the fields above, but you can still manipulate those vectors by using the 
two < buttons to the right of the New and Old coordinates. 
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Delete  
The Delete button deletes the currently selected vector, both from the routine 
and the screen. 

Delete All 
The Delete All button deletes all vectors on the layer “RASTER.” 

Raster Layer Display 
This location displays the number of vectors detected on the layer “RASTER.” 
Do NOT use this layer for anything else or you will confuse the program. 

4-POINT TRANSFORMATION (RTRANS) 
This command performs a simple transformation that stretches the raster image 
to match your vector line work. You are required to enter four vector 
translations in the edit/define transformation vectors menu. Then when you 
select this option the stretching of the raster will be done. Make sure you enter 
exactly four transformation vectors, since this routine will not run with more or 
less than four! Once the transformation is completed you will be prompted for 
the properties to confirm the insertion point color, etc.  

PRINT/PLOT SORTING 
For printers and plotters that can output raster images (such as inkjet, laser, 
electrostatic, and dot matrix), you can control whether you want the vectors 
printed on top of the raster image -- or the other way round. This way you can 
see the vectors on top of the image, if desired. The prompt of the PrintOpt 
command is, as follows: 

print raster before vector or after vector [Before]: 

Valid replies are B for before or A for after. 

Now you can go ahead and plot your diagram as you normally would. The 
raster will now print/plot as you have indicated. 
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The BATPROC Command (Batch Processing) * 

The BATPROC command is a tool for Batch Processing of FelixCAD FLX, 
DXF and DWG files. It has three main functions:  

• Converting files (FLX, DXF and DWG) to Raster Format (WMF or BMP) 

• Converting files (FLX, DXF and DWG) to Vector Format (FLX, DXF and 
DWG) 

• Batch plotting of files (FLX, DXF and DWG) 

These functions can be used alone or in combination (example. batch plotting 
and file conversion).  

All Batch Processing functions are started by adding files for processing to a 
'List' located on the left side of the Batch Plotting and Converting Dialog box. 
The 'Actions' to apply to the 'List' are located at the right side of the Dialog 
box.  
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START BATCH PROCESSING 
You can start the command by simply typing "BATPROC" or by selecting the 
menu item 'Batch Processing' from of FILE menu. Once this is done the 
following dialog box appears at the screen: 

 
 

CREATING AND MODIFYING FILE LIST 
The first step in Batch Processing is creating a 'List' of drawing files to process. 
Located on the left side of the BATPROC dialog box, there are several file 
selection tools that enable you to:  

• Add files from any directory 

• Save a List of files 

• Append a file list to the current list or load a saved file list. 

• Remove files from the current list. 
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Options for Adding Files from a Directory 
The first step is setting the selection options. The two options for file selection 
are displayed as check boxes: 

 Include Subdirectories (click on box to include all subdirectories of the 
chosen directory) 

 Filter: *.FLX, *.DXF, *.DWG  (edit filter list & click on box to select only 
these file types) 

Adding Files from a Directory 
The next step is to select a directory and add all files inside that directory to the 
list. The button to do this is labeled:  <<  Select Directory to Add Files from. 
Once you click on this button, browse through your computer directories 
(networked or local) and choose the directory containing the files you want to 
process. To add files from a different directory, simply repeat the command or 
use the << Append from  button (see List Files below).  

Note: If you have previously selected a directory and saved that list of files, you 
can load a list file instead (see List Files below). 

List Box 
Once the previous two steps have been completed, you will see a list of files 
from which to select individual ones for processing. Select some or all of the 
files by marking them inside of the box. To do this, use the mouse (left click) in 
combination with the <SHIFT> or <CONTROL> Key to get a multiple 
selection. The selected file(s) will be highlighted. This in fact operates in the 
same fashion as all Windows programs for file selection. Note: that if you start 
the processing, all files inside of the list, not only the highlighted files, will be 
used. 

Selection Options 
After selecting or deselecting items of the list box, you can change the 
selections using any of six buttons: 

• All. Clicking this button will select all items from the list. 

• None. Clicking this button will deselect all selected items of the list. In 
result no item in the list will be selected. 
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• Invert. Clicking this button will invert the selection; this means all 
selected items will be de-selected, while all others will be selected. 

• Mark By Pattern Matching. Clicking this button will open a new dialog 
box; there you can select or deselect items by applying one or more 
patterns to the list of drawing files. The following picture shows the dialog 
box: 
  

Patterns Matching Dialog Box 

The meaning of the pattern matching is not the same as DOS/ WIN - 
file names, but the same as the 'wcmatch' function. See the 
"Customization Manual" for more information. 
Here is a short summary of special selection characters: 
*  =  any  sequence  of  characters;   ? = any single character; 
@  =  any single letter; # = any single number; 
. = any non-alphabetical character; ,= separates patterns; 
~ = not the following match (works only at the first position) 
[..] = any character inside  .-. = character in the range 
[~ ] = any character, which is not inside of the brackets 
` = suppresses the special meaning of the following character 

 

• >> Delete selected from the list. Use this button to remove the selected 
items from the list. 

• >> Clear list .Use this button to fully clear the list. Note: This function 
does not delete any file from your file system. 

List Files 
List Files are stored lists of files that can be recalled for later use. There are 
four buttons options for this function: 

• Save >. Once a list of files is composed from the previous steps, this list 
can be saved for future using the button. 

• < Load. After pressing the button, you retrieve a previously saved 'List 
File' which contains a list of drawing files. Repeating the command will 
exchange the current file list with the new one selected. 

• <<Append from. Activating the button will add the contents of a 'List File' 
to the current list. 



Chapter 16 The BATPROC (Batch Process) Command 

 381 

• Append to>>. Activating the button will add the contents of the current list 
of files to a selected 'List File'.  

Note: You can generate a drawing file list using the old DOS-Command dir: 
>  dir *.flx /S /B > C:/TEMP/draw.lst 

List Order 
There are five buttons to help you define the order of processing: 

• Sort. The Sort button will sort the list in alphabetical order. If you apply 
this function, duplicate items will be removed too. 

• Reverse. The Reverse button turns around the order of the items inside of 
the list box. 

• Move up. The Move Up button will move all selected items by one item. 

• Move down. The Move Down button moves all selected items down by 
one step. 

• Move to top. The Move to Top button moves all selected items up to the 
top of the list. 

• Move to end. The Move to End button moves all selected items to the end 
of the list. 

Note that all of these functions for changing the list order, leave the selection 
unchanged. 

INFO/STATE 
This area of the BATPROC dialog box, located in the lower left corner, 
informs you about the process and the results of all list actions. On the first 
line, you can see the current state - i.e. how many files are in the list and how 
many are selected. The second line shows you the progress of the current 
action, and if ready, the result of this action. 

DEFINING THE ACTIONS FOR BATCH PROCESSING 
After composing the list, the actions for all items of the list have to be 
specified. The related fields are placed on the right side of the dialog box. 
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Printing/ Plotting 
The area of the BATPROC dialog box labeled 'Print / Plot' is to 'output' the 
selected files. This output is transferred to either a device (such as a plotter or 
printer) or a raster file (BMP or WMF format). There are six options for this 
function which include the following radio buttons and check boxes: 

• View. Activating this radio button process a file to the current view at the 
time the drawing was last saved. 

• Limits. Activating this radio button means file(s) will be processed at each 
drawing limit(s) or extents. 

• To printer. Activating this check box will send selected files to the 
printer or plotter. 
Note: Before you start the batch printing, it's necessary to select the printer 
and the options for printing. It's highly recommended to open one of the 
drawing files which are be plotted and print this using the set options. 
These options are defaulted for each drawing of the list. 

•  Into BMP-file. Activating this check box will 'plot' the selected files to 
a BMP file (Bitmap). 

•  Into WMF-file. Activating this check box will 'plot' the selected files to 
a WMF file (Windows Metafile) 

•  Overwrite Existing files. Activating this check box will determine if 
existing BMP and WMF files, of the same name, will be overwritten or not. 

Converting Files to Other Vector Formats 
In addition to batch plotting & raster conversion features, the Convert to 
section of the BATPROC dialog box allows you to convert selected files to one 
or more other vector formats (FLX, DXF or DWG). The AutoCAD DWG 
formats will be written for Release 12. Note: For multiple file type conversions 
it's highly recommended to switch off the Overwrite Option, because enabling 
it can destroy the original drawings. 

Conversion Overwrite Options 
It's possible to overwrite existing files in converting files. To do this, activate 
the Overwrite existing drawings check box. Once this option is activated, 
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there are three possible modes of operation, which are chosen by means of 
radio buttons: 

• Not multiple. This radio button prevents overwriting the file, if it has 
already written or if it is inside of the drawing file list, which will follow. 
As an example assume you have the composed a list, which contains both a 
file conv.flx and a file conv.dwg. These files would be converted into both 
the DXF and the DWG format. If the unlimited overwriting was set, the 
first file conv.flx would be open and saved as conv.dxf and as conv.dwg. It 
would overwrite the existing file conv.dwg too. Because this file is also in 
the list, it would be opened again. To prevent such occurrences, it's highly 
recommended that you use the Not Multiple option to prevent overwriting 
of drawing files. The technical background of this option is, that for each 
file that is to be overwritten, another one is checked. If this file has already 
been written by the Batch Process, or if it is part of the remaining list, the 
file won't be overwritten. 

• Not refresh itself. This radio button prevents the file from overwriting 
itself. 

• Always. This radio button allows overwrite each selected file, including 
itself.  

LogFile Options  
The Logfile section of the BATPROC dialog box is located in the lower right 
corner. It has two variables which activate the logfile option and create a name 
for that logfile. 

Create Logfile. Activating this check box allows you to define a logfile, 
which will be written during the batch processing.  

Select… button. You can select a Logfile filename, by using this button. If a 
chosen filename already exists, it will be overwritten. It's useful to leave this 
option activated. 
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Customization: Palette and Resource Manager 

This chapter discusses FelixCAD functions that allow you to customize the 
user interface. The following table contains a summary of the available 
commands found in the File menu: 

Command Function 

PalMan Palette Manager 

Palette Palette  

Menu Menu  

Tablet Load tablet menu  

TabSection Load tablet section  

Macro Execute macro  
 

This chapter gives you an overview of some of the customization possibilities 
with FelixCAD. For complete details, refer to the Customization and 
Programming manual. 

Palette 
A palette (or toolbox) is a collection of buttons that represent a common group 
of commands. You can open up to ten palettes simultaneously, and place them 
anywhere on the screen. 

Palettes allow you to quickly access commands; to execute these commands, 
you need only select the button with the cursor. 

In general, all of the commands found in a given pull-down menu are contained 
in a single palette. FelixCAD, however, includes some palettes in which the 
commands from several pull-down menus are combined for practical reasons. 

Use the Dialog and Menu Editor to create your own palettes, or to customize 
existing palettes for particular tasks. Detailed instruction on this customization 
is contained in the Programmer’s Guide manual. 
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PALETTE MANAGER 
You control the display of palettes with the elect Palette / Desktop Manger. 
Type the PalMan command or select Palette Manager from the File menu. 
The following dialog box opens: 

 

The upper half of the dialog box lists all palettes currently at your disposal. 
This list displays the names of all palette files with the extension .mnp in the 
directory defined during program configuration the menu folder (or sub-
directory). By default, this is the \applic folder. Instructions for this 
configuration are found in the Programmer’s Guide manual. 

To open one or more palettes: 

1.   From the list, select the palette you want displayed.  
2.   Notice the ten buttons, designated Palette 1 through Palette 8. Click one of 
the ten buttons. This assign an identification number (for example, Palette 1) to 
the palette. If there is another palette with the same ID number already open, 
that palette is closed and is replaced by the newly selected palette. 
3.  Click Close. FelixCAD opens the palette.  

To add customized palettes to the Palette Manager, edit the Fcad.Pal file, 
which is located in the \applic folder. The structure of the file is: 
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 Palette description 1 
 palette1.mnp 

 Palette description 2 
 palette2.mnp 

 Palette description 3 
 palette3.mnp 

and so forth. 

The palette description is found in the list shown in the Palette Manager 
dialog box. The line following always names the palette file. You can change or 
delete the entries as you wish. 

COMMANDS FOR PALETTE CONTROL 

Palette 
The Palette command (File > Resource Manager > Palette) opens and places 
a palette on the FelixCAD desktop. The Palette command differs from the 
Palette Manager in that Palette lets you chose the palette from any folder 
(sub-directory). It is not necessary that the palette files be situated in a 
particular directory. 

Palette can only be executed when less then ten palettes are open. When the 
maximum of ten palettes is open, the message “A maximum of ten palettes is 
available!” is displayed and the command stops.  

Every palette opens in its own window. In the title bar of the palette window 
you will find the name of the palette as well as an ID-number. Palettes can be 
moved, rotated, and placed anywhere on the screen. 

PalClose 
The PalClose command removes a palette from the desktop. Specify the Palette 
ID number, such as P1, P2, etc. (you find the number displayed on the title bar 
of the palette) or type the name of the palette, such as Dimension. The 
corresponding palette is closed. 
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MENU 
FelixCAD is designed to work with a variety of pull-down menus. The 
definitions of the pull-down menus are located in files with the extension of 
.mnu. 

You can create your own pull-down menus using the Dialog and Menu Editor 
program. You will find detailed instructions on this procedure in the 
Programmer’s Guide manual.  

To load a pull-down menu follow this procedure: 

1.   Select File > Resource Manager > Pulldown Menu or type the Menu or 
Pulldown commands.  
2.   Select a menu .mnu file from the dialog box. 
3.   Click OK.  
 

DIALOG AND MENU EDITOR * 
With the Dialog and Menu Editor (DME) FelixCAD provides a powerful tool 
for customization. You open the DME with the DlgEdit command (File > 
Resource Manager > Run Dialog and Menu Editor).  

When the file dialog box appears, use the Files of type drop list to specify the 
type of the resource file to be edited: 

 .dlg Dialog file 
 .mnp Palette file 
 .mnu Menu file 

Detailed information on customizing these items and using the DME is 
provided in the Customization and Programming manual. 
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MACROS * 
Using macros automates the execution of a sequence of command. A macro 
minimizes repetitive keystrokes. You create a macro by saving the command 
sequence in a .mcr file, which can be executed as many times as you require.  

The procedure for this is as follows: 

1.   To execute a macro, select File > Resource Manager > Run Macro from 
the menu, or type Macro at the command prompt.  
2.   Select a macro file (extension .mcr) from the file dialog box. 
3.   Confirm the selection by clicking OK. Notice that the macro immediately 
begins to run. 
 
There are further instructions for creating macros in the Programmer’s Guide 
manual.  

Load LISP File * 
The LoadLisp command (File > Resource Manager > Load LISP File) 
allows you to load an FLISP file via a file dialog box. Detailed information on 
the built-in FLISP interpreter is found in the Programmer’s Guide. 

Editor 
The Editor command (File > Resource Manager > Editor) calls the Windows 
Notepad editor, which allows you to edit FLISP files or other resource files 
(such as linetype and hatch pattern files). A file dialog box to specify the file 
type and file name is displayed when invoking the command. 

Display Text-File 
The ListFile command File > Resource Manager > List File) displays a 
specified file in a list box. This allows you to read the resource file without 
editing it. 
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DIGITIZING TABLET * 
FelixCAD supports the use of a digitizing tablet as an input device and for 
cursor control. The tablet lets you enter coordinates for drawing points, as well 
as select commands via icons. Before you can use the tablet, you must load an 
.mnt tablet menu file. This is performed automatically when FelixCAD starts, if 
the tablet configuration had been selected during program configuration. 

The Menu command enables you to change the tablet menu file in the same 
way as described previously for the pull-down menu file. To load a tablet menu 
follow this procedure: 

1.   Select File > Resource Manager > Menu from the menu. You can also 
type the Tablet command. 
2.   Select a tablet menu file from the dialog box. If necessary, change the file 
type to .mnt. 
3.   Confirm the selection by clicking OK. 
 
A tablet can also be loaded by selecting the symbol for program customization. 
In this case you must select a .mnt file. The remainder of the selection is made 
according to the previously described procedure. 

Replace Tablet Menu Section * 
The Replace Tablet Menu Section option enables you to load an individual 
section of the tablet menu, changing the commands and functions of the 
complete menu. 

To do so, enter the TabSection command. There is also a small palette made 
for the tablet configuration. Using the palette manager, load the Tablet Menu 
palette. 

Determine which tablet menu section should be loaded. Identify the desired 
section by its section number. Enter the name of the tablet menu file that 
contains the defined area. 

Replace Tablet Menu Section  
ID (S1...S8) or section name: S1 
File name of the new tablet menu-description: tabmenu1 

The identified area with the commands and functions from the entered file will 
be restored. 
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Configuring a Tablet * 
FelixCAD uses the Windows WinTab standard to interface with digitizing 
tablets. Contact the tablet manufacturer for the necessary Windows device 
driver. When the tablet is working as a standard Windows pointing device, then 
it can be configured for FelixCAD. 

FelixCAD supports the tablet in two modes: digitizing and command entry. 
When set to digitizing mode, you can trace over paper drawings into FelixCAD 
with as much accuracy as your tablet can provide.  

When used in command entry mode, the tablet is used to position the cursor on 
the drawing window, select commands from menus and tool palettes, and 
optionally select commands from menus on the tablet itself. 

The tablet uses a menu file with the extension .mnt. A sample has been 
included with FelixCAD called Template.Mnt. This tablet menu is currently 
empty. The tablet can contain up to eight menu areas. 

Tablet configuration is done using the TabConfig command. This command 
loads a dialog box that is used to define the screen area location on the tablet, 
and the menu locations on the tablet. The number of rows and columns for each 
screen area is defined in the tablet menu file. 

Setting up the tablet areas can be done interactively byt picking the bottom left 
and top right corners of each area, or manually by directly entering the digitizer 
coordinates in the dialog. Most users will prefer to do this interactively.  

Digitizing Existing Drawings * 
To digitize existing drawings, you need to have two defined coordinate 
locations on your drawing. Place your drawing on the tablet and tape it down so 
it cannot move. Enter the DigiConfig command. The program asks for the 
value of two coordinates and then asks you to pick the corresponding location 
on the plan.  

You turn on and off the digitizing function with the DigiOn and DigiOff 
commands. The program has a digitizer palette called the “Digitize Paper 
Drawings” that can make the process easier.  
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Editing Tablet Menus * 
The tablet menu commands are stored in an ASCII file that can be edited using 
any standard text editor, such as the Windows Notepad. (If you edit the file 
with a word processor, such as WordPerfect, make sure that the file is save as 
pure text only. Word processors normally store files in a proprietary binary 
format.) 

To modify a tablet menu file, you need to edit two primary areas of the file: (1) 
the SETTINGS area, which defines the row and column layout of the menu 
areas; and (2) the FIELD area, which defines the commands that are executed 
when you pick with your tablet cursor pick button. 

The SETTINGS Section 
The header looks like this: 

SECTION 
      SETTINGS 
      BEGIN 
         SECTIONIDENT = “Section_1” 
         Columns      = 10 
         Lines        = 10 
      END 
 

The SECTIONIDENT defines the name of this menu section. The Lines and 
Columns define how many rows and columns will be immediately below this 
section. You can have up to eight sections in the menu file. 

The FIELDS Section 
Here is an example of a field line: 

TABLETITEM = “A_01”,{Help Status Bar | Help-Item},[FCMD]^^COMMAND 

The A_01 defines the row and column item. 

The Help Status Bar defines the information that will be displayed when the 
cursor selects the item. 

The Help-Item defines the help item in the help file. 

The [FCMD] identifies that a command is coming and should not be modified. 
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The ^^COMMAND defines the command that will be executed. Normally you 
prefix all commands with the ^^ symbol, which represents the Esc key (twice 
in a row) to cancel any current commands.  

Here is an example of what you might enter if you wa nt to execute the Line 
command: 

TABLETITEM = “A_01”,{Draw Line(s) | LINE},[FCMD]^^LINE 

Note that this structure is very similar to the menu files (.mnu) structure.  

If you need more examples of how commands are executed, you can edit the 
Fcad.Mnu file. Be very careful not to modify the Fcad.Mnu. You should copy 
this file to another location and edit from it there.  
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INDEX 

 
.BAK, 36 
.BMP, 374 
.DWG, 2, 8, 31, 35, 246, 247, 250, 253, 263, 

277, 383 * 
.DXF, 2, 8, 31, 35, 246, 247, 250, 251, 263, 277, 

330, 383 * 
.FLK, 37 
.FLX, 8, 31, 35, 36, 37, 246, 250, 253, 263, 277, 

327, 336, 360, 383 
.FSH, 234–37 
.LIN, 118, 129 
.MCR, 395 
.MNT, 396 
.MNU, 40, 394, 399 
.PAT, 317, 319 
.PDF, 4, 5 
.PLB, 261, 263 
.RLC, 374 
.TIF, 374 

 
3D BOX, 185 * 
3D CONE, 186 * 
3D ELLIPSOID, 186 * 
3D FACE, 89, 136, 174, 177 * 
3D POLYLINE, 132, 141, 173, 182, 184, 206, 

211 * 
3D SPHERE, 186 * 
3D TORUS, 186 * 
3D WEDGE, 185 * 

 
4-POINT-TRANSFORMATION, 381 

 
ADOBE ACROBAT INSTALLATION, 8 
ALIAS. SEE COMMAND ALIAS 
ALL, 73 
ANGLE INPUT (POLAR COORDINATES), 64 
ANIMATED RENDERING, 364 
ARC 

3Point, 147 
Angle, 148 
Append, 150 
Center point, 150 

Direction, 148 
Radius, 150 
Start point / end point, 147 
Start-/end point/center point, 149 

ARC SEGMENTS, 137, 158, 173, 184, 206, 221 
ARRAY, 201, 284, 352 

in rows and columns, 202 
ATTACH, 278. SEE XINSERT. SEE XLINK 
ATTRIBUTES 

creating, 267 
insertion point, 269 
Part definitions with attributes, 271 
text options, 269 

ATTRIBUTES, 1, 53, 132, 192, 223, 245, 247, 
260, 267. SEE COMMAND ATTEDIT. SEE 
COMMAND ATTDEF 
display mode, 136 
Display mode, 275 

AUTOCAD 
drawings. See .DWG and .DXF 

AUTOMATIC BACKUP SETTING, 59 

 
BASEPOINT, 200 
BATCH PROCESSING, 339, 383–89 * 
BEARINGS, 78 
BHATCH. SEE HATCH 
BIND, 280 
BLOCKS. SEE PARTS 
BOUNDARY. SEE PCONTOUR 

edge, 211, 216, 316, 379 
BOX. SEE 3D BOX * 
BPOLY. SEE PCONTOUR 
B-SPLINED CURVE, 230 
BYLAYER, 44, 117, 123, 126, 127, 297 

 
C/C++ LANGUAGE PROGRAMMING 

INTERFACE, 4 * 
CENTER, 46, 62, 66, 80, 86, 87, 90, 133, 142, 

143, 144, 146, 148, 149, 150, 152, 153, 156, 
168, 170, 193, 203, 206, 221, 234, 240, 250, 
270, 290, 294, 310, 322, 345 

CHAIN, 74, 84, 140, 157, 163, 291, 305, 308 
CHANGE 

attributes, 272 
dimension, 313 
object properties, 129 
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polyline, 225 
text, 243 

CHANGE, 221–24. ALSO SEE ATTEDIT, 
POLYEDIT, PROPEDIT, TEXTEDIT 

CIRCLE, 49, 50, 74, 87, 91, 93, 132, 137, 152, 
202, 207, 218, 222, 246, 299, 310, 311, 323, 
339 

CIRCLE. SEE COMMAND CIRCLE 
Diameter, 145 
Radius, 144 
Tangent, 145 
Three points on circumference, 143 

CLIPBOARD, 326, 328, 331, 332, 334, 335, 
338, 362 

CLIPPING RASTER IMAGE, 379 
CLOSING A DRAWING, 35 
COLOR OF LAYER, 117 
COMMAND 2DFACE, 165 
COMMAND 3DBOX, 185 * 
COMMAND 3DCONE, 186 * 
COMMAND 3DELLIPS, 186 * 
COMMAND 3DFACE, 174 * 
COMMAND 3DSPHER, 186 * 
COMMAND 3DTORUS, 186 * 
COMMAND 3DWEDGE, 185 * 
COMMAND ALIAS, 49, 61 
COMMAND ARC, 146 
COMMAND ARENDER, 364 
COMMAND ARRAY, 201 
COMMAND ATTEDIT, 272, 273 
COMMAND ATTXEDIT, 272 
COMMAND BATPROC, 383 * 
COMMAND CHAIN, 157 
COMMAND CHANGE, 221 

attributes, 273 
COMMAND CIRCLE, 142 
COMMAND CLOSE, 35 
COMMAND CONFIG, 59 
COMMAND COPY, 192 
COMMAND COPYPROP, 131 
COMMAND DELETE, 53 
COMMAND DELPARTIAL, 218 
COMMAND DESKCONF, 57 
COMMAND DIGICONFIG, 397 * 
COMMAND DIGIOFF, 397 * 
COMMAND DIMA3P, 312 
COMMAND DIMA4P, 312 
COMMAND DIMBAS, 308 
COMMAND DIMCEN, 311 
COMMAND DIMCON, 305 
COMMAND DIMHOR, 299 
COMMAND DIMLIN, 301 

COMMAND DIMOBL, 313 
COMMAND DIMORD, 309 
COMMAND DIMSAVE, 314 
COMMAND DIMSER, 306 
COMMAND DIMTMOVE, 313 
COMMAND DIMTNEW, 313 
COMMAND DIMTPOS, 313 
COMMAND DIMTROT, 313 
COMMAND DIMTYPE, 291 
COMMAND DIMUPD, 314 
COMMAND DIST, 323 
COMMAND DPAN, 106 
COMMAND DRAWMODE, 135 
COMMAND DZOOM, 106 
COMMAND EINFO, 326 
COMMAND EXPAND, 211 
COMMAND FHIDE, 361 
COMMAND FILLET, 212 
COMMAND GROUP, 283 
COMMAND HIDE, 360 * 
COMMAND HPEDIT, 320 
COMMAND ID, 322, 323 
COMMAND INSERT, 246, 252 
COMMAND INSERTQ, 257, 258 
COMMAND INTERSECT, 215 
COMMAND LAYER, 121 
COMMAND LAYREF, 128 
COMMAND LENGTHEN, 216 
COMMAND LIBRARY, 261 
COMMAND LIGHT, 365 * 
COMMAND LINE, 138 
COMMAND LINE, THE, 41, 57 
COMMAND LINETYPE, 119, 134 
COMMAND MACRO, 395 * 
COMMAND MOVE, 190 
COMMAND NGON, 152 
COMMAND OFFSET, 206 
COMMAND OSNAP, 86 
COMMAND PALETTE, 393 
COMMAND PALMAN, 58 
COMMAND PAN, 104 
COMMAND PARTDEF, 248 
COMMAND PARTEXP, 247, 250 * 
COMMAND PARTLIB, 261 
COMMAND PASTE, 335 
COMMAND PCONTOUR, 163 
COMMAND PLANVIEW, 99 
COMMAND POINT, 169 
COMMAND POLY3D, 173 
COMMAND PRECPAR, 81 
COMMAND PRINT, 341 
COMMAND PROPEDIT, 129 
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COMMAND PROPLAYER, 131 
COMMAND PSETUP, 340 
COMMAND PURGE, 54 
COMMAND QWOPEN, 100 
COMMAND RECTANGLE, 151 
COMMAND REDO, 53 
COMMAND REJOIN, 221 
COMMAND RENAME, 54 
COMMAND RENDER, 362 * 
COMMAND RING, 168 
COMMAND ROTATE, 193 
COMMAND RTEXT, 242 
COMMAND SAVE, 36 
COMMAND SAVEALL, 36 
COMMAND SETLAYER, 126 
COMMAND SETLIB, 261 
COMMAND SETTINGS, 79 
COMMAND SETTINGS, 78 
COMMAND SETUP, 75 
COMMAND SETVIEWDIR, 99 
COMMAND SLDOUT (MSLIDE), 333 
COMMAND STRETCH, 199 
COMMAND TABLET, 396 * 
COMMAND TEXT, 238 
COMMAND TEXTEDIT, 243 
COMMAND THICKNESS, 132 
COMMAND TICON, 47 
COMMAND TRAPEZOID, 155 * 
COMMAND UNDELETE, 54 
COMMAND UNDO, 53 
COMMAND VIEW, 107 
COMMAND VTXEDIT, 228 
COMMAND WCLOSE, 100 
COMMAND WMFOUT, 331, 332  * 
COMMAND WOPEN, 98 
COMMAND XLINK, 277 
COMMAND XPLODE, 260 
COMMAND XPLORER, 55  
COMMAND ZOOM, 101 
COMMAND ZOOMBACK, 102 
COMMAND ZOOMFAC, 104 
COMMAND ZOOMFIT, 103 
COMMAND ZOOMIN, 103 
COMMAND ZOOMOUT. SEE 
COMMAND ZOOMPAGE, 104 
COMMAND ZOOMWIN, 102 
COMMANDS, REPEATING, 51 
CONE. SEE 3D CONE *  
CONFIGURE, 59 
CONSTRUCTION POINTS. SEE COMMAND 

POINT 
CONTOUR, 163 

CONTROL PANEL, 45, 57 
COORDINATE FILTERS, 66 
COORDINATE SYMBOL, 47 
COORDINATE TYPES, 62 
COPY, 192 
COPY MULTIPLE, 201 
COPY OBJECT PROPERTIES, 131 
COPY PORTION OF IMAGE, 379 
CREATING GROUPS, 283 
CROSS HATCHING. SEE HATCH 
CROSSING POLYGON SELECTION, 70 
CROSSING SELECTION, 69 
CURSOR, 66 
CURSOR MENU, 48, 88 
CUSTOMIZING PALETTES, 58 
CUSTOMIZING TOOLBARS. SEE 

CUSTOMIZING PALETTES 
CYLINDER. SEE 3D CONE * 

 
DATA INPUT, 62 
DELETE 

attributes, 337 
entities, 53 
files, 37 
groups, 284 
icons, 59 
light, 366 
palette entries, 393 
parts from a drawing, 249 
parts of an entity, 218 
polyline vertex, 228 
raster images, 373 
table entries, 56 
UCS, 111 
views, 108 
Xrefs, 281 

DESKTOP CONFIGURATION, 57 
DETACH, 281 
DIALOG AND MENU EDITOR, 3, 40, 394 
DIGITIZE, 397 
DIGITIZING, 399 
DIMENSIONING 

Alternative dimensioning, 295 
angle, 311 
baseline, 308 
diameter, 310 
dimensioning style, 314 
dimensioning text, 296 
general settings, 292 
horizontal, 299 
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linear, 301 
lines and arrows, 293 
modify, 313 
Modify, 313 
radius, 311 
rotated, 303 
Serial, 306 
vertical, 300 

DIMENSIONING, 288–315 
DIRECTORIES (WORKING), 59 
DISTANCE, 323 
DONUT. SEE RING COMMAND 
DOTS PER INCH, 376 
DRAWING AREA, 38, 46, 59, 80, 97 
DRAWING EXPLORER, 55, 116, 247 
DRAWING MODES, 135 
DRAWING OUTPUT, 339 
DRAWING SETTINGS, 78 
DYNAMIC LINK LIBRARIES (DLL), 4 
DYNAMIC PREVIEW MODE, 74 
DYNAMIC ZOOM AND PAN, 106 

 
EDIT PART ATTRIBUTES, 272 
ELLIPSE (2D), 156 
ELLIPSOID. SEE 3D ELLIPSOID 
ENTITY INFORMATION (EINFO), 326 
EXPANDING, 211 
EXPLODE 

groups, 284 
on insert, 264 
parts, 53, 246, 255, 260 

EXPORT 
Attributes, 336 
BMP, 332 
DWG and DXF files, 329 
parts, 247, 250, 251, 336 
WMF, 331 

EXTEND. SEE EXPAND AND LENGTHEN 
COMMANDS 

EXTERNALLY REFERENCED DRAWINGS, 
276–82. SEE XLINK 

 
FCAD GRAPHIC DEVELOPER’S ENGINE, 1 
FELIXCAD DEVELOPERS TOOLKIT, 4 
FILE LOCKING, 59 
FILLED FACES (2D), 165 
FILLET, 212 
FIT 

attributes, 270 

b-spline, 230 
curve, 231 
dimensions, 290 
polygon, 154 
text, 240 
to drawing scale, 344 
to paper size, 349 
to viewport, 355 
zoom window, 101, 103 

FLIP, 196 
horizontal, 197 
settings, 188 
through free axis, 196 
vertical, 197 
viewports, 352 

FLOATING TOOL BOXES. SEE PALETTES 
FONT CONVERSION TABLE, 237 
FONTS, 61, 115, 134, 233, 234, 236, 239, 327 
FREEZE 

group, 354 
layer, 120, 125, 128, 277 
viewports, 354 

FUNCTION KEYS. SEE HOT KEYS 

 
GRID, 80, 82 

Isometric, 85 
spacing, 82 

GROUP, 282–86 

 
HATCH, 45 

angle, 318 
basics, 316 
command, 319 
edit text file, 395 
explode from part, 260 
mirror hatching, 189 
modification settings, 188 
modify, 320 
open areas, 320 
pattern, 317 
pattern elements, 317 
patterns, 82 
stretching, 199 

HEIGHT. SEE THICKNESS 
HIDDEN LINES, 360, 361 
HOT KEYS, 61 
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IMPORT 
DWG or DXF, 330 
multiple drawings, 383 
part, 253, 336 

INFO 
Angle, 323 
Area, 324 
Circumference, 324 
coordinate, 322, 323 
Distance, 323 
see EINFO command, 326 
Tables, 327 

INQUIRY COMMANDS, 322 
INSERT 

drawing as a part, 264 
externally referenced file, 281 
parts with attributes, 271 
raster and scanned files, 374 

INSTALLATION, 7 
INTERSECTING, 66, 92, 136, 143, 170, 183, 

201, 210, 212, 214, 215, 220, 285, 312 

 
LAYER 

basics, 2, 115 
button, 44 
BYLAYER, 44 
changing linetype, 123 
color, 117 
creating new, 122 
current layer, 116, 123 
define layer color, 124 
drawing explorer, 116 
Drawing Explorer, 55 
drop down list, 44 
freeze and thaw, 120 
naming, 117 
pre-defined layers in templates, 33 
properties, 117 
purging, 54 
quick access, 126 
rename, 54, 122 
renaming, 122 
set by reference, 128 
set current, 126 
visibility, 120 

LAYER MANAGER, 121 
LAYOUT MODE, 349 
LEFT TOOLBAR. SEE CONTROL PANEL 
LENGTHEN, 216 
LIMMAX, 80 

LIMMIN, 80 
LINE 

Append, 140 
Close, 139 
Command, 138 
Continuous, 138 
Segments, 139 
Tangent to Tangent, 141 

LINE, 138 
LINETYPE 

and Xrefs, 276 
assigning, 122, 127 
basics, 118 
BYLAYER, 44, 115 
changing, 123 
command line, 42 
Drawing Explorer, 55 
drop down list, 44 
edit text file, 395 
from parts, 246 
hidden lines, 360 
in templates, 33 
load, 118, 134 
PROPEDIT, 129, 221 
purge, 54 
Scale Factor (LTScale), 135 
thickness, 132 

LISP PROGRAMMING, 3 
LIST (EINFO), 326 
LOCK-FILES, 37 
LTSCALE, 135 

 
MEASURE, 170 
MENU BAR, 40 
MENU FILES, 40 
MIDDLE MOUSE BUTTON, 48, 88 
MIRROR IMAGE, 378 
MIRRORING TEXT, 199 
MODEL SPACE, 349 
MODEL SPACE. SEE LAYOUT MODE 
MODIFY 

array, 201 
attribute text, 274 
attributes, 273 
batch processing list, 384 
break, 220 
chamfer, 214 
change, 221 
copy, 192 
delete partial, 218 
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desktop, 3, 57 
dimensions, 313 
drawing objects, 187 
expand, 211 
fillet, 212 
flip, 196 
hatching, 320 
intersect, 215 
lengthen, 216 
light settings, 362 
mirror, 197 
move, 190 
object layer (PROPLAYER), 131 
object properties (PROPEDIT), 129 
object slection, 188 
offset, 206 
parameters, 188 
part library, 262 
part properties, 337 
pcurve, 231 
polylines, 225 
read only files, 35 
rejoin, 221 
rotate, 193 
scale, 194 
spline, 230 
stretch, 199 
tablet menu, 398 
text, 243 
text style, 236 
trim, 210 
vertex, 228 
viewport, 358 
viewports, 352 
Xref, 281 

MOUSE BUTTONS, 48 
MOUSE CONTEXT ON/OFF, 190 
MOVE 

attribute text (ATTMOVE), 274 
command line, 42 
light, 366 
objects, 190 
plot origin, 348 
raster image, 377 
UCS origin, 108 
vertex, 228 
viewport, 352 

MSLIDE. SEE SLDOUT COMMAND * 

 
NEW DRAWING, 32 

NEW LAYER, 122 
NGON, 152 

 
OBJECT SELECTION, 68–74 
OBJECT SELECTION MODE 

Add, 68 
Add and Remove, 73 
All, 68, 73 
Crossing, 69 
crossing polygon, 70 
Fence, 71 
Last, 71 
Previous, 73 
Single, 73 
Window, 69 
Window Polygon, 70 

OBJECT SNAP, 80, 86 
center point, 91 
end point, 90 
Insertion point of text or a complex object, 94 
intersection point, 92 
mid point, 90 
Next point on entity, 93 
perpendicular, 92 
Point, 94 
quadrant, 91 
tangent, 93 

OBJECT SNAP. ALSO SEE SNAP 
OBJECT SNAP CURSOR MENU, 48 
OFFSET 

by distance, 209 
through point, 206 

OPEN, 281 
DWG and DXF files, 330 
existing drawing, 34 
existing drawing as read only, 35 
externally referenced file, 276 
palettes, 391 
slides (VSLIDE), 333 

OPTION MENU/OPTION BAR, 57 
ORTHO MODE, 80, 81, 84 

 
PALETTE MANGER, 392 
PALETTES, 50, 58, 391, 392 
PANNING, 105 
PAPER SPACE, 349 
PAPER SPACE. SEE LAYOUT MODE 
PART LIBRARY 

selecting, 261 



Index 

 401 

setup and creation, 262 
PARTS 

advantages, 246 
attribute definitions, 247 
attribute display mode, 275 
attributes, 267 
creating external, 250 
creating internal, 248 
discreet insertion, 259 
edit attribute text, 274 
edit attributes, 272 
explode, 260 
exploded, 255 
export, 247 
external, 247 
insert external, 257 
insert with attributes, 271 
inserting, 252 
inserting external, 253 
inserting internal, 253 
insertion point, 249, 250 
internal, 247 
naming conventions, 248 
paste internal, 257 
properties, 246 
quick insert, 255 
rotation angle, 254, 257 
X factor, 256 

PARTS, 245–66 
PASTE 

from clipboard, 335 
PASTE INTERNAL PART, 257, 258 
PCONTOUR, 163 
PLAN VIEW, 98, 99, 108, 351, 356 
PLOTTING. SEE PRINTING 
POINT REPRESENTATION, 137 
POINTS, 169 
POLAR COORDINATES. SEE ANGLE INPUT 
POLYGON (NGON), 152 

circumscribing, 153 
inscribing, 154 

POLYLINE (2D), 158 
append option, 162 
arc option, 161 
divide, 172 
measure, 171 
tangent option, 162 
width and halfwidth options, 159 

POLYLINE 3D (3DPOLY), 173 
POLYLINE CONTOUR (BOUNDARY). SEE 

PCONTOUR 
POLYLINE EDITING, 225 

break, 220 
delete partial, 218 
fillet, 212 
join, 227 
POLYEDIT, 225 
setting width, 227 
transform to polyline, 225 
vertex chamfer, 214 
vertex editing, 228 

PRECISION AND UNITS SETTING, 75 
PRECISION PARAMETERS, 81 
PRINTER INSTALLATION, 340 
PRINTING 

basics, 339 
batch plotting, 383 
centered, 345 
colors and line widths, 346 
define area, 341 
fill polygons, 347 
filled areas, 347 
hidden line drawings, 360 
margins, 344 
paper size, 340 
Paper Space / Model Space, 349 
preview, 342 
print zone, 344 
raster images, 381 
rotation and offset, 348 
saved view, 341 
Scaling, 344 
scaling and fit, 344 
setup, 340 
sheet layout mode, 349 
tile across pages, 345 
to file, 341 

PRISM. SEE 3D CONE 
PROGRAMMER’S GUIDE, 5 
PROPERTY BAR, 57 
PURGE, 54 

parts, 251 
PYRAMID. SEE 3D CONE 

 
RASTER 

4 point transformation, 381 
copy portions of image, 379 
cut portions of image, 379 
edit transformation, 380 
loading function, 373 
loading RLC files, 374 
loading TIF and BMP files, 374 
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mirror, 378 
move, 377 
palette, 373 
print/plot order, 381 
property settings, 376 
remove image, 375 
rotate, 378 
save, 377 
toggle frame, 377 
unloading function, 373 
zoom extents, 375, 377 

RASTER LAYER, 381 
READ-ONLY FILE, 35 
RECTANGLE, 151 
REDO, 53 
REDRAW, 333 
REGENERATE DRAWING (REGEN), 120, 135, 

137, 341, 361 
REJOIN SEPARATED ENTITIES, 221 
RELOAD, 279, 281 
REMOVE. ALSO SEE DELETE 

attributes from a list, 337 
blocks, 54 
desktop components, 57 
entities from a group, 284 
feils from batch process list, 386 
FelixCAD, 8 
files from part library, 263 
hidden lines, 359 
icons, 59 
light, 366 
named views, 108 
object from selection, 68 
objects, 73 
palette from desktop, 393 
raster image, 375 

RENAME, 54 
RENDER * 

ambient light, 367 
animated rendering, 364 
anti-aliasing, 364 
copy to clipboard, 362 
distant light, 368 
insert lights, 366 
Intensity components of emitted light, 370 
light attenuation, 370 
light types, 365 
lights, 365 
move lights, 366 
overview, 362 
point light, 369 
set parameters, 363 

spotlights, 369, 371 
REPEATING COMMANDS, 48, 51, 68, 71, 139, 

144, 166, 168, 169, 173, 201, 210, 271, 307, 
385 

RINGS, 168 
ROTATE, 193 

attribute text, 274 
dimensions, 290, 303 
part, 257 
print/plot, 348 
raster image, 378 
rendering, 365 

RZOOM, 375 

 
SAVE/RETRIEVE VIEWS, 107 
SCANNED IMAGE, 373 
SCREEN COLORS, 61 
SEGMENTS, 170. ALSO SEE LINE AND ARC 

COMMANDS 
SELECTING OBJECTS. SEE OBJECT 

SELECTION 
SET CURRENT LAYER (SETLAYER), 126 
SET LAYER BY REFERENCE, 128 
SINGLE, 73 

3D face, 176 
character, 33 
object picking, 80 
objects, 157, 158, 173, 178 

SLIDES 
making, 333 
viewing, 333 

SNAP, 80, 133. ALSO SEE OBJECT SNAP 
Angle, 82 
CENterpoint, 91 
ENDpoint, 90 
IMPlied intersection, 92 
INSertion point, 94 
INTersection, 92 
Isometric, 85 
MIDpoint, 90 
NeXT point, 93 
palette, 88 
PERpendiculer, 92 
PoiNT, 94 
QUAdrant, 91 
TANgent, 93 

SPHERE. SEE 3D SPHERE * 
STATUS BAR, 58 
STATUS LINE, 46 
STRETCH MOVEMENT, 199 
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SURVEYORS UNITS. SEE UNITS 
SYMBOL LIBRARY. SEE PARTS LIBRARY 

 
TABLET MENU, 398 * 
TECHNICAL SUPPORT, 8 
TEXT 

add new style, 235 
alignment and fit, 240 
angle, 239 
correct, 244 
edit properties, 236 
entering, 238 
fonts, 233, 234 
height, 239 
insertion point, 239 
modify, 243 
objects, 233 
options, 239 
properties, 233 
reference text, 242 
special characters, 241 

THAW, 120, 127, 128, 277, 354 
THICKNESS OF ENTITIES, 129, 132, 151, 346 
TORUS. SEE 3D TORUS 
TRANSFORMATION VECTORS, 380 
TRANSPARENT 

commands, 51, 86, 322, 357 
dpan, 106 
dzoom, 106 
pan, 104 
zoom, 101 

TRAPEZOID, 155 
TRIM, 52, 64, 187, 210, 213, 214, 218, 285 

on/off, 213 

 
UNDELETE, 54, 249 
UNDO LIST, 53 
UN-INSTALL, 8 
UNITS 

Angular, 76 
Linear, 75 
Orientation, 76 
Surveyors, 77 

USER COORDINATE SYSTEMS, 108–14 
USER INTERFACE. SEE DESKTOP 

CONFIGURATION 

 

VIEW, 96, 356 
3D view, 99 
manager, 107 
parameters, 97 
plan view, 99 
save named view (NVIEW), 107 
viewports, 97 

VIEW. ALSO SEE ZOOM AND PAN 
COMMANDS 

VIEW SLIDE (VSLIDE), 333 
VIEW WINDOWS/VIEWPORTS, 97 

 
WBLOCK. SEE PARTS 
WEDGE. SEE 3D WEDGE 
WIDTH VALUES, 62, 64, 82, 132, 136, 151, 

157, 160, 173, 218, 225, 227, 228, 230, 233, 
236, 332, 346, 347 

WINDOW POLYGON SELECTION, 70 
WINDOW SELECTION MODE, 69 
WINDOWS OPERATING SYSTEM, 1, 7, 27 
WINTAB, 397 
WMF-FORMAT, 331, 332 
WORLD COORDINATE SYSTEM, 110 

 
XINSERT, 282 
XLINK, 276, 277, 281 
XPLORER, 55 * 

 
ZOOM, 96, 101, 107, 115, 333, 341, 361 

alias, 61 
ARENDER, 365 
back, 102 
dynamic, 106 
factor, 104 
fit, 103 
in, 103 
out, 104 
page, 104 
palette, 101 
parameters, 97 
raster, 375 
ratio, 351 
scale factor, 355 
transparent, 101 
window, 102 
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